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Introduction
This guide describes Siebel ePharma Handheld, providing information on 
configuration, installation, application administration, and the user interface.

This book will be useful primarily to people whose titles or job descriptions match 
one of the following:

This guide assumes that you already have an understanding of Siebel Tools.

Your project team members will benefit from attending Siebel University’s 
configuration training before they begin working with and configuring Siebel 
Handheld applications.

Trained technical professionals should configure Siebel Handheld applications 
carefully. Keep in mind that improper application configuration can adversely affect 
the reliability and performance characteristics of your configured Siebel application. 
Thorough testing is strongly recommended before production rollout of your 
configured application.

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
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How This Guide Is Organized
Product Modules and Options
This guide contains descriptions of modules that are optional and for which you 
may not have purchased a license. Siebel’s Sample Database also includes data 
related to these optional modules. As a result, your software implementation may 
differ from descriptions in this Bookshelf. To find out more about the modules your 
organization has purchased, see your corporate purchasing agent or your Siebel 
sales representative.

How This Guide Is Organized
This guide provides instructions for configuring and using the Siebel Handheld 
application. The instructions assume a working knowledge of Siebel Tools; 
therefore, information that appears in Siebel Tools Reference is not repeated. This 
guide is designed to be read from start to finish, although it can also be used as a 
reference thereafter to look up specific topics.

The following chapters and appendixes are directed to database administrators, 
Siebel application administrators, Siebel application developers, and Siebel system 
administrators:

■ Chapter 1, “Overview”

■ Chapter 2, “Application Development”

■ Chapter 3, “Application Administration”

■ Chapter 4, “Data Filtering”

■ Chapter 5, “Deployment”

■ Chapter 6, “Synchronization Conflict Handling and Recovery”

■ Appendix A, “Troubleshooting”

■ Appendix B, “Screens and Views”

■ Appendix C, “Business Components and Classes”

■ Appendix D, “User Properties”

■ Appendix E, “Print Tagging Language”
16 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3
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Additional Resources
■ Appendix F, “Print Configuration Settings”

The following chapters are directed to end users of the application. These chapters 
will also be helpful, as a reference, to administrators and application developers 
who need to understand the handheld application in order to customize it.

■ Chapter 7, “Installing the Handheld Application”

■ Chapter 8, “Working with Siebel Handheld Applications”

■ Chapter 9, “Using ePharma Handheld”

Additional Resources 
The following Siebel application guides contain information that may be relevant to 
your use of the Siebel handheld application.

■ For detailed coverage of the Siebel user interface and how to use it, working with 
data, locating information with the query and find features, sharing information 
with other users and other basic functionality topics, see Fundamentals.

■ For development and configuration information, see Siebel Tools Reference and 
Siebel Tools Online Help.

■ For information on installing the server components that are required for Siebel 
Handheld, see Siebel Server Installation Guide for Microsoft Windows.

■ For more information on assigning user access to catalogs, see Siebel eSales 
Administration Guide.

■ For information on creating user accounts, adding views and associating views 
with responsibilities, and assigning responsibilities and passwords for each 
handheld user, see Applications Administration Guide.

■ For information on using Siebel Remote to complete the Companion Sync 
synchronization process to the Siebel server from the laptop, see Siebel Remote 
and Replication Manager Administration Guide.
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Revision History
Revision History
Siebel ePharma Handheld Guide for Windows-Powered Devices

Version 7.5.3
Table 1. Changes Made in Version 7.5.3

Topic Revision

“Unsupported Features” on 
page 28

Revised for 7.5.3: Added more information 
to this topic.

“Synchronization Security” on 
page 105

New to 7.5.3: Added new topic.
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Overview 1
Siebel Handheld provides Siebel functionality to Windows-powered mobile devices 
employed by mobile Siebel users working in the field. Siebel Handheld provides the 
subset of the Web Client functionality that is required by the handheld user. It 
differs from Siebel Web Client and Siebel Mobile Web Client in that it uses a selected 
subset of views, accommodates smaller screen sizes, and has a reduced memory 
capacity.

Siebel Handheld
The Siebel Handheld client is a streamlined version of the Siebel Mobile Web Client. 
It includes only the functionality required by end users. The Siebel Handheld client 
supports the same data relationships, the same configuration in Siebel Tools, and 
much of the same functionality as the Siebel Mobile Web Client.

Some features that are available on the Siebel Mobile Web Client are not available 
on the Siebel Handheld. Scripting and Siebel engines (for example, Pricing and 
Reporting) are not supported on the handheld.

Functional Differences
Siebel Handheld applications provide the functionality to support Siebel Handheld 
users working in the field. Not all functionality that is appropriate for the desktop 
or server environment is required by the handheld user. See Chapter 2, “Application 
Development,” for details on functional differences.
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Synchronization Overview
Using Siebel Tools
Siebel Handheld applications for Windows-powered devices can be configured in 
Siebel Tools using Web mode. You can take your existing Siebel application and use 
this as the basis for the handheld application, or you can create a new application 
by using the Siebel Tools application shipped on the Siebel Handheld application 
CD-ROM. See Chapter 2, “Application Development,” for more information.

Filtering
Filtering allows you to specify a subset of data to be used on the handheld device. 
Filtering is an important feature of a Siebel Handheld deployment because of the 
relatively large size of the average enterprise database in comparison to the 
relatively limited memory capabilities of handheld devices. It is important that 
sufficient time is allocated in the project plan to create and test the handheld filters. 
See Chapter 4, “Data Filtering,” for more information.

Deploying
The Siebel Handheld application can be installed on Windows-powered devices in 
one of two ways. The first is to create a partnership between a desktop or laptop PC 
and the handheld device using Microsoft ActiveSync. The second is to install the 
handheld application from external media, for example, a Cabinet (CAB) file. 

Handheld patches can be remotely deployed using PatchAgent. For more 
information, see Chapter 5, “Deployment.”

Backing Up and Restoring Data
The Siebel Handheld application provides database backup functionality. A 
database restore utility is also included with the application. See Chapter 3, 
“Application Administration,” and Appendix A, “Troubleshooting,” for details.

Synchronization Overview
The Siebel Handheld Synchronization (Sync) client synchronizes data between the 
Siebel Handheld database and a remote or server database. The synchronization 
process:
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Synchronization Overview
■ Updates the Siebel server database with changes made to the Siebel Handheld 
database

■ Updates the database on the handheld device with changes made to the Siebel 
server database

■ Downloads metadata changes, such as object definitions for new or modified 
screens or views

■ Allows users to select filters to limit the amount of data that is downloaded

Synchronization Methods and Architecture
The following methods can be used to synchronize data on the handheld device 
with data in the Siebel server database: Companion Sync (CS), Direct Server Sync 
(DSS) and Direct Server Sync via Proxy (DSSvP). The architecture of these methods 
is discussed in the following sections.

Synchronization Servers
There are two types of synchronization servers: direct synchronization servers and 
companion synchronization servers. A direct synchronization server runs in a 
Siebel server installation and can accept concurrent synchronization requests from 
multiple synchronization clients. When connecting to a direct synchronization 
server, the Siebel Handheld Sync client synchronizes its data with the server-side 
database.

In Direct Server Sync mode, the Siebel Handheld Synchronization client uses the 
HTTP protocol over a network connection to communicate with the handheld 
synchronization server. Users should configure their handheld devices for 
communication over the desired network.

A companion synchronization server runs on a companion personal computer with 
a Mobile Web Client installation. A companion synchronization server supports 
synchronization with a data source specified in a client configuration; the database 
resides on the companion PC.
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Synchronization Overview
Companion Sync
Figure 1 on page 22 illustrates Companion Synchronization architecture. 
Companion Sync allows users to synchronize the Siebel Handheld application and 
database with a Siebel Remote database on a Mobile Web Client.

Microsoft ActiveSync is used to connect the handheld device and the companion 
PC, through a serial or USB connection, or through a network connection. The user 
selects synchronization filters and launches Siebel Handheld Sync from the mobile 
client. The Sync server components that manage transaction processing and data 
extraction for the handheld database reside on the mobile client.

Figure 1 illustrates Companion Sync architecture.

Figure 1. Companion Synchronization Architecture
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Synchronization Overview
Direct Server Sync
Direct Server Sync allows users to synchronize their Siebel Handheld application 
and database directly with the Siebel server. The user connects the handheld device 
to the Siebel application server through a network connection that uses the HTTP 
protocol. The connection runs through an IIS Web server to the Siebel Gateway 
server and application server, where the Sync server components are installed. 
Figure 2 illustrates DSS architecture.

Figure 2. Direct Server Synchronization Architecture
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Configuring the Siebel Handheld Client Application
Direct Server Sync via Proxy
Direct Server Sync via Proxy (DSSvP) allows users to synchronize their Siebel 
Handheld application and database directly with the Siebel server. The user 
connects the handheld device to the Siebel application server through ActiveSync 
and the network connection established by the companion PC. The connection runs 
through an IIS Web server to the Siebel Gateway server and application server, 
where the Sync server components are installed.

Configuring the Siebel Handheld Client Application
Complete the following steps to configure your handheld client application.

To configure the Siebel Handheld Client

1 Define the user functionality. 

Determine which user interface elements (such as screens, views, toolbars, 
applets, find, and help) will be necessary for your Siebel Handheld Client end 
users. For more information, see “Defining User Functionality” on page 31.

2 Configure the Siebel Handheld Client user interface. 

The process for configuring user interface elements in the Siebel Handheld 
Client is the same as the process for designing user interface elements in the 
Siebel Mobile Web Client. For more information, see “Configuring User Interface 
Elements” on page 36 and Siebel Tools Reference.

3 Identify all eScript or VB script used in the Siebel application, and make sure that 
it does not conflict with the handheld application configuration. Siebel 
Handheld applications do not currently support scripting.

4 Compile the new configuration.

For more information, see “Compiling the Application” on page 45.

5 Update directives in the Siebel Handheld Client configuration file. 

For more information, see Chapter 4, “Data Filtering.”
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6 Test the new configuration. 

Test the configuration, repeating Step 2 through Step 6, to address any 
configuration errors.

After completing the Siebel Handheld Client configuration, you are ready to install 
it on the handheld devices. To install the Siebel Handheld configuration on a 
handheld device, see the instructions in “Installing on the Handheld” on page 131.
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This chapter describes the Siebel Handheld Client configuration process for 
application developers. The process for configuring a Siebel Handheld Client has a 
few differences, described in this chapter, from the process for configuring a Siebel 
Web Client.

NOTE: Readers should familiarize themselves with the Siebel Web Client 
configuration process described in Siebel Tools Reference before attempting to 
configure the Siebel Handheld Client.

Architectural Overview
The five layers in the Siebel Handheld architecture are comparable to those used on 
the Siebel Web Client: 

Application layer. The application layer starts and closes the application.

User Interface layer. The user interface layer renders the display and interacts with 
users’ actions.

Object Manager layer. The object manager layer provides a consistent object behavior 
and interaction between all business objects within the application.

Data Manager layer. The data manager layer maintains an object-oriented abstraction 
of the native data stored in the data repositories for the benefit of the object 
manager.

Database layer. The database layer includes the data that Siebel Handheld users will 
access.
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You configure an application using Siebel Tools and compile the Siebel repository 
(.srf) file. During the synchronization process, information specific to the Siebel 
Handheld Client is extracted from the Siebel repository file. This information is used 
to create a repository meta language (.rml) file, which is downloaded to the 
handheld device. The repository meta language file has all of the layout information 
for the handheld device. For more information, see Siebel Tools Reference.

Unsupported Features
The differences between configuring user interface elements for the Siebel Web 
Client and the Siebel Handheld Client are shown in Table 2.

The following are not supported in Siebel Handheld applications:

■ The following applet types are not supported:

■ Chart

■ Explorer

■ More than two applets per view is not supported. A maximum of two applets 
may be displayed at one time.

■ Group boxes are not supported. See “Group Boxes” on page 39 for information 
on how to accommodate this limitation.

■ Alarm Manager is not supported. Therefore, if an alarm check box is added to 
an applet and the check box is selected, no alarm will sound.

■ The base time zone is determined by the system settings on the server and 
cannot be changed on the handheld device.

Table 2. Configuring Siebel Client User Interface Elements

Client Siebel Tools SWT Template Files
Specialized 
Algorithms

Siebel Web Client Yes Yes No

Siebel Handheld Client Yes No Yes
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■ Alphabet tabs are not supported.

■ Scripting is not supported. However, any scripts on the business components 
will be executed during synchronization.

■ Siebel Workflow is not supported. 

Multi-Value Groups (MVG)
The Multi-Value Group applet is not supported on the Siebel Handheld Client; 
however, the Multi-Value Group relationship is supported. The Multi-Value Group 
(MVG) control button does not appear on fields in Siebel Handheld Client 
applications. Instead, MVGs can be implemented as parent-child views. As a result, 
MVG fields are not editable within the parent record. In the Siebel Web Client, 
addresses of accounts are added, deleted, or edited through the Business Address 
MVG applet. However, in the Siebel Sales Handheld Client, these functions must be 
done through a Business Address child applet with an Account applet as its parent.

On the handheld, all MVG fields are displayed as read-only fields with the primary 
record visible. If you have an application or business requirement that requires the 
user to view or update all the records in the MVG, you must configure a separate 
view for that MVG. For example, the Address field in the Accounts or My Accounts 
view is an MVG. In the Siebel Handheld Client that field is read-only and displays 
the primary record. In order for the handheld user to see and update the addresses, 
the new Address view is configured in Siebel Tools. This new Address view is visible 
in the Show drop-down list.

CAUTION: Multi-Value Group fields are automatically displayed as read-only fields in 
the handheld application. If the fields are set to be editable, the application will 
crash during synchronization.
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Functions
Siebel Handheld applications support most of the calculated fields and operations 
used in the Siebel Web applications with a few exceptions. See Table 3 for a list of 
the unsupported functions.

The NOT key word is not supported on booleans. Use the != operator instead. For 
example, "Active" != "Y".

The RowIdToRowNum function is supported differently in the handheld 
applications than in the Web applications. In Web applications, RowIdToRowNum 
converts a row Id to a numeric value. In the handheld applications, it returns the 
row ID itself.

Table 3. Unsupported Functions

Function Name

BCHasRows GetXAval*

DockingNodeId IsDocked

DockingNodeName LanguageName

DockingNodeRoutId LocaleName

EAILookupExternal LookupMessage

EAILookupSiebel LookupTranslation

EXISTS NOT

GetHQInstanceId RepositoryId

GetHQInstanceName RepositoryName

GetNumBCRows RowIdToRowNum

GetProfileAttr* ToolsLanguage
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The first step in configuring a Siebel Handheld Client is to determine which user 
interface elements are necessary. Keep in mind the differences in display size, 
memory capacity, and input methods between handheld devices and larger 
computers, such as desktop computers.

The goal is to create applications that are easy for your end users to use and which 
take advantage of the strengths of the handheld device platform. Because of 
processing speed, memory limitations, and form factor differences, you should only 
include those user interface elements that are necessary for users to complete their 
job responsibilities.

General Guidelines
The following list provides some general guidelines for defining user functionality:

■ Limit the number of screens and views.

■ Design each view so that it has one or two applets.

NOTE: In some instances, Siebel Systems found it necessary to create a view with 
three applets in its handheld applications. For these views, a toggle button was 
added to the applet so that the user can easily navigate between the two child 
applets.

■ Design each applet so that it only contains columns and fields that are required 
for end-user tasks. 

Use these guidelines when you design any new objects for the Siebel Handheld 
Client. This approach facilitates a logical separation of the Siebel Handheld Client 
user interface elements from the Siebel Web Client user interface elements. This is 
important because very few applets are shared between the two types of clients.
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Taking Advantage of the Handheld Device
Siebel Handheld Client users have different requirements from Siebel Web Client 
users. Typically, handheld devices have limited screen space and use different 
methods for entering data, such as smaller keyboards or a touch-sensitive screen. 
By keeping the Siebel Handheld Client user experience in mind, you will build 
applications that will allow your users to be more productive. Some guidelines for 
taking advantage of the handheld device are discussed in the following sections.

Identify User Activities
To conserve memory (and thereby improve performance) and ease navigation, 
identify business processes that are required by end users and develop applications 
that support these processes. If more than one type of user needs a Siebel Handheld 
Client application, it is preferable to divide the application into multiple 
responsibilities rather than give all possible users access to all available screens and 
views. Responsibilities are fully configurable by the application developer.

Support Stop-and-Go Workflow
Design Siebel Handheld Client applications to support a stop-and-go workflow. End 
users interact daily with the Siebel Handheld Client application, performing 
job-related tasks. These end users frequently start the Siebel Handheld Client 
application, navigate to data, read or enter data, and later return to the application 
to resume entering information. Frequently, an end user needs to navigate to 
another view to retrieve information while in the middle of a task. Design your 
applications so that end users perform a minimum number of taps to navigate to 
the desired information.

Design Applications That Require Minimal Navigation
Design applications that are as flat as possible. In a Web-based application, you may 
have views with many applets, and the user toggles between the applets. However, 
for handheld applications, create a larger number of views with fewer applets to 
allow users to quickly find information with a minimal amount of toggling.

Design for the Handheld Screen
Consider the type of handheld device that is being used and the way the screen is 
laid out. Consider the following questions when designing your applets:
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■ Are the applets laid out side by side (on a HPC 2000 handheld device) or stacked 
one on top of another (on a Pocket PC handheld device)?

■ If you are using a list applet, how wide is that list applet going to be? Is it a 
full-screen list applet or a child list applet?

■ What are the most important fields and columns that a user needs to see at a 
glance before scrolling? 

■ If you have a form applet that is a parent, for example, what fields do you really 
need in order to avoid scrolling?

Because there is less screen space on a handheld device than on a laptop or desktop, 
the most important data should be immediately visible.

Creating a Handheld Project
The Siebel Handheld projects appear in the list of projects in Siebel Tools; when 
Project is selected in the Object Explorer, the list of projects is displayed in the 
Object List Editor.

Use a naming convention that allows you to easily identify applications, screens, 
views, and applets belonging to a particular Siebel Handheld application. This 
allows you to locate all the object definitions in a handheld application by querying 
on the name in the Object List Editor. For example, all of the Siebel Handheld Client 
screens, views, applets, toolbars, and menus use either an SHCE prefix (for 
example, SHCE Sales Account List View) or a CE suffix. Use the Object List Editor 
to query for views that contain the prefix SHCE or the suffix CE; doing so displays 
all of the Siebel Handheld Client views.

If you create a new Siebel Handheld application, create a new suffix or prefix to 
identify the name of the application and each screen, view, and applet name. For 
example, you could use PPC_SHCE for an application that is designed for handheld 
devices using the Pocket PC operating system.
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Each view in a handheld application can display a maximum of two applets at a 
time, regardless of the number of applets in the view. If there are more than two 
applets in a view, the user can navigate to additional applets by toggling. For more 
information, see “Multiple Applet Views” on page 34.

Multiple Applet Views

Screen Allocation
The amount of screen space available for applets is determined by the handheld 
device’s operating system and the type of applets in the view.

Pocket PC For handheld devices using the Pocket PC operating system, the two applets are 
stacked one above the other. A parent form applet in a two-applet view displays up 
to five fields on the screen. The form applet dynamically resizes if there are fewer 
than five fields and, therefore, does not waste screen display space with empty 
lines. The maximum number of fields that are displayed at one time is configurable 
by setting the Max Parent Applet Size preference in the User Preferences dialog. See 
“Setting User Preferences” on page 155 for more information on this user 
preference.

Handheld
PC

For handheld devices using the HPC 2000 operating system, additional screen space 
is provided for list applets. The following examples illustrate how the screen space 
is allocated depending upon the type of applets in the view.

■ For views containing a form applet (on the left) and a list applet (on the right), 
the form applet receives 3/8 of the screen space and the list applet receives the 
remaining 5/8 of the screen space.

■ For views containing two form applets or two list applets, the screen space is 
allocated equally between the two applets.

■ For views containing a list applet (on the left) and a form applet (on the 
right), the list applet receives 5/8 of the screen space and the form applet 
receives the remaining 3/8 of the screen space.
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Toggling Between Multiple-Applet Views
The Siebel Handheld Client application displays up to two applets at one time. If the 
view has only one applet, the applet takes up the entire display area. For views with 
two or more applets, the first two applets in the view are displayed, and the user 
toggles to see the other applets. The first applet is always displayed and the second 
applet changes as you toggle.

By default, the user toggles by choosing the View > Toggle menu item. In addition, 
it is recommended that you provide a toggle button as a visual cue to the end user 
that there are additional applets. Add a toggle button to each applet except the first 
applet. Identify the button with a Toggle caption and set methodInvoked to 
ToggleApplet.

Drill-down Only Views
Some views may be drill-down only views—that is, they can only be accessed by 
navigating from another view. These views should not be accessible through the 
Show drop-down list. However, when the end user navigates to the view, the view 
title appears in the Show drop-down list. To configure a drill-down only view, set 
the view title as you would for any other view and set the ScreenMenu property to 
FALSE. See Siebel Tools Reference for more information.

Views with Associated Print Templates or Reports
Print templates are text files that you design and create for printing. After creating 
a print template, you associate it with an applet. When an end user chooses to print 
a view, the print template that is associated with the applet is automatically selected 
and used for printing. Follow these guidelines when creating print templates:

■ Only one print template can be associated with an applet.

■ The print template name for a particular display applet is registered in the Mail 
Template property in the Applet object associated with the applet.

■ The template must be placed in the Templates directory.

■ The template name that goes into the Mail Template property should not include 
a path name or extension. For example, if the full path of the template is 
\Program Files\Siebel Handheld\Templates\InvoiceTemplate.txt, you would 
enter only the root name InvoiceTemplate in the property field.
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■ The template file itself must have a .txt extension on the device.

For more information, see Appendix F, “Print Configuration Settings.”

Configuring the Activities View

The Planned Start and Duration fields on general activities and appointments must 

be populated in order to be displayed in the correct time slot in the Calendar view. 

The Planned Start field is exposed in the Activities > My Activities view. However, 

it is not displayed in the Contacts > Activities and Accounts > Activities views. It 

is recommended that you configure your application to expose the Planned Start 

field in these views. 

Configuring User Interface Elements
When configuring user interface elements on the Siebel Handheld Client, also 
consider the processing speed and memory constraints of handheld devices. The 
constraint on processing speed affects the performance of a handheld device. The 
performance of a handheld device is also related to the number of screens and views 
downloaded to the handheld device. Because handheld devices are not meant to 
provide the same functionality as larger devices, such as laptops, the number of 
screens and views must be kept to a minimum on the handheld device.

Due to size constraints on handheld devices, the Siebel Handheld Client displays 
user interface elements differently from the Siebel Web Client. Consider these 
differences when configuring the Siebel Handheld Client application. For example, 
Siebel Handheld Client does not support an alphabetical index.

List Applets
List applets display in the Siebel Handheld Client application almost identically to 
their display on the Siebel Web Client. The list columns in the Siebel Handheld 
application are identical to the list columns that appear as Applet Web Template 
Items under the Applet Web Template.
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The recommended strategy when configuring the Siebel Handheld Client is to use 
the list applets for record navigation and to rely on form applets to provide the 
record details.

The following are additional guidelines to follow when designing list applets:

■ Configure specific list applets for your handheld application, rather than reusing 
Siebel Web Client list applets.

■ Remove all but the essential list columns. Because there is limited screen area to 
display list columns, omit all unnecessary columns to minimize horizontal 
scrolling. You may either remove the columns from the application or set the 
Show in List property on the column to FALSE.

■ Reorder the remaining list columns so that the most frequently used columns are 
furthest to the left.

■ Reduce the default width of the list columns so that more columns can be 
viewed at one time.

These changes can minimize the amount of horizontal scrolling and column 
reordering that a user must do. Limiting the number of list columns to the essential 
ones minimizes the amount of data downloaded to the device, resulting in faster 
synchronization times and more economical use of device memory.

NOTE: All required fields on form and list applets appear with an asterisk (*). If an 
administrator specifies that a field is required, the field appears with an asterisk in 
the user interface.

When designing list applets, consider using hyperlinks on the list applet as a 
convenient way to drill into the form applet.

Use the Web Applet Designer in Siebel Tools to add, remove, or rearrange list 
columns. Open the applet in the Web Applet Designer and choose the List Columns 
option from the Format menu. For more information on the List Column options, 
see information about the Siebel Web Applet Designer in Siebel Tools Reference.
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You may make columns available, but not visible by default, by setting the Show In 
List property of the column to FALSE. From the handheld application, you can make 
the columns visible from the View > Columns Displayed menu option. In order for 
the change to be reflected in the application, you must compile the application and 
synchronize with the handheld device. In addition, you must delete the \Program 
Files\Siebel Handheld\siebel.ssf file on the handheld. If this file is not deleted, the 
change to the Show In List parameter will not be reflected in the application.

Form Applets

Layout Sequence
When configuring for the handheld device, the Applet Web Template Items in the 
Applet Web Template determine the controls that appear on a form applet. The 
layout of form applets on the handheld device is determined by the HTML Sequence 
field set on control objects.

Handheld
PC

On form applets on the HPC 2000 operating system, controls are laid out left-to-
right, top-to-bottom, according to their HTML Sequence number. 

Pocket PC The HTML Sequence field determines the screen layout of a handheld device. 
Controls are ordered from top-to-bottom based on their HTML Sequence property 
values. Label and control pairs that do not fit on the same line as other label and 
control pairs wrap to the next line.

Labels
Keep field labels in applications using the Pocket PC operating system short 
(approximately 12 characters or fewer, depending on the character width). Use 
abbreviations where possible. Labels that are too long are truncated.
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Group Boxes
Group boxes are not supported and are not displayed in form applets, even if they 
are added in the Web Applet Designer. Therefore, reword the field labels to include 
group box information if necessary. For example, you may have two group boxes on 
the form, one labeled Ship To and another labeled Bill To. Each group box includes 
a field named Address. Because group boxes are not supported, the Ship To and Bill 
To labels will be lost, and two fields with the identical Address label will remain. 
Therefore, you must rename the Address labels “Ship To Addr” and “Bill To Addr,” 
or some other label that distinguishes them.

Auto Pop-Up Lists
Sometimes when a user is navigated to a new view, there is an action he or she must 
perform, for example, filling in a required field by selecting a value from a pop-up 
list. Rather than requiring the end user tap the control to open the pop-up list, you 
can configure the view so that the pop-up list automatically opens when the end 
user gets to that view. To configure a pop-up list to open automatically, add the user 
property on the applet with Name set to AutoPopupField. Depending on the type of 
applet, this property is set differently:

■ For list applets, set the AutoPopupField property to the Business Component 
field name.

■ For form applets, set the AutoPopupField property to the name of the control.

Home Page Applets
To configure a Home Page applet, create an applet that has controls of HTML Type 
Button only. Use the following guidelines in creating your Home Page applets:

■ Set the MethodInvoked property of these controls to GotoView. Then add a user 
property for the control, and set the Name parameter to “View” and set the Value 
parameter to the view name.

■ Set the Caption field.

■ Set the HTML Sequence field according to the order in which the buttons are laid 
out on the device. The buttons appear on the Home Page applet of the handheld 
device, laid out in rows of three buttons.
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■ Set the class property of the Applet to CSSFrameCEHome.

All pick data is not downloaded to the device due to the memory constraints on the 
device. Only pick data for fields that are editable is downloaded. Therefore, if you 
are doing a query on a pick field, you may not be able to display the picklist. When 
viewing a record in an applet, if a pick field is read-only, its pick button will be 
disabled. If end-users select a read-only field with a pick control, they receive the 
following error: No data available in picklist because field is read-only.

Data in picklists are filtered like any other data in a handheld application. For 
information on how to filter picklists, see Chapter 4, “Data Filtering.”

NOTE: Catalogs control visibility of data in pick applets. To make sure that pick 
applets contain valid data, the administrator must add data to a relevant catalog and 
make sure users have visibility to the catalog using the Catalog screen’s Access 
Groups view tab. 

Buttons
Set the HTML Type field on buttons to Button, MiniButton, PushButton, or 
MiniButtonEditNew. All of these HTML Types map to the same button control on 
the handheld device.

Figure 3. Home Page Applet Example
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Buttons with text labels on them are sized to the minimum width required to fit the 
text on the buttons.

NOTE: You cannot use scripting to augment the button functionality in handheld 
applications.

See “Toggling Between Multiple-Applet Views” on page 35 for more information on 
toggle buttons.

Menu Bar
You can use the same menu configuration for handheld devices using the Pocket PC 
or HPC 2000 operating system. The menu in Siebel Tools that is used for the 
handheld applications is SHCE Generic. The default menu bar configuration for the 
Siebel Handheld Client includes the following menus: File, Edit, View, and Help. 
You may remove or rename menus on the menu bar, but you cannot add new 
menus. You may reorder the menu items by changing the Position property for the 
menu items. Generally, use the default menu bar configuration for all of your Siebel 
Handheld Client applications.

Toolbars
This section describes how to configure the toolbar for your application.

Handheld
PC

Table 4 show the supported toolbar functions for the HPC 2000 operating system.

Table 4. HPC 2000 Toolbar Functions

HPC 2000 Toolbar Functions

Back, Forward

New Record

New Query, Execute Query

Next Record, Previous Record, First Record, Last Record

Minimize, Maximize
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The toolbar for the HPC 2000 operating system is not configurable.

Pocket PC Table 5 shows the supported toolbar functions for the Pocket PC 2002 operating 
system.

On the Pocket PC 2002 operating system, the default toolbar can be configured in 
Siebel Tools by configuring the SHCE Main toolbar object. SHCE Main is the main 
toolbar that is downloaded to the handheld device. If a toolbar named SHCE Main 
does not exist in your repository, a default toolbar, Main, is downloaded instead.

The SHCE Main toolbar contains the default buttons for the device, Back, Forward, 
New Record, New Query, and Execute Query. Change the order of the buttons on 
the display by modifying the Position property of the toolbar items. Remove a 
toolbar button by deleting it or making it inactive.

You can add additional default buttons to the toolbar by creating toolbar items 
whose Command property matches the name of an active bitmap in the SHCE 
Command Icons bitmap category. Do not add bitmaps to the SHCE Command Icons 
bitmap category because only those commands, which are already provided, are 
supported on the device. No additional commands are supported. You can remove 
a bitmap or make a bitmap inactive if you do not want it to appear in the Customize 
Toolbar dialog box.

You can change the bitmap for a toolbar by reimporting the bitmap from the SHCE 
Command Icons bitmap category.

Table 5. Pocket PC 2002 Toolbar Functions

Pocket PC 2002 Toolbar Functions

Back, Forward

New Record

New Query, Execute Query

Next Record, Previous Record, First Record, Last Record

Minimize, Maximize

Delete Record
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An end user can personalize the toolbar by selecting View > Customize Toolbar.

For more information on toolbars, refer to Siebel Tools Reference.

Status Bar
The location and type of information available on the status bar depends on the 
operating system of the handheld device.

Pocket PC On the Pocket PC operating system, the status bar is located above the toolbar. The 
status bar displays the status of applet with focus, including the applet title and 
record item count (for example, Contacts: 1 of 13).

Handheld
PC

For handheld devices using the Handheld PC operating system, the status bar is 
located above the taskbar, at the bottom of the screen. The status bar displays 
information about both visible applets in the view.

Hyperlinks
Configuring a hyperlink or dynamic hyperlink in the Siebel Handheld Client is 
performed the same way as in the Siebel Web Client. For more information on 
configuring hyperlinks and dynamic hyperlinks, see Siebel Tools Reference.

Preventing Synchronization Conflicts
Because multiple users are synchronizing with the server, conflicts may occur when 
any single user synchronizes their handheld. For more information on how to 
configure your application to prevent synchronization conflicts, see Chapter 6, 
“Synchronization Conflict Handling and Recovery.”

Recommended Configuration Guidelines
The Siebel Handheld Client application will perform best if you use the following 
guidelines: 

■ Keep the number of views in your application to 30 or fewer.
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■ For optimal usability, limit each view to one or two applets.

■ To minimize horizontal scrolling, limit the number of columns displayed in a list 
applet to no more than ten.

■ There is no limit on the number of fields in form applets of single-applet views. 
However, to minimize scrolling, keep the number of fields to 20 or fewer.

■ For each screen, create a view called My * or All * as a single list-applet view. 
For example, for the Activities screen, create a My Contacts view that has the 
Contacts list applet only.

■ For each screen, create a single-applet More Info view. Create this applet as a 
form applet. For example, for the Contacts screen, create a More Info view that 
has the Contacts form applet only.

■ Use a form applet for the parent for each parent-child view.

■ In a multi-applet view, limit the number of fields in form applets to five or fewer 
for Pocket PC and 10 or fewer for Handheld PC. Add additional fields only if the 
field width is short—for example a check box field. Reduce the number of fields 
if the fields are multiline—for example, a Comments box that contains three 
lines of text.

■ Do not include read-only check boxes in form applets. It is very difficult for users 
to discern that the check box is not editable.

■ Limit the number of views within a screen to 12 or fewer so that the View 
drop-down list is not too long and unwieldy.

■ Limit the number of screens to six or fewer so that the Screen drop-down list is 
not too long and unwieldy.

■ Keep query names to about 15 characters or fewer, so that they fit in the Queries 
drop-down list. For example, North American Organization is too long for a 
query name, so you should change it to a shorter name, such as N. American 
Org. The number of characters is a general guide because characters vary in 
width (for example, W is wider than i).

■ Keep screen names to about 15 characters or fewer, so that they fit in the Screen 
drop-down list. The number of characters is a general guide because characters 
vary in width.
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■ Keep view names to about 20 characters or fewer so that they fit in the View 
drop-down list. The number of characters is a general guide because characters 
vary in width.

■ Limit the size of the dbfile.txt file to less than two megabytes (MB). The RDBMS 
on the handheld device will be approximately three times the size of dbfile.txt. 
If the data files are so large that they cannot be imported into the database with 
the available memory, users will not be able to successfully synchronize their 
data. See Chapter 4, “Data Filtering,” for information on how to design data 
filters to limit the amount of data that is synchronized to the handheld.

Compiling the Application
Compiling the repository for the Siebel Handheld Client is identical to compiling on 
the Siebel Web Client (see Siebel Tools Reference). Perform a full compilation the 
first time; subsequent compilations can be incremental, replacing only the projects 
that are affected. This assumes that you have organized all of your handheld object 
definitions in one project or a limited set of projects.

When you compile your application, a Siebel repository file (.srf) is created and put 
in the destination directory you specified during the compile procedure. Make this 
.srf file the source of repository information for the Siebel Handheld test client 
machine, defining all Siebel applications for that client, when you move it to your 
local \Siebel\objects directory.

It is strongly recommended that you make a backup of the existing .srf file in your 
local \Siebel\objects directory before overwriting it with the new one. That way, if 
you make an error or you want to revert to the original application, you have a 
backup that you can easily restore. For more information, see Siebel Tools Reference.

Configuring Printing from the Handheld
Users may print from any view in the application. However, they are not necessarily 
printing what they see on their screen. They may print a portion of the data they 
view or data that is not viewable at the time.A print template defines the document 
that is to be printed. After the template has been defined, it must be associated with 
an applet in a view.
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This section provides information on the following topics:

■ Defining documents

■ Designing print applets

■ Configuring applets for printing

■ Creating print buttons

■ Creating print templates

Defining Documents
Defining documents for printing includes several steps:

■ Determine the documents your users will need to print.

■ Determine the views from which they are most likely to print the documents.

■ Lay out the document for printing.

Determining which documents users will need and the views from which they are 
most likely to print requires that you have a good understanding of the users’ 
day-to-day work.

Whether the existing applets in a view include most of the required data or only a 
small portion is a secondary consideration. It is not likely that a printout of the 
existing applets, which are formatted for an electronic PDA interface, will provide 
an acceptable or usable printed document. In most instances, you need to create 
additional applets that are specifically used for printing data.

The printed document will be composed of several applets which are added to the 
view. The applets pull the data from the underlying business components which are 
a superset of the data in the view. These applets, in turn, direct the data to the print 
templates discussed in Appendix E, “Print Tagging Language.”
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Designing Print Applets
The print template references applets associated with the view and is how you 
specify what data appears in the printed document. As you design your applets, you 
should be aware of the print specifications of the printers used in the field. Portable 
printers typically print on two-inch or four-inch wide paper. You need to design your 
applets so that the data fits within the limits of the paper width. Keep your 
documents simple so that they will work with different sizes of paper. The following 
are some guidelines to use when designing your applets to accommodate the 
smaller paper sizes.

Form Applets
Data from only one business component can be displayed on each line in your 
document. When you design your form applets, keep in mind that you can display 
a maximum of two columns of data in form applets. You can specify that each 
column of data is preceded by an optional caption column. This means you can 
have up to four columns displayed in your document—two data columns and two 
caption columns. Alternatively, you may have no captions, and simply display one 
or two columns of data.

The ratio between caption and data columns is, respectively, 35 percent and 65 
percent. This is a fixed relationship that cannot be customized in the template.

List Applets
When specifying the width of a column, you can either specify it with a unit of 
measurement or as a percentage of the total page width. For example, you can 
specify that the first column is 20 mm, and the second column is 40 mm. If the 
width of the paper you print to is narrower than 60 mm, the column widths 
automatically adjust to fit the printable width as a proportion of the specified width. 
Therefore, the first column will always be 33 percent, and the second column will 
be 67 percent of the paper width. The minimum width for a column is 8 mm, which 
includes a 3 mm gutter margin between columns.

You can specify any number of columns in your list applet. However, if the width 
of the column is less than 8 mm, the application ignores the column and does not 
print it.
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On narrow paper widths, data from a field may not all fit on one line. Data that does 
not fit can be specified, in the Applet tag, to wrap to the next line and keep 
wrapping until the data in that field is completely displayed. The printable width of 
the page is equal to the paper width minus the left and right margins (PaperWidth 
– [LeftMargin + RightMargin]). These parameters are set in the setup.ini file. For 
more information on setting these parameters, see Appendix F, “Print Configuration 
Settings.”

Configuring Applets for Printing
Configure print applets as you would any other applet using Siebel Tools. In 
addition, set the following properties for each applet in the view.

■ Set the HTML Popup Dimension value to 0x0. 

The 0x0 setting hides the applet from the end user who should not see the applet 
that is used to generate the document. Exposing these applets would complicate 
a product that is tightly configured for an effective and efficient workflow on a 
small mobile device.

NOTE: For compatibility with previous versions, Siebel Systems continues to 
support the name, Popup Dimension, for this property. However, it is 
recommended that you use HTML Popup Dimension.

■ Set the name of the Mail Template to be the name of the print template file. For 
more information on the print template file, see “Creating Print Templates” on 
page 49. For more information on the Mail Template property, see “Views with 
Associated Print Templates or Reports” on page 35.

Configuring Print Buttons
While users can use the File > Print menu option to print a document, it is helpful 
to include a Print button on the applet to give users a visual reminder that it is 
possible to print from a particular view.

When you design your applets, keep the following in mind when deciding where to 
place the print button:
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■ Add the print button to the applet that is visible to the user. Do not add the print 
button to the print applet, which the user never sees.

■ Consider what the desired behavior is when determining the placement of a 
print button. 

For example, in a parent-child view, you may want to add the print button to the 
parent applet to ensure that the print button is always enabled. This is not 
necessarily true if the print button is placed on the child list applet. If there are 
no items in the list applet, the print button is disabled, and the end user will not 
be able to print from that view. If you only want the end user to print when there 
are list items, then placing the button on the child list applet is appropriate.

To configure a print button

1 From Siebel Tools, add a control to the print applet and specify HTML Type = 
Button.

2 Set Method Invoked = Print.

3 Set the Display Name property of the button. Generally, this is set to Print.

Creating Print Templates
Once you have identified and created the necessary views, you are ready to create 
print templates. A print template is a text file that includes instructions for printing 
a document. It specifies the data to be printed, document layout options, and text 
formatting. These instructions are specified using a print tagging language that is 
described in Appendix E, “Print Tagging Language.”

Configuring Default Predefined Queries
You must configure the default predefined queries (PDQs) for ePharma Handheld. 
These PDQs affect how data is synchronized between the handheld device and the 
Siebel database.

For information about configuring the default PDQs, “Predefined Query Filters” on 
page 80.
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Testing the Handheld Application
Before deploying your application to your end users, be sure to thoroughly test the 
application by synchronizing to a handheld device. The handheld configuration is 
downloaded to the device where you can test the functionality and verify that you 
have the desired behavior. Another equally important aspect of handheld testing is 
to check to see how much data is downloaded to the device. If too many records are 
downloaded, this increases the length of time it takes to synchronize the handheld 
and slows down the application performance. Check the server log file to see how 
many records are downloaded for each business component. You must set the 
LoggingLevels parameter to 25555 to capture this information in the log file. 

For more information on the LoggingLevels parameter, see “Configuring Server 
Logging Levels” on page 101. For more information on the server log files, see 
“Direct Server Sync Log Files” on page 232 and “Companion Sync Log Files” on 
page 233. For more information filtering data, see Chapter 4, “Data Filtering.”
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This chapter describes the application administration procedures for Siebel 
ePharma Handheld. These administrative procedures help to make the application 
run more efficiently on the device. In addition, this chapter describes the set of 
administrative tasks specific to tasks performed on Siebel ePharma Handheld, such 
as signature captures and audits.

The audience for this chapter is Siebel application administrators.

Assigning User Responsibilities
You must create user accounts and assign responsibilities and passwords for each 
handheld user. The steps are the same as those for creating user accounts, assigning 
responsibilities and passwords for the Siebel Web Client. See Applications 
Administration Guide for more information on this topic.

Administering Handheld Views
There are two administrative tasks associated with handheld views:

■ If you have added a new view or changed the name of a view, you must add the 
view or update the name of the view in the Application Administration screen.

■ Specify the default views in the configuration file.

Adding Views to the Application
Add new views to the Siebel Handheld application from the Application 
Administration screen in any Siebel Web Client application. You must be logged on 
as an administrator. (If you are using the Siebel Mobile Web Client to log in as an 
administrator, you must also specify the /editseeddata parameter.)
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To add new views to Siebel Handheld

1 Launch the Web Client application that uses the same database that the 
handheld application synchronizes to (or will use to synchronize to).

NOTE: If you launch the application from a mobile Web client, specify the 
/editseeddata parameter.

2 In the Siebel Web Client, from the application-level menu, choose View > Site 
Map > Application Administration > Views.

3 Add the new views.

4 From the application-level menu, choose View >Site Map > Application 
Administration > Responsibilities.

5 Associate each view with the appropriate handheld responsibility.

6 Add appropriate users to the responsibility.

NOTE: For more detailed instructions on adding views and associating views with 
responsibilities, see Applications Administration Guide.

Specifying Default Views in the Configuration File
The Siebel Handheld application uses a small subset of views in the Siebel 
enterprise application. Because there are memory resource constraints on the 
handheld devices, it is recommended that you extract only those views that are used 
on the handheld.

There are two methods for specifying which views will be extracted to the 
handheld. The first method is to compile an .srf of only those views that are relevant 
to the Siebel Handheld application. Or, alternatively, you may specify the handheld 
views in the Siebel Handheld configuration file located in the 
\siebsrvr\BIN\Language directory (Direct Server Sync deployments) or 
client\BIN\Language directory (Companion Sync deployments), where Language is 
the language of the application (for example, ENU for English).
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The views are specified in the [PDA] section of the handheld configuration file 
(phce.cfg). By default, all views for the handheld application are listed here. Edit 
the list so that only those views which your application is using appear in the list. 
Use the following syntax to specify the views:

DefaultViews1="view_name"
DefaultViews2="view_name"
DefaultViews3="view_name"
DefaultViewsn="view_name"

where view_name is the name of the view as it appears in Siebel Tools. The name 
must match precisely or it will be ignored during synchronization. It is 
recommended that you copy and paste the name from Siebel Tools into the 
handheld configuration file.

The combination of the .srf file, the handheld .cfg file, and the user's responsibility 
determines which views are extracted. Siebel Server uses the information in the 
handheld configuration file and the .srf file during synchronization in the following 
way:

■ If no default views are specified in the handheld configuration file, all the views 
in the .srf are extracted during synchronization. If the .srf contains only the 
handheld-specific views, then this is the same as listing each handheld view in 
the handheld configuration file.

■ If default views are specified in the handheld configuration file, then only those 
views are extracted. If there are some views that do not match the views in the 
.srf file, these are ignored.

■ If default views are specified in the handheld configuration file, but none of the 
views match those listed in the .srf file, then all the views in the .srf are 
extracted.
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Preventing Synchronization With Another Handheld 
Device

End users should not synchronize their mobile client database with any other 
handheld device except their own. Doing so can result in data integrity errors and 
data loss. Siebel Handheld ties a companion PC to a specific handheld device and 
prevents the end user from synchronizing with another end user’s handheld device. 
Uninstalling the software from the companion PC and the handheld device does not 
remove this link. If you need to remove the link between the two, contact Siebel 
Technical Support for the hhunlock.exe utility.

Siebel ePharma Handheld Administration
Siebel administrators should see Siebel Life Sciences Guide for detailed information 
about managing samples. The following sections cover only those administration 
procedures that apply to the handheld version of ePharma.

The following sections cover the designated topics and procedures:

■ Managing Samples Records

■ Performing disclaimer administration

■ Configuring the distributor name

■ Verifying signature capture

■ Performing a signature audit

■ Preparing receipts for calls

■ Signature capture validation

■ Validation logic of the sign and submit buttons

■ Validating the DEA number
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Managing Samples Records
Administrators can manage samples inventory using either Siebel ePharma 
Handheld or Siebel Life Sciences, but should not use both. In order to keep samples 
inventories in sync, end users should be prevented from submitting a samples 
transaction on the server when the same record is still editable on their handheld 
device.

When a user submits a record, the status changes to Submitted and it becomes read-
only, meaning no additional operations are allowed on the record. By updating a 
user property and writing two small Visual Basic scripts, you can specify that 
synchronized records are also read-only.

■ First, the administrator changes the value of the user property “Update Status To 
Synchronized” to Y. 

Making this change invokes the UpdateStatusToSynchronized method on the 
Sample Txn business component. 

■ Then, the administrator writes a small Visual Basic script for this method to 
change the status on the Sample Txn to “Synchronized.” 

■ Finally, the administrator writes another Visual Basic script to specify that the 
record becomes read-only when its status changes to “Synchronized.” 

This prevents users from accidentally submitting the sample transactions on the 
server while the same record is still editable on their handheld device.

Performing Disclaimer Administration
Your legal department may require that a change be made to the disclaimer text that 
appears below the signature area on the Siebel Signature Capture display of Siebel 
ePharma Handheld. Only one disclaimer can be active at a time.

To edit the disclaimer text

1 From the application–level menu, select View >Site Map > Samples 
Administration > Disclaimer Administration.

The Disclaimer Administration view appears.
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2 In the Disclaimers list, add a record.

3 Enter the new text in the Disclaimer field.

The Status, Start Date, End Date, Created By, and Created fields are read-only.

4 Click Submit.

The submitted disclaimer becomes active, and the status and date fields are 
updated. When sales representatives next synchronize, the disclaimer on their 
Siebel ePharma Handhelds is updated.

Configuring the Distributor Name
The default name of the company appears on the Siebel Signature Capture display. 
You may need to change this name if, for example, there is a name change as a result 
of a merger between two companies.

In addition, a company may use a contract sales force to distribute some of its 
products. You can use the Distributor by Employee feature to customize the display 
to show the name of the contract distributor for the contract sales representatives 
and to show the name of the primary pharmaceutical company for its sales 
representatives.

To change the distributor name in the Siebel Signature Capture display

1 From the application–level menu, choose View> Site Map > Application 
Administration > System Preferences.

The System Preference Administration view appears.

2 Find the Company Name system preference and change the value to the new 
company name.

When the sales reps next synchronize their PDAs, the new company name is 
downloaded to their Siebel ePharma Handheld applications.

3 From the application–level menu, select View > Site Map > User 
Administration > Employees.

The Employee Administration view appears.
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4 Select the employee from the Employees list. 

5 In the More Info view, enter the account of the distributor in the External 
Account field. (The external account must already have been set up as an 
account.)

If the External Account field is blank for an employee, the company name set in 
the System Preference Administration view, set in Step 2, is used.

6 Repeat Step 4 and Step 5 for each employee of the distributor.

Performing a Signature Audit
The Siebel administrator is typically assigned responsibility for checking the validity 
of signatures recorded electronically. This is done using the Verify button in the 
Signature Audit Administration view. For more information about the logic behind 
the Verify button, see “Validation Logic of the Sign and Submit Buttons” on page 64.

As the samples administrator, you should check Signature Audit Administration 
regularly and perform signature capture verification to make sure that signatures 
collected from each contact are consistent. 

Users may see an error message if Signature Audit Administration tasks are 
performed on a desktop computer running multiple versions of Siebel ePharma. 
Make sure that only the latest version of Siebel ePharma is running, and uninstall 
all previous versions.

To verify signatures

1 From the application–level menu, select View > Site Map > Samples 
Administration > Signature Audit Administration.

2 In the Sample Signatures list, create a query.

3 Visually compare the signatures for consistency.
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Contact names are retained even if the Contact record is deleted. If a Contact record 
is deleted from View > Site Map > User Administration > Persons, the contact 
name is removed from all applets with reference to that contact’s name in the 
S_CONTACT table. Therefore, if the Contact Id is deleted from the S_ACT_SIGN 
table, the last name and first name fields appear empty in the Sample Signature 
form in the Signature Audit Administration view.

However, the Contact Full name is not affected by deleting a contact record because 
it is stored in a text field in the same table. In the Signatures applet, the control 
above the signature displays the full name of the contact at the time of the call (that 
is, no reference to the S_CONTACT table). Because the contact’s name is not 
removed from this applet, a permanent and complete electronic record of calls 
captured with signatures recorded electronically is maintained.

Signature Capture Verification
Signature capture verification compares information captured at the time of 
signature (the signature event string) with the current call information (the current 
call string) to assess if the call information has been modified. Reasons the call 
information might be modified include:

■ Re-creation of a sample receipt

■ Sample adjustments

■ Fraud

Signature capture verification is launched from the Verify button on the Signature 
Audit Administration view. For an example of signature audit administration, see 
“Performing a Signature Audit” on page 57.

The Signature Key
When the signature is first created, a signature key is calculated from the signature 
and stored. When the signature is verified, this key is recalculated from the current 
signature and compared to the stored key. If the two keys do not match, the 
signature key checksum fails. A failed checksum indicates that the current signature 
has been altered since the time of capture. If the checksum fails, the signature is not 
displayed in the Signature Audit Administration view.
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Outcomes of Checksums
The signature capture verification status (Passed, Adjusted, or Failed) is determined 
by the outcome of checksums: user property checksums, which compare text saved 
at the time of the signature capture with fields in the current call record and the 
signature key checksum. See Table 6 on page 59 for examples of checksum 
combinations.

NOTE: You may need to expose the Verification Status field using Siebel Tools. This 
is a configuration change that may need to be performed before implementation of 
Siebel ePharma Handheld. For more information, see the release notes 
documentation for Siebel ePharma Handheld.

Each user property checksum returns results for a different group of fields involved 
in the signature capture.

User Properties for Signature Capture Verification
In the default installation of Siebel ePharma Handheld, there are three user 
properties that set fields for the checksums (Checksum Field: 1, Checksum Field: 2, 
and Checksum Field: 3). These user properties and their default configurations are 
described in the following sections.

Using Siebel Tools, you can create additional checksums. For more information, see 
“Creating New Checksum Field User Properties” on page 64.

Table 6. Checksum Examples

If… Then the verification status is set to…

All checksums pass Passed.

Any of the checksums fail Failed.

One or two checksums return Adjusted and the 
others pass

Adjusted.
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Checksum Field: 1—Signature Header Text
This checksum compares the signature header text recorded at time of signature 
with the similar string in the current call record. The three possible outcomes 
(Passed, Adjusted, and Failed) for this checksum depend upon the signature header 
text strings and the (signature) Status field.

Checksum Field: 2—Signature Body Text
This checksum compares the signature body text recorded at the time of signature 
with the similar string in the current call information.

The outcome (Passed and Adjusted) for this checksum depends on whether the 
signature body text strings match.

Checksum Field: 3—Sales Representative’s Row Number
This checksum compares the identity of the call creator at time of signature with 
the identity of the current creator of the call. The employee’s row number is used 
to identify the call creator. 

Table 7. Checksum Status for Signature Header Text

The Checksum Status is… If the signature event string…

Passed Equals the current call string.

Adjusted Is different from the current call string and the (signature) 
Status is Inactive.

Failed Is different from the current call string and the (signature) 
Status is Active.

Table 8. Checksum Status for Signature Body Text

The Checksum Status is… If the signature event string…

Passed Equals the current call string.

Adjusted Is different from the current call string.
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An employee’s row number can be obtained by selecting the employee in the 
Employees view (View > Site Map > User Administration > Employees) and then 
selecting Help > About Record. The Employee’s Row # appears in the About 
Record dialog box.

The outcome (Passed and Failed) for this checksum depends on whether the sales 
representative name text strings match.

Configuring User Properties for Closing Inventory 
Periods

The recommended process for closing an inventory period is:

1 Synchronize the handheld device with Siebel server immediately before closing 
the period.

2 Close the inventory period.

3 Synchronize the handheld device with Siebel server a second time, immediately 
after closing the inventory period.

End users must synchronize the handheld with Siebel server before closing the 
inventory period because there may be calls on the handheld that have not yet been 
synchronized with Siebel server. Only the current active period is downloaded to 
the handheld device. Therefore, after the current inventory period is closed, they 
must synchronize a second time in order to bring down the next active period.

Table 9. Checksum Status for Sales Representative’s Row

The Checksum Status is… If the signature event string…

Passed Equals the current call string.

Failed Is different from the current call string.
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To enforce this procedure, the inventory period closure logic has been added. When 
it is enabled, this logic goes into effect during the inventory period reconciliation. 
It ensures that the end user synchronizes his handheld with Siebel server before 
closing the inventory period, and it requires the end user to submit all outstanding 
calls (that is, when an electronic signature has been captured, but the call has not 
been submitted).

The following user properties have been created on the Pharma Inventory Period 
business component to support the inventory period closure logic:

■ Inventory Closure Validation. The default value is N (No), and the Inventory Period 
Closure logic is not triggered. To activate the Inventory Period Closure logic, set 
this parameter to Y (Yes). Setting the parameter to Y forces the end user to 
synchronize the handheld with Siebel server prior to closing the inventory 
period.

■ Acceptable Period to Complete Synchronization. The default value is 30 (minutes). 
When Inventory Closure Validation is set to Y, the Acceptable Period to Complete 
Synchronization user property determines a grace period during which the end 
user must synchronize the handheld before closing the inventory period. If the 
end user does not synchronize within the time period, he will not be permitted 
to close the inventory period.

If Inventory Closure Validation is enabled and the Acceptable Period to Complete 
Synchronization user property is not created, the default value of 30 minutes is 
used. 

After the end user successfully closes the inventory period, he sees a message that 
prompts him to synchronize the handheld device with Siebel server. Note, however, 
this step is not enforced. However, if the end user fails to synchronize a second time, 
the handheld device will not receive the current period, and this can potentially 
cause synchronization errors the next time the end user synchronizes.

NOTE: The same logic is enforced during inventory reconciliation.
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Configuring User Properties for Signature Capture 
Verification

Use Siebel Tools to edit the following user properties:

■ Turn checksums on or off

■ Add additional fields to checksums

■ Remove fields from checksums

■ Create new checksums of the same form as Checksum Field: 3

Editing Checksum Field: 1—Signature Header Text
This checksum compares the Signature Header Text field in the Pharma Call 
Signature business component with the concatenated text string of the Header Text 
Fields (Header Text Field: 1 to Header Text Field: 7) in the Pharma Professional Call 
business component.

In Siebel Tools, you can edit these user properties by adding, deleting, or editing the 
Header Text Fields in the Pharma Professional Call business component. The 
maximum allowed number of Header Text Fields is 20 (Header Text Field: 20).

Editing Checksum Field: 2—Signature Body Text
This checksum compares the signature body text in the Pharma Call Signature 
business component with the concatenated text string of the Signature Body Text 
Fields (Signature Body Text Field: 1 to Signature Body Text Field: 3) in the Pharma 
Call Sample Dropped business component. 

In Siebel Tools, you can edit these user properties by adding, deleting, or editing the 
Signature Body Text Fields in the Pharma Call Sample Dropped Call business 
component. The maximum allowed number of Signature Body Text Fields is 10 
(Signature Body Text Field: 10).

Editing Checksum Field: 3—Sales Representative’s Row Number
This checksum compares the “Created by” field of the Pharma Call Signature 
business component with the “Created by” field of the Pharma Professional Call 
business component. 
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In Siebel Tools, you can edit these user properties by replacing “Created by” with 
any field found in both business components. 

Creating New Checksum Field User Properties
In Siebel Tools, you can create user properties for up to 25 checksums that compare 
fields in the Pharma Call Signature business component with fields in the Pharma 
Professional Call business component. 

Use Checksum Field: 3 as a template to create new user properties with the same 
format. 

Name the new user property Checksum Field: n, where n is less than or equal to 25.

Validation Logic of the Sign and Submit Buttons
You can edit the validation logic for the Signature and Submit buttons for 
professional and account calls.

Default Validation Logic Flowcharts
The default validation logic for the Signature and Submit buttons is shown in the 
following flowcharts:

■ Signature button, Figure 4 on page 66

■ Professional Call Submit button, Figure 5 on page 67

■ Account Call Submit button, Figure 6 on page 68

Table 10. Checksum Field User Properties

User Property Name Value

Checksum Field: 3 “Created by”, “Created by”

Checksum Field: n “field in Pharma Call Signature”, “field in Pharma Professional 
Call”
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Not all implementations of Siebel ePharma Handheld require the extensive 
validation as shown in the following flowcharts. Before most validation steps, the 
procedure consults a user property to determine if the field should be used during 
the validation. For example, if it is not necessary to validate the License Number 
field, the user property Validate License Number is set to false. The Signature button 
validation then skips the validation question “Is the License Number field 
populated?”.
Version 7.5.3 Siebel ePharma Handheld Guide for Windows-Powered Devices 65



Application Administration

Validation Logic of the Sign and Submit Buttons
User Properties that can be used to alter validation logic are described in “Changing 
Validation Logic by Editing User Properties” on page 69.

Figure 4. Default Validation Logic Flowchart for Signature Button
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Figure 5. Default Validation Logic Flowchart for Professional Call Submit Button
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Validation Logic of the Sign and Submit Buttons
Figure 6. Default Validation Logic Flowchart for Account Call Submit Button

The numbers in the 
flowchart correspond to the 
numbers of the user 
properties in Table 11 on 
page 69.
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Changing Validation Logic by Editing User Properties
Validation logic uses user properties to determine if a field should be used during 
validation.

Table 11 explains the user properties you can use to alter the validation logic of the 
Sign, Professional Call Submit, and Account Call Submit buttons.

Table 11. User Properties for Setting Sign and Submit Button Logic 

Flowchart 
Reference User Property Action if Y… Action if N…

Default 
Value

1 “Validate OK to Sample”

Use to enforce confirmation that 
the OK to Sample flag is selected 
before launching the Signature 
Capture display.

Enforce the OK to 
Sample validation.

Skip the OK to Sample 
validation.

Y

2 “Validate License Number”

Use to enforce validation that the 
License # is populated before 
launching the Signature Capture 
display.

Enforce the License 
Number validation.

Skip the License 
Number validation.

Y

3 “Validate License Number Status”

Use to enforce validation that the 
License # status = Active before 
launching the Signature Capture 
display.

Enforce the License 
Number Status 
validation.

Skip the License 
Number Status 
validation.

N

4 “Validate License Number 
Expiration”

Use to enforce validation that the 
Expiration date on the License # is 
later than Today before launching 
the Signature Capture display.

Enforce the License 
Number Expiration 
validation.

Skip the License 
Number Expiration 
validation.

N
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N/A “Validate Address DEA Number”

Use to enforce that the DEA 
number is valid (DEA # checksum 
algorithm) at the time the value is 
entered into the DEA # field on the 
Address child applet (on the 
handheld).

This user property applies to both 
the laptop and the Siebel 
Handheld applications.

Enforce the Address 
DEA Number 
validation (field is 
populated and number 
is valid).

Skip the Address DEA 
Number validation 
(field is populated and 
number is valid).

Y

6 “Validate Signature DEA Number”

Use to enforce that the DEA 
number is populated and that the 
value is valid (DEA # checksum 
algorithm) before launching the 
Signature Capture display.

Enforce the DEA 
Number validation in 
the Signature button 
(field is populated and 
number is valid).

Skip the DEA Number 
validation in the 
Signature button (DEA 
number is valid per the 
checksum routing and 
the field is populated).

Y

7 “Validate DEA Number 
Expiration”

Use to enforce validation that the 
Expiration date on the DEA is later 
than Today before launching the 
Signature Capture display.

Enforce the DEA 
Number Expiration 
validation in the 
Signature button 
(expiration date is later 
than today).

Skip the DEA Number 
Expiration validation in 
the Signature button 
(expiration date is later 
than today).

N

8 “Validate Professional Profile”

Use to validate if the 
professional’s Last Name, First 
Name, Title, and Address fields 
are populated before launching 
the Signature Capture display.

Enforce the 
Professional Profile 
validation.

Skip the Professional 
Profile validation.

Y

9 “Validate Sign Lot Number”

Use to validate if the lot number is 
populated on launching the 
Signature Capture display.

Enforce the Signature 
button Lot Number 
validation.

Skip the Signature 
button Lot Number 
validation.

N

Table 11. User Properties for Setting Sign and Submit Button Logic 

Flowchart 
Reference User Property Action if Y… Action if N…

Default 
Value
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10 “Validate Submit Lot Number”

Use to validate if the lot number is 
populated on submitting a call.

Enforce the Submit 
button Lot Number 
validation.

Skip the Submit button 
Lot Number validation.

Y

11 “Sample Disbursed Required”

Use to require that at least one 
sample be disbursed before 
submitting the call.

Enforce that at least 
one sample be 
disbursed.

Do not require at least 
one sample disbursed.

N

12 “Must Detail Products”

Use to require that at least one 
product be detailed before 
submitting the call.

Enforce that at least 
one product be 
detailed.

Do not require at least 
one product detailed.

N

13 “Paper Reference Number 
Required”

Use to require a sample reference 
number for calls with paper 
signatures.

Enforce the Paper 
Reference Number 
required validation.

Skip the Paper 
Reference Number 
required validation.

Y

14 “SRE Reference Number 
Required” 

Use to require a sample reference 
number for signature recorded 
electronically (SRE) calls.

Enforce the SRE 
Reference Number 
required validation.

Skip the SRE Reference 
Number required 
validation. (If the Ref # 
field is blank, it will be 
populated with the 
Row ID of the call.)

N

15 “SRE Professional Type”

Use to require that the 
professional type be valid for 
signature recorded electronically 
(SRE) calls.

The professional type (for example, “Physician”) 
must match the value of this user property.

If the value is null, all professional types are valid.

null 

Table 11. User Properties for Setting Sign and Submit Button Logic 

Flowchart 
Reference User Property Action if Y… Action if N…

Default 
Value
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Validating the DEA Number
In the U.S., the DEA number is a federally authorized number for physicians at a 
specific address. 

In Siebel ePharma Handheld, the DEA number is stored at the address level for each 
physician. Siebel ePharma Handheld can confirm that a valid DEA number is 
populated at the selected address for a professional call. Depending on how your 
Siebel ePharma Handheld application is configured, the valid DEA number check 
can be performed at the time of entering the DEA number, upon launching the 
Siebel Signature Capture display, or both.

If:

■ The product dropped is a controlled substance and

N/A Submit Confirmation

Note: If this user property does 
not exist (for example, in the 
standard Siebel ePharma 
application), behavior is 
equivalent to “Submit 
Confirmation” = Y.

Confirmation message 
appears when the 
Submit button is 
tapped.

No confirmation 
message appears when 
Submit button is 
tapped.

Y

N/A Submit On Sign OK

Note: If this user property does 
not exist (for example, in the 
standard Siebel ePharma 
application), behavior is 
equivalent to “Submit On Sign 
OK” = N. 

Tapping the OK button 
on the Siebel Signature 
Capture display for 
new professional calls 
invokes the submit 
method. The submit 
method is not invoked 
for account calls nor 
for re–created 
professional calls.

Tapping the OK button 
on the Siebel Signature 
Capture display closes 
the display. To submit 
the call, tap the Submit 
button.

N

Table 11. User Properties for Setting Sign and Submit Button Logic 

Flowchart 
Reference User Property Action if Y… Action if N…

Default 
Value
72 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Application Administration

Preparing Receipts for Calls
■ The user property “Validate Address DEA Number” or “Validate Signature DEA 
Number” is true

then Siebel ePharma Handheld checks the validity of the DEA number by executing 
the algorithm described in Table 12.

Preparing Receipts for Calls
As the Siebel administrator, you may be asked to print receipts for sample drops to 
a physician. From the Sample Event Administration view, you generate a list of 
sample drops and print receipts using the Sample Receipt report.

To print receipts for samples dropped

1 From the application-level menu, select View > Site Map > Samples 
Administration > Sample Event Administration.

2 In the Sample Events list, create a query.

3 From the application-level menu, select View > Reports to open the Sample 
Events dialog box.

Table 12. The DEA Number Checksum Algorithm

Step Algorithm Example

1 The first two characters must be 
uppercase letters.

BB1388568

2 Sum the first, third, and fifth digits. 1 + 8 + 5 = 14

3 Sum the second, fourth, and sixth 
digits.

3 + 8 + 6= 17

4 Double the number obtained in step 3. 2 × 17 = 34

5 Sum the numbers from steps 2 and 4. 14 + 34 = 48

6 If the last digit of the DEA number is the 
same as the last digit of the number 
obtained in step 5, the DEA number is 
considered valid.

The last digit of BB1388568 and 48 is 
the same, “8”. 
This checksum indicates that the DEA 
number is valid.
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4 From the Select a Report drop–down list, select Sample Receipts and click Run.

5 To print the receipt, click the Print button in the Siebel Report Viewer window.
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This chapter provides information on deploying and developing data filters. 
Effective filtering is a key component of handheld deployment. Filtering restricts the 
amount of data downloaded to the handheld device in order to accommodate the 
reduced memory and processing resources of the handheld device. The user 
experience is improved if Siebel Handheld users do not need to navigate through 
unnecessary records. Device performance and synchronization times are improved 
as well.

The audience for this chapter is Siebel application administrators and Siebel 
application developers.

Types of Data Filters
There are three filtering methods that can be used to control the data synchronized 
to the handheld, which are discussed in greater detail later in this chapter.

■ Repository Configuration. By specifying links between business components in 
business objects, you are filtering the data that gets downloaded to the device. 
These links are defined in Siebel Tools by the application developer.

■ Query by Example Filters (QBEs). QBEs are business component-level filters that 
are primarily used to filter data at the business component level across all 
business objects. It defines the overall set of data available to the handheld. This 
filtering mechanism is used to provide handheld-specific business component 
level filtering and to define the overall set of data available to the handheld 
application. QBEs can also be used to filter picklists. It is strongly recommended 
that these filters be thoughtfully designed and be in place before synchronizing 
data to the handheld.
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■ Predefined Query Filters (PDQs). PDQs, sometimes called synchronization filters, 
select data at the business object (screen) level. End users use PDQs to select the 
data downloaded during synchronization. The list of PDQs appear in the Set 
Filters dialog box.

Users select one PDQ filter per business object, or one per screen. Therefore, all 
views in the same screen must be associated with the same business object. The 
filters apply to the screen the same way PDQs apply to screens in the desktop 
applications. The data on all views within the Handheld application screen is 
filtered by the PDQ filter.

Developing Data Filters
Siebel Systems suggests the following general steps for developing Handheld 
synchronization filters.

■ Identify the screens and views of your application. Then identify the business 
components that are required to support each screen and view, noting the areas 
where each business component occurs. For example, identify the form, list, or 
pick applets that are based on each business component.

■ Within Siebel Tools, establish the base parent-child relationships and any 
reverse relationships at the component level.

■ Review the business components that occur in picklists and consider creating 
default sync filter declarations for those that will cause large numbers of records 
to synchronize to the device. These declarations are maintained in the PDAQBE 
file.

■ For each business component, determine whether it is possible to apply a search 
specification to all instances of the business component within the handheld 
application. Develop a set of suitable Query by Example (QBE) declarations in 
the PDAQBE file. Common examples of business components that are suitable 
for global QBEs include: 

■ Employees (for large organizations)

■ Activities (for example, filter for current Activities, Activities of only certain 
kinds)
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■ Accounts (for example, by geography) 

■ Products (for example, active, orderable products)

■ Orders (for example, open, closed in last three months)

■ Create appropriate PDQ synchronization filters for each business object or 
screen and make sure that each screen includes a default filter. Default filters 
make sure that users avoid accidental download of an excessive number of 
records.

Query by Example Filters
During the synchronization process, the synchronization engine accesses a text file 
that contains handheld-specific filters applied at the business component level. 
These filters are QBE (Query by Example) statements that apply only to the 
handheld data extraction, so you can think of these QBE filters as handheld-specific 
business component search specifications. You can combine these QBE filters with 
PDQ synchronization filters or search specifications defined in Siebel Tools for 
flexible data filtering. There is one PDAQBE file per application on a server. (The 
PDAQBE file is the file defined by the PDAQBEFile parameter in the .cfg file. The 
PDAQBE file is located in the Siebel Root\siebsrvr\BIN\language directory for DSS 
deployments and in the Siebel Root\client\BIN\language directory for CS 
deployments.) Therefore, if you require different QBE definitions for different user 
populations, you will need a separate server for each PDAQBE file.

Unlike the PDQ filters, which are visible to the end user and can be selected through 
the Set Filters dialog box of Siebel Handheld Sync, QBE filters can only be created 
by the administrator and are hidden from the end user. QBE filters are always 
applied when the end user synchronizes a handheld device.
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Adding Business Component Filters
The handheld PDAQBE file is installed by default into the \BIN\language directory 
of the Siebel Application Server or Siebel Mobile Web Client where the handheld 
application is installed. The name of the file is application-specific, but always ends 
with PDAQBE file (for example, pharmaceqbe.txt, cgceqbe.txt, salesceqbe.txt). You 
can create new QBE filters or modify the default QBE filters by editing this file 
directly. Changes are applied to all subsequent synchronizations. You can also 
change the name of the file PDAQBE file by adding the following line to the [PDA] 
section of the Siebel Handheld application .cfg file:

PDAQBEFILE = "PDA filename"

NOTE: The Siebel Handheld application configuration file is located in the \bin\enu 
directory of the Siebel server for DSS or in the \bin\enu directory of the Siebel 
Mobile Web Client application for CS.

To create new business component filters, add rows to the PDAQBE file. The syntax 
for new filters is as follows:

DefaultSyncFilterXXX = Business Component Name|QBE Statement

where:

■ XXX is a unique number. The numbers should be in sequential order.

■ Business Component Name is the name of the business component to which the 
filter is applied.

■ QBE Statement is the query language that limits the records downloaded for the 
specified business component.

For example, the following is a QBE Statement from the PDAQBE file:

DefaultSyncFilter1 = Action|[Status] = "Not Started" OR [Status] = 
"In Progress" OR ([Status] IS NULL) OR [Status] = "On Hold" OR 
([Status] = "Done" AND [Done] >= Today() - 7)
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In this example, a Siebel Handheld filter has been created for the Action business 
component. This is the business component that underlies Activities in Siebel 
eBusiness Applications. This filter limits the Activities extracted for the Handheld 
application to those whose Status field is Not Started, In Progress, Null, On Hold, 
or Done. Activities whose Status is Done will only be allowed if the Done date 
occurred during the past week.

The example also demonstrates how these global QBE statements should be used 
during deployment. In the example, the QBE limits the handheld Activity records to 
those that are current. For every handheld application user and for every occurrence 
of the Activity business component, whether in a parent-child view or a pick applet, 
Activities are limited to those specified in this QBE. While this particular filter will 
not apply to every handheld deployment where Activities are used, most customers 
can use these global QBEs to rule out large sets of data not appropriate or necessary 
for the handheld application user.
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Filtering Out List of Values
You can use QBE filters to filter out values that are not used in picklists in your 
handheld application. For example, there may be account types, such as Distributor 
and Competitor, that are only used by users in the Web Client application and are 
not used by sales representatives out in the field. By including only those values 
that are used by the sales representative, you simplify the application for the user 
and improve the application performance.

The following is an example of a QBE filter that filters List of Values (LOV):

DefaultSyncFilter1 = List of Values| ([Type])="ACCOUNT_TYPE") AND 
(([Value] = "Reseller") OR ([Value] = "Retailer"))

In this example, regardless of the number of values that have been defined for LOV 
type ACCOUNT_TYPE, only the Reseller and Retailer values are extracted to the 
handheld. 

Be careful when you use QBE filters on LOVs. Multiple screens and views may use 
List of Values, such as ACCOUNT_TYPE, and may require that different values 
appear in the list. To avoid data loss, carefully review your filters and verify that all 
the required values are included.

Predefined Query Filters
Siebel Handheld provides synchronization filters that allow users to select the data 
they want to synchronize to their handheld applications. These filters are 
specifically named Predefined Queries (PDQs) that reside in the Siebel database. 
During synchronization, Siebel Handheld Sync accesses the database and processes 
the handheld-specific PDQs. The user can select one synchronization filter from the 
Set Filters drop-down list for each screen in their application. The selected filter 
determines the parent data that gets downloaded to the device.

You may also define a sort specification in your PDQs. These sort specifications are 
applied when the data is displayed on the device and is helpful for displaying 
records in a particular order. An example of a PDQ that includes a sort specification 
is shown below. The sort specifies that Activity records display according to the 
required Start Date, so that the first activities to complete appear at the beginning 
of the activity list.
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Name:  PDA_Current Activities

Query: 'Action'.Search = "[Start Date] >= Today () - 90 AND [Start 
Date] < Today () + 365"

'Action'.Sort = "Start Date (ASCENDING)"

General and Default PDQ Filters
There are two types of synchronization filters in Siebel Handheld—general and 
default filters.

■ General sync filters. Filters users select to specify the records users want 
downloaded to their handheld application.

■ Default sync filters. Filters displayed by default the first time the user taps the 
Select Filters button on the Handheld Sync user interface or if the user 
synchronizes without first selecting a filter.

The naming convention for general sync filters is:

PDA_<filter name>

An example of a general filter name is PDA_My Big Opportunities. See “Query by 
Example Filters” on page 77 for more information on filter naming conventions.

General filters with the PDA_ prefix appear in the Set Filters dialog when users 
synchronize their data and, if selected, in the handheld application in the Queries 
or Favorites drop-down list.

The naming convention for default sync filters is:

PDADef_<filter name>

or 

PDADef_*<filter name>

Default filters with the PDADef_ prefix appear in the Set Filters dialog when the user 
synchronizes their data and, if selected, in the handheld application in the Queries 
or Favorites drop-down list. Default filters with the PDADef_* prefix only appear in 
the Set Filters dialog; this filter does not show up in the application.
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There should only be one default query for each business object or screen. An 
example of a default filter is PDADef_Current Activities. The sync engine is 
case-sensitive, so pay close attention to using filter prefixes exactly as shown 
(PDA_, PDADef_).

CAUTION: Administrators must be sure to define a default filter for each screen in the 
handheld application. If no filters are applied during the synchronization process, 
an unacceptably high volume of data will probably be downloaded to the handheld 
device.
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Configuring Default PDQs
The default PDQs that are included in Siebel ePharma Handheld are designed to be 
placeholders for the PDQs that your users will need. Table 13 shows the PDQs that 
must be created and set as the default PDQs.

Table 13. Default PDQs for ePharma

Business Object PDQ Name PDQ Value

Account PDADef_AccountSyncFilter 'Account'.Search = "[Account Status]=""Active"" 
AND [My Position Id] = PositionId()"

Action PDADef_ActionSyncFilter  'Action'.Search = "([Due] >= Today() - 30) AND 
([Due] <= Today() + 30)"

Contact PDADef_ContactSyncFilter 'Contact'.Search = "[My Position Id] = PositionId () 
AND [Status]=""Active"""

Pharma 
Account Call - 
CE

PDADef_Last45DaysandPlanne
dAcctCalls

'Pharma Account Call - CE'.Search = "([Start Date] 
>= Today() - 30 AND [Start Date] <= Today() + 7) 
AND [Account Status] = ""Active"" AND EXISTS 
([Owned By Id] = PositionId())"

Pharma 
Professional 
Call - CE

PDADef_Last45DaysandPlanne
dProfCalls

'Pharma Professional Call - CE'.Search = "([Start Date] 
>= Today() - 30 AND [Start Date] <= Today() + 30) 
AND [Contact Status] = ""Active"" AND EXISTS 
([Owned By Id] = PositionId())"
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All Records PDQ
The All Records PDQ has special implications for Siebel Handheld users. When an 
All Records PDQ has been defined for a screen, the user can select it from the 
Favorites or Queries drop-down list in the application. This PDQ returns all records 
for the primary business component defined for the screen. The purpose of this 
query is to eliminate a potentially confusing scenario for users.

Suppose a user chooses a synchronization filter called My California Accounts that 
applies to the Account screen and causes only Accounts with State = CA to 
synchronize to the handheld application. However, during the course of the day, the 
handheld user creates a new Account on the device with State = NY. When the user 
leaves and later returns to the Accounts screen, the original PDQ (State = CA) is 
applied, and the new NY Account is absent from views within the screen. If the user 
selects the All Accounts PDQ from the Favorites drop-down list on the device, the 
NY Account reappears.

To avoid this kind of confusion, you should create a PDQ for each screen following 
this naming convention:

PDAAll_<filter name>

The query syntax should be written to return all records.

An example of the All Records PDQ:

Name: PDAAll_All Activities, Query: 'Action'.Search = "". 

NOTE: This filter only appears in the application. It is not used during 
synchronization and does not appear in the Set Filters dialog.

See “Query by Example Filters” on page 77 for more information on filter naming 
conventions.
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Summary of PDQ Filter Availability
Table 14 summarizes how the different filters are used. Some filters are 
synchronization filters—that is, they are only visible when the user synchronizes 
their data. Other filters are display filters—these filters are only available in the 
handheld application and are used to filter the records that are displayed on a 
screen. Some filters are both synchronization and display filters.

Administration of PDQ Filters
The following sections provide recommendations for creating and managing filters 
with various synchronization methods.

Companion Deployments
Administrators typically provide their users with an initial set of PDQ filters and 
instruct them how to manage the synchronization filters themselves later. Create the 
desired Default, General, and All Records PDQ Synchronization filters in the Siebel 
Server database, using the Application Administration >Predefined Queries screen, 
or from within the Siebel application screen with which the PDQ is associated. After 
the appropriate PDQs are created, make the PDQs public by deselecting the Private 
flag. The next time the users synchronize, their local databases are updated with 
the new PDQs.

Table 14. Availability of PDQ Filters

Filter Prefix Synchronization Filters Display Filters

PDA_<filter name> Available Available, if selected during 
synchronization from the Set 
Filters dialog

PDADef_<filter name> Available Available, if selected during 
synchronization from the Set 
Filters dialog

PDADef_*<filter name> Available Not available

PDAAll_<filter name> Not available Available
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In addition to using administrator-defined PDQs, Companion Sync (CS) users can 
define their own synchronization filters in Siebel Web Client or Siebel Mobile Web 
Client applications using the special naming conventions. See the previous section, 
“Predefined Query Filters” on page 80 for more information on filter naming 
conventions. Synchronization filters (PDQs) created by a user are initially available 
for use only by that user. A user-defined PDQ can be made public by clearing the 
Private field in the PDQ record in the Predefined Queries view of the Application 
Administration screen.

NOTE: If you create a PDA PDQ, you need to restart the Handheld Component for 
that new PDQ to get registered as part of a Handheld synchronization.

There are several sample PDQs in the sample database, as well as in the Siebel 7 
seed data.

Stand-Alone Deployments
For Direct Server Sync deployments, only administrators or users with access to the 
Siebel Application Server through a Web client can manage the PDQ sync filters. 
This simplifies end-user training, but requires you to carefully manage the filters on 
an ongoing basis. 

Administrators manage most end user filtering needs through the use of public 
PDQs.   These PDQs are made available to all end users and, therefore, must be 
defined with the needs of all end users in mind.   Private filters, targeted for 
individual user needs, can be created only if the administrator logs into the Siebel 
Web Client application as an end user, navigates to the applicable screen, and 
creates the desired filter

Filtering Data for Pick Applets
Configuration file directives are used only in specific situations and should not be 
considered the primary method for filtering data. Modify these filters cautiously and 
only with the support of skilled Siebel configurators.
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Use default Business Object declarations to force the extraction of data for a given 
business component in the context of a given Business Object and Visibility type. 
(See “Designating Visibility” on page 89 for more information on visibility 
designations.) The Default Business Object extractions are performed in the first 
phase of data extraction.

You will most often use these declarations to extract additional data that is not 
extracted as part of the user interface extraction. This may be useful for business 
components that are referenced programmatically by other business components, 
but are not exposed in the user interface. The default Business Object declarations 
are used to enforce the extraction of a subset of data to the handheld that would not 
have been otherwise extracted or, most commonly, to filter the data downloaded for 
dynamic picklists or pick applets.

All pick data is not downloaded to the device due to the memory constraints on the 
device. Only pick data for fields that are editable is downloaded. Therefore, if you 
are doing a query on a pick field, you may not be able to display the picklist. When 
viewing a record in an applet, if a pick field is read-only, its pick button will be 
disabled. If end-users select a read-only field with a pick control, they receive the 
following error: No data available in picklist because field is read-only.

NOTE: Catalogs control visibility of data in pick applets. To make sure that pick 
applets contain valid data, the administrator must add data to a relevant catalog and 
make sure users have visibility to the catalog using the Catalog screen’s Access 
Groups view tab. 

Configuration File Directives
Within the Siebel Handheld application .cfg file, there is a [PDA] section that 
contains a number of handheld-specific parameters. One of these parameters, the 
Default Business Objects declarations (DefaultBusObjs), can be used as a Handheld 
Sync data filtering tool. Two directives that are used to filter data are:

■ DefaultFields. This directive specifies which fields in the specified Business 
Component are downloaded to the device.
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■ DefaultBusObjs. This directive determines the Business Objects and Business 
Components that are downloaded. This directive is used primarily for those 
Business Objects and Business Components that are used internally in the code, 
but do not have applets or views based on them.

In the DefaultBusObjs directive, you can specify that a QBE be applied to a 
Business Component. You can also use the directive to set the visibility on the 
Business Object. This visibility is applied to the parent Business Component of 
the Business Object.

However, be extremely careful when modifying these declarations. The default .cfg 
file created during installation of the application includes certain Default Business 
Object declarations that are required for the application to function properly. Be 
sure that Default Business Object declarations for business objects like Shift, System 
Preferences, List of Values, System, and others are never modified. The business 
objects that are required for internal application functioning differ by application, 
so consult Siebel Technical Support or Siebel Expert Services before modifying these 
parameters.

Examples of Business Object Declarations
You can set the PDQ in the Default Business Object declarations as described in the 
following examples.

The general format of a .cfg file is as follows:

DefaultBusObjs<##> = <Business Object name> | <Visibility> | <PDQ> 
| <Business Component 1> | <QBE for Business Component 1> | <Business 
Component 2> | <QBE for Business Component 2>

An example from the Handheld .cfg file:

DefaultBusObjs22 = Opportunity | 3 | | Account | [Account Status]  = 
"Active" | Action | [Start Date] >= Today () - 30 AND [Start Date] 
< Today () + 90
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The example Default Business Object declaration results in an extraction of the 
Account and Action business components where they occur with visibility of 3 
within the Opportunity Screen. See “Designating Visibility” on page 89 for further 
information on visibility codes. The Account business component is filtered to 
include only Active status Accounts. The Action business component is filtered to 
include current Activities (those occurring in the previous months and over the next 
three months).

Note that there is no PDQ included in the example. A PDQ is only included when 
you want to force the use of a particular PDQ synchronization filter. See “Predefined 
Query Filters” on page 80 for more information on PDQ synchronization filters.

In the following example, the declaration is used to extract all of the Price List Line 
Items that will display within the Orders screen.

DefaultBusObjs13=  Order Entry (Sales)|0||Price List Item|

Note that this declaration lacks an associated QBE statement. When this is the case, 
all of the records available to the user for the given visibility are extracted.

Another less common way to use the Default Business Object declarations is to set 
a single PDQ synchronization filter for the Business Objects or Screens that are 
synchronized.

Designating Visibility
It is very important that you use the correct visibility designation in the Default 
Business Object declarations. The visibility entered should be the visibility that 
governs the data displayed for the business component within the context of the 
Business Object specified in the declaration. In the previous Example 1, visibility 
code 3 is designated. This corresponds to All Visibility, which is the visibility that 
applies to the Account business component when it is used in a pick applet.
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You determine the correct visibility to use by examining View and Business 
Component properties within Siebel Tools. When creating a Default Business Object 
declaration to restrict the volume of data extracted for a pick applet, begin by 
examining the Popup Visibility Type in Business Component Properties. Cross-
reference the visibility type to the list below, and enter the appropriate visibility 
code in the declaration. If the Popup Visibility Type field on the Business 
Component is null, the default value is All. Table 15 summarizes popup visibility 
types and the corresponding visibility codes.

.

NOTE: Do not use the Group, Catalog, and Sub Organization PopupVisibilityType. 
This is not supported in the CE handheld applications.

Table 15. Visibility Codes

Popup Visibility Type Visibility Codes

Sales Representative 0

Manager 1

Personal 2

All 3

None 4

Organization 5

Contact 6
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Overriding the Popup Visibility
If the Popup Visibility Type setting is not sufficiently restrictive (for example, All 
visibility), this can lead to a large number of records being extracted when the 
picklist is processed during synchronization. Making the Popup Visibility Type more 
restrictive reduces the number of records extracted for picklists. The 
OverridePopupVisibility user property for an applet overrides the Popup Visibility 
Type on a business component. Use this property when the desired visibility differs 
from the business component’s Popup Visibility Type, and you do not want to 
change the Popup Visibility Type. If several picklists use the same business 
component, you can also use the OverridePopupVisibility user property to vary the 
visibility of the picklists in the different applets.

There are two considerations you should keep in mind if multiple applications are 
sharing the same repository. First, changing the Popup Visibility Type has a global 
effect for all instances where the business component is used. If multiple 
applications share the same repository and use the same business components, 
changing the Popup Visibility Type for a common business component could have 
an undesirable effect for another application. Second, if multiple applications share 
the same applet, the picklist in each applet shares the same visibility as defined by 
OverridePopupVisibility property. This is because the OverridePopupVisibility 
property is set on the containing applet.
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In Siebel Tools, go to Applet > Applet User Properties, and define the 
OverridePopupVisibility user property on the applet containing the control that 
opens the pick applet. See Table 16 for a description of the syntax. Assign a value 
to this property using the syntax shown, where <buscomp field n> is the 
underlying business component field of an applet control or column, and 
<visibility type> is the code corresponding to the desired visibility of the picklist’s 
business component. (See Table 15 for a list of the visibility codes.) Because the 
name of the OverridePopupVisibility parameter must be unique, append a unique 
number to the name of the parameter for any other picklists, for example, 
OverridePopupVisibility1, OverridePopupVisibility2, and so on.

NOTE: If OverridePopupVisibility is used, then the picklist and pick applet search 
specifications are ignored during synchronization when the records for the picklist 
are extracted.

Table 16. OverridePopupVisibility Syntax

Name Value

OverridePopupVisibility <buscomp field 1>, <visibility type>

OverridePopupVisibility1 <buscomp field 2>, <visibility type>

OverridePopupVisibility<n> <buscomp field n + 1>, <visibility type>
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This chapter discusses the following aspects of deploying the handheld application: 

■ Server installation, including how to optimize the server

■ Web client installation

■ Handheld installation, including administrative tasks that must be performed 
before the handheld application is deployed

The audience for this chapter is Siebel application developers, database 
administrators, and system administrators.

Scripting
The Siebel Handheld Client does not execute Siebel Visual Basic (VB) or Siebel 
eScript scripting.

The Siebel Web Client application runs Siebel VB or Siebel eScript scripts and 
specialized business component logic at synchronization time, rather than in real 
time on the handheld device. This has significant consequences in applets and 
controls, because scripts attached to applets and controls are ignored.

Be aware of the following additional issues with respect to scripts and validation: 

■ Deactivating scripts. Do not deactivate existing scripts in Siebel Tools to make the 
handheld device or the synchronization process accept data it is excluding. The 
script is probably used by the Siebel Web Client, and you can cause damage 
elsewhere.
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■ Calls to user interface methods. When a business component script makes a call 
to a user interface method (such as MsgBox), the script cannot be executed, and 
the record update, deletion, or addition is rejected during synchronization. 
Strictly speaking, a script attached to a business component should not interact 
with the user interface, but it is nevertheless a common practice.

Any Siebel Visual Basic code should be restricted to the business component level. 
Applet-level Siebel Visual Basic will not be executed and, therefore, should not be 
written for the Siebel Handheld Client application. As a substitute to using Siebel 
Visual Basic on the Siebel Handheld Client application, for real-time execution, use 
the following business component user properties:

■ BC/Field Read Only Field...for making fields or business components read-only 
dynamically.

■ Pickmap for fields on the picklist.

Do not use message boxes or prompts on the Siebel Visual Basic code used in 
conjunction with the Siebel Handheld Client application business components. If 
the business component is shared between the Siebel Handheld Client application 
and a laptop, use the following construct to determine if the code is being executed 
in real time on the laptop or during synchronization:

'ActiveViewName is only available when the script is called real time 
on the laptop

If (TheApplication.ActiveViewName<>"") then

MsgBox"....."

End If
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Server Installation
This section provides an overview of important factors to consider when planning 
Direct Server Synchronization (DSS) infrastructure. One aspect of successful 
planning and execution of a Siebel Handheld DSS deployment is to understand 
hardware and network requirements. While these factors are generally applicable 
to all deployments, there are unique aspects to each customer configuration and 
implementation strategy. Therefore, it is highly recommended that customers 
conduct detailed configuration, sizing, and production readiness reviews with 
Siebel Expert Services. This is especially important for complex deployments, such 
as those supporting large numbers of users over wide geographic areas. 

For each new customer deployment of Siebel Handheld, there is a mandatory Siebel 
Professional Services program called the Siebel Mobile eBusiness Competency 
QuickStart Engagement or the Siebel Expert Services Handheld Review Package. For 
more information about this program, contact Siebel Global Services or your district 
manager.

You can also improve the performance and scalability of DSS deployments by 
working with the Siebel application server component parameters. For more 
information about the Siebel application server, see “Optimizing Server Process 
Management” on page 104.

NOTE: The recommendations in this chapter are general ones and are intended to 
raise your awareness of the key factors in handheld synchronization, performance, 
and scalability. These factors must be confirmed for your actual environment, and 
the usage patterns in your enterprise should be taken into consideration.
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Server Topology Overview
The diagram in Figure 7 shows the servers and components that are required to 
deploy Direct Server Sync. The components are the Siebel database, Siebel server, 
Siebel Web engine, and Siebel Handheld. The synchronization components are the 
Siebel Sync engine which resides on Siebel server and the Sync client on Siebel 
Handheld. 

NOTE: Companion Sync uses Siebel Remote to complete the synchronization process 
to the Siebel server from the laptop. For more information, see Siebel Remote and 
Replication Manager Administration Guide.

You can improve performance by properly selecting the machine that each server 
runs on (Web server, Siebel server, database server). For example, increasing the 
memory and number of spindles improves the database server performance, and 
increasing the number of CPUs and the amount of memory improves the 
performance of the application server.

Figure 7. DSS Servers and Components
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Recommended Hardware and Network Configuration
There are many factors to take into account when designing and implementing your 
server and network hardware and architecture, and sizing your database. The 
critical factor in sizing a handheld implementation is the expected peak 
synchronization load. Specific application variables to consider in calculating this 
load are: the number of concurrent users, number of transactions, and size of the 
data file. These variables should be considered within the context of the hardware 
specifications, including memory and processor speed.

The following resources are available as you plan your Siebel Handheld 
implementation:

■ Refer to Microsoft and manufacturer documentation for comprehensive 
information on server hardware and registry parameters.

■ Refer to Siebel Technical Note 405, Siebel Handheld Synchronization for specific 
recommendations on the following topics:

■ Server Architecture

■ Server Hardware and Registry Parameters

■ Database Server Sizing

■ Database Tuning

■ Dial-Up and Network

■ Wireless

■ VPN (Virtual Private Networks)

■ The Expert Services Handheld Review Package assists customers with planning 
their hardware and network for handheld implementations. Contact Siebel 
Global Services for more information about this program.
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Server Installation for Direct Server Sync
The server components that are required for Siebel Handheld are installed when 
you install the Siebel server. See Siebel Server Installation Guide for Microsoft 
Windows for details on installing and configuring Siebel server. The Siebel server 
installer copies the necessary DLLs to create an Object Manager for Direct Server 
Sync and creates and configures a Server Component and Component Group. The 
rest of this subsection describes which options you must select to correctly install 
the software, along with creating or configuring additional Object Managers.

Installing the DSS Components Using the Siebel Server Installer
Install the Siebel server, following the instructions in the Siebel server installation 
guide for the operating system you are using. When you reach the Setup Type screen 
in the Installer wizard, you will see three installation options:

■ Typical. This setup option installs all Siebel server components except those 
displayed. 

■ Compact. This setup option installs only those components necessary to run the 
Siebel server, but no additional components or help.

■ Custom. This setup option lets you customize your installation by choosing the 
specific components you want to install.

To install the Direct Server Sync components with your Siebel Server installation

1 Choose the Custom setting, and then click Next.

NOTE: At this screen, you may also choose a different directory for your Siebel 
server installation. 

2 Choose from the following components:

■ Object Manager Component

■ Handheld Synchronization

■ Siebel Data Quality Connector

■ Remote Search Support
98 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Deployment

Server Installation
■ Siebel Java Integrator

The listed Custom Installation options are all selectable.

NOTE: You must Handheld Synchronization to enable Direct Server Sync for your 
DSS installation.

3 Click Next.

Continue with the installation in Siebel Server Installation Guide for Microsoft 
Windows.

The install wizard automatically installs and configures the DSS components. In 
addition, the installer creates a configuration file that includes the parameters 
necessary to properly run the DSS server components and the Business Component 
filters file.

Editing the DSS Object Manager Configuration File
You must edit the configuration (.cfg) file associated with the DSS server 
components that you installed and configured to reflect your company's 
environment.

To edit your configuration file

1 In Windows Explorer, navigate to the directory where the Siebel server is 
installed and locate the configuration file associated with the DSS server 
component. By default, this directory is C:\Siebel Root\ siebsrvr\BIN\ENU.

NOTE: By default, the name of the DSS Object Manager configuration file is  
phce.cfg, but you can change the name of this file.

2 Create a backup copy of the configuration file and name it phce.cfg.bak.

This step allows you to recover the original version of the file if you encounter 
errors.

3 Open the configuration file using Microsoft Notepad.
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4 Enter parameter values appropriate for your deployment.

The following parameters in the .cfg file may need to be edited to reflect your 
environment. All other parameters in this section should not require change. 

Parameter Default Value Description

[Siebel] 
section 

ApplicationName Siebel ePharma CE The handheld application. 
This value must match the 
name of the application as it 
is specified in Siebel Tools.

ApplicationTitle Siebel ePharma CE The name of the Siebel 
Handheld application as 
shown on the Title bar on 
the browser. This parameter 
is only used if the Siebel 
Tools application developed 
for the handheld is run on 
the Web client.

ApplicationSplashText Siebel ePharma CE The Siebel Handheld 
application name as shown 
on the splash screen. This 
parameter is only used if the 
Siebel Tools application 
developed for the handheld 
is run on the Web client.

ComponentName Required for Direct Server 
Sync, it is entered in the 
registry on the handheld 
device.
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5 Save your changes.

6 Restart the component or server.

Configuring Server Logging Levels
You can specify the level of logging to the server hhsync.*.log files by setting the 
LoggingLevels parameter in the [PDA] section of the .cfg file. By default, the 
parameter is set to the following:

[PDA]

LoggingLevels = 23333

Generally, you should start with the default values. These values work for most 
customers and were selected to optimize performance. If you are experiencing 
problems with the application, change the logging levels to 77777 to capture 
additional diagnostic information. Performance degrades slightly as you increase 
the logging levels, but in most instances, this is not discernible. Once the problem 
is resolved, reset the logging levels to their default values.

[PDA] 
section

AppDir hhsync\phce The directory location for 
the user's synchronization 
files.

PDAQBEFile The Business Components 
filtering file used by the 
synchronization process.

RemoteCfgName epharma.cfg Name of the Siebel Mobile 
Web Client configuration 
file. If the parameter is not 
specified in the .cfg file, the 
default is siebel.cfg. This 
parameter is used by Siebel 
Handheld Sync to invoke 
Siebel Remote. It applies 
only when synchronizing 
using the Integrated Sync 
option.

Parameter Default Value Description
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Each number specifies two things:

■ The type of log record. (See Table 17 for the specific values.)

■ The amount of information that is logged. (See Table 18 for the specific values.)

The different types of log records are described in Table 17 and correspond to the 
following format: LoggingLevels = emdts.

Each type of log record (emdts) can be set to one of the logging levels described in 
Table 18:

Table 17. Types of Log Records

Log Record Description

e Transaction events captured and returned to the client application as error 
messages

m Log records created by the metadata extractor

d Log records created by the database extractor

t Log records created by the transaction processor

s Log records created by the mainline synchronization code

Table 18. Logging Levels

Logging Level Description

0 Suppress all log records

1 Process Critical records only

2 Process Critical and Error records only

3 Process Critical, Error, and Warning records only

4 Process Critical, Error, Warning, and Information records only

5 Process Critical, Error, Warning, Information, and Debug records
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Figure 8 shows the default settings for the LoggingLevels parameter. The parameter 
specifies both the type of log record and the logging level. The figure describes the 
logging levels for the default setting.

Figure 8. Logging Levels Parameter

CAUTION: The maximum level for transaction events (e) is 2. It is recommended that 
you do not lower the value for logging transaction events. If the transaction events 
level is set to 0 or 1, transaction error messages are not sent to the client, and 
transactions will silently fail.

NOTE: The salesceqbe.txt that is shipped with the application does not include a 
[PDA] section. What this means is that the defaults for all PDA parameters apply. 
For example, the default setting of 23333 applies for the LoggingLevels parameter. 
If the LoggingLevels parameter or any other PDA parameter needs to be changed, 
administrators can add this section to the end of the file and manually enter the 
parameter.

LoggingLevels = 23333

Metadata Extractor 
Database Extractor 

Transaction Processor 
Sync Code

3=Critical, Error, and 
Warning Messages

2=Critical and Error
Messages

emd t s

Transaction Events
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Optimizing Server Process Management
Several parameters are outlined below that help optimize server processing for 
Direct Server Sync. To set these parameters, log into a Siebel client as a user with 
Administrative responsibility and navigate to Servers >Components >Component 
Parameters through the Screens menu. Select the SalesCE ObjManager (or the 
appropriate Siebel Handheld application) and update the following parameters to 
optimize threads per process. For further information and assistance, see Technical 
Note 405, Siebel Handheld Synchronization, and contact Siebel Global Services 
about the Siebel Expert Services Handheld Review Package.

■ Max tasks. This parameter determines the maximum number of threads that can 
run concurrently for a given component. The value of this parameter should 
equal the maximum expected peak number of concurrent synchronizations.

■ Min MT servers. This parameter determines how many multithreaded server 
processes are started by default for the Siebel Object Manager.

■ Max MT Servers. This parameter defines the maximum number of processes 
supported by the instance of the Siebel Object Manager. The value for this 
parameter should be the same as Min MT servers and should be set so that 
threads per process (Max Tasks/Max MT Servers) is optimized.

Synchronization Performance and Scalability
There are a number of factors that affect the performance and scalability of 
handheld synchronization. It is very important that administrators and those 
involved in the design and deployment of Siebel Handheld understand the impact 
of usage parameters on synchronization performance and scalability. For more 
information, see Technical Note 405, Siebel Handheld Synchronization for 
application-specific variables affecting synchronization and data from 
synchronization scalability tests. In addition, the Siebel Expert Services Handheld 
Review Package assists customers with optimizing the synchronization 
performance of their handheld installations. Contact Siebel Global Services for more 
information about this program.
104 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Deployment

Mobile Web Client Installation
Using Multiple Synchronization Servers
As you scale your deployment, you may need to use multiple synchronization 
servers to accommodate all of your users. Your end users must be manually 
assigned to a particular server. Resonate products cannot be used for load 
balancing. Refer to Technical Note 405, Siebel Handheld Synchronization and to 
your hardware manufacturer’s documentation for more information on scaling 
deployments.

Synchronization Security
In Siebel Handheld Version 7.5.3 and beyond, the synchronization data stream can 
be secured using SSL (Secure Sockets Layer). 

Mobile Web Client Installation

You must edit the configuration (.cfg) file associated with syncmanager.exe (the 

Companion Sync executable) that was installed with the Siebel Mobile Web Client 

to reflect your user's environment. It may not be practical to individually edit each 

Companion Sync user's .cfg file; therefore, it is recommended that you create one 

edited file and distribute it to all your users with Siebel Anywhere. See Siebel 

Anywhere Administration Guide for more information.

Handheld Device Installation
Before you deploy the handheld application, there are several tasks you need to 
perform:

■ Editing the installation configuration file (setup.ini)

■ Enable database backup

■ Setting up installation on the CompactFlash card
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■ Verifying that the logging parameters are set correctly

■ Changing the DSS URL

■ Print Templates

■ Creating a stand-alone installer (This is optional.)
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Editing the Installation Configuration File
The Siebel Handheld application setup.ini file configures the Siebel Handheld Client 
application installer. Before you deploy a custom-configured Siebel Handheld 
application, you must update the parameters in the setup.ini file so that the correct 
values are written to the device registry before distributing the client installer to end 
users.

The setup.ini file resides in the Siebel Handheld application directory (for example, 
the ePharma Handheld directory) on the Siebel Handheld CD-ROM. To modify this 
file, create a Siebel Handheld installation directory on the network, or create and 
duplicate a custom CD-ROM for distribution to end users. This installation directory 
must include the same files and directory structure as the original CD-ROM. Then, 
modify the setup.ini file in the custom installation directory.

Table 19 lists the parameters that you may need to modify in the setup.ini file, their 
default value, and a description of the parameter.

Table 19. Siebel Handheld Sync setup.ini Parameters

Parameter Default Value Description

Version 7.5.2 Version of the desktop Siebel 
application against which the Siebel 
Handheld version synchronizes.

ApplicationName Siebel ePharma CE The handheld application. This value 
can be ignored in the setup.ini file 
because the value will be read from the 
configuration file on the server (for 
DSS) or the PC (for CS).

ApplicationSplashText ePharma CE Handheld The Siebel Handheld application name 
as shown on the splash screen.

MultiCurrency True Required for the application to handle 
multiple currencies.

DSSURL http://Web Server Name 
or IP address/Virtual 
Directory Name

Required for Direct Server Sync. This 
value is entered in the registry on the 
handheld. See “Changing the DSS URL 
on Devices” on page 114 for more 
information on this parameter.
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[Printing] Section See Appendix F, “Print Configuration 
Settings,”for more information on the 
parameters used to configure printing.

[Backup] Section Enables handheld database backups.

See “Editing the Database Backup 
Parameters” on page 112 for more 
information on settings for the 
parameters in this section of the 
setup.ini file.

[ApplicationLocation] Section Specifies where the handheld 
application and database are installed.

See “Setting up Installation on a 
CompactFlash Card” on page 113 for 
more information on the parameters in 
this section of the setup.ini file.

InternetOptionReceiveTime
out

600000 Length of time to receive data (except 
data extraction) from the server before 
the handheld client times out. This 
parameter only applies to 
synchronizations using Direct Server 
Sync.

In milliseconds. The default value, 
600000, is 10 minutes.

InternetOptionSendTimeout 600000 Length of time to send data to the 
server in a single call the handheld 
client times out. This parameter only 
applies to synchronizations using 
Direct Server Sync.

In milliseconds. The default value, 
600000, is 10 minutes.

Table 19. Siebel Handheld Sync setup.ini Parameters

Parameter Default Value Description
108 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Deployment

Handheld Device Installation
InternetOptionDataExtractionTimeout 900000 Length of time to extract data from the 
server to the handheld device the 
handheld client times out. This 
parameter only applies to 
synchronizations using Direct Server 
Sync.

LogSqlStmts N This outputs all SQL statements 
generated by the handheld application 
to a log file in the Siebel Handheld 
directory on the handheld. See 
“Configuring Handheld Logging 
Parameters” on page 113 for more 
information on this parameter.

Table 19. Siebel Handheld Sync setup.ini Parameters

Parameter Default Value Description
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LogSSAErrors N This outputs all system error messages 
generated by the handheld application 
to a log file in the Siebel Handheld 
directory on the handheld. See 
“Configuring Handheld Logging 
Parameters” on page 113 for more 
information on this parameter.

SyncLogReportingLevel 1 Specifies the level of logging by Siebel 
Handheld Sync.

Valid values are:

0 – includes critical errors for the Siebel 
Handheld Sync client and all messages 
that are displayed to the end user.

1 – includes all error messages for the 
Siebel Handheld Sync client, repository 
version information, device Id, 
extraction Id, and last processed 
transaction Id.

2 – includes transactions that are sent 
to the server, schema file and repository 
file activity, and device information.

TXNErrorLevel 1 Specifies the level of transaction errors 
returned by the server and displayed to 
the end user.

Valid values are:

0 – returns only critical messages from 
the server. This setting is not 
recommended.

1 – returns all error messages from the 
server.

Table 19. Siebel Handheld Sync setup.ini Parameters

Parameter Default Value Description
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Enabling Database Backup
Siebel Systems provides a way to automatically back up a snapshot of the user’s 
database and current settings, and to restore those settings in the event of a total 
device failure. The backup functionality automatically copies all the necessary files 
to a single compressed file. Each time the user backs up, the backup process creates 
a new copy of the file and deletes older backups. The backup process must close 
the application in order to copy the RDBMS and handheld configuration files. After 
the files are copied, it automatically restarts the application.

The backup feature must be enabled in the application. (For more information on 
enabling the backup feature, see “Setting Up Database Backups.”) If the backup 
feature is enabled, a backup is created during every synchronization. This way, the 
user retains an up-to-date snapshot of the database, and older backup versions are 
removed.

When the database backup feature is enabled, a database backup occurs 
automatically at the end of each synchronization. This makes the overall time to 
synchronize somewhat longer. The size of the database and the speed of the 
CompactFlash card also affect the time it takes to complete synchronization.

NOTE: Backups should not be used as a replacement for synchronization.

Setting Up Database Backups
In order to back up the database:

■ Provide users with an external memory card.

■ Install the handheld application with the backup functionality enabled.

■ Instruct users to back up their database on a regular basis.

Backing Up to External Media
It is recommended that you back up to external media—for example, a 
CompactFlash card.
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Backing up data to a directory in memory is an option, if external media is not 
available on the handheld device. However, if the handheld device is damaged, the 
backup in memory may not be retrievable. Also, when backup data is stored in 
memory, the amount of memory available to run the application decreases, and 
application performance may suffer.

Editing the Database Backup Parameters
Before users can back up the database on their handheld devices, you must first 
enable the Backup menu item on the handheld application. This requires editing the 
setup.ini file to enable backup.

The following is an example of the default settings for the backup parameters:

[Backup]
BackupLocation= \Storage Card\Siebel Backup
BackupEnabled= N

■ BackupEnabled = [Y/N] The default is N (No). Change this setting to Y (Yes) 
to enable the Backup menu item and to trigger a backup to occur automatically 
after each synchronization.

If the product is installed with Backup = N, the backup menu item is disabled. 
You will need to change the parameter, then reinstall the product in order to 
enable the menu item.

■ BackupLocation = [Backup location] The default is an external storage card. 
Specify the location where you want the data backed up. It is recommended that 
you do not back up to internal RAM because this may have a negative effect on 
the performance of the application. However, if you back up to RAM, then 
specify the directory location where you want the data backed up.

For more information on the setup.ini file, see Chapter 7, “Installing the Handheld 
Application.”

Restoring from a Backup
For information on restoring a database from a backup, see “Backing Up and 
Restoring Data” on page 155.
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Setting up Installation on a CompactFlash Card
The default, when installing Siebel Handheld applications, is to install both the 
application and the database into RAM on the device. In most instances, there is 
sufficient available memory, and end users are satisfied with the application 
performance. There are situations, however, where you may need to optimize the 
application performance. You can improve performance by installing the Siebel 
Handheld application on an external storage device.

To improve the performance of the application, it is recommended that you install 
the application binary files on a CompactFlash card. By doing so, you can free up 
program memory. Installing the data on the CompactFlash card is not recommended 
because performance will likely degrade.

You can specify, in the application’s setup.ini file, where the application files and 
database files are to be installed. By default, this is set to the handheld device. In 
the ApplicationLocation section of the setup.ini file, there are two parameters. The 
following shows the default settings for these parameters:

[ApplicationLocation]
ApplicationBinariesLocation=Device
ApplicationDataLocation=Device

■ ApplicationBinariesLocation = Device. The default is Device. To improve 
application performance, set this to CF (CompactFlash).

■ ApplicationDataLocation = Device. The default is Device. It is recommended 
that you always install the data files on the device.

After you have edited the setup.ini file, follow the instructions for installing the 
Siebel Handheld application on the client.

Configuring Handheld Logging Parameters
Before you deploy your application, verify that your logging parameters are set 
correctly in the setup.ini file. The parameters and their default values are:

[Logging]

LogSqlStmts = N
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LogSSAErrors = N

The LogSQLStmts and LogSSAErrors parameters log messages to the 
sql_stmt_log.txt and ssa_errors_log.txt files, respectively. You may want to set these 
parameters to Y for debugging while you are developing your application. However, 
once you are ready to deploy your application, be sure to reset the values of both 
parameters to N. For more information on these log files, see “Handheld Device 
Logs” on page 234.

CAUTION: If the LogSQLStmts and LogSSAErrors parameters are set to Y, then the log 
files will get very large and use up the available memory on the handheld device.

Changing the DSS URL on Devices
Once the handheld application is installed, the DSS URL cannot be changed. If you 
need to change the DSS URL, contact Siebel Technical Support.

Installing Print Templates
If your application allows printing, you must include all print templates in the 
template subdirectory of the Siebel Handheld Install directory. The print templates 
are language-specific, so copy the templates to the template subdirectory within the 
language directory of the language you are deploying (for example, 
...\ENU\Template). See the system requirements and supported platforms 
documentation for your application for the language codes.

See Appendix F, “Print Configuration Settings”for more information about Printing.
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Installing from External Media
You may create an image of the Handheld Installer that can be loaded onto external 
media such as a CompactFlash card. When you create a stand-alone installer 
platform, a Cabinet file (CAB) is created in a location that you specify. On the Pocket 
PC platform, this file is named siebel.hpc2k_arm.cab. On the Handheld PC 
platform, this file is named siebel.hpc2k_arm.cab. You can copy the CAB file to a 
CompactFlash card, insert the card into the handheld device, and double-click on 
the file to install the Siebel Handheld application on the device.

NOTE: When installing the application on the device, the end user is asked if he or 
she wants to install the application in the default directory. Regardless of the user's 
answer, the application is always installed in the directory specified by the setup.ini 
file. Therefore, the only way to change the directory the application is installed in 
is to modify the parameters in the ApplicationLocation section of the setup.ini file.

Creating a Stand-Alone Installer
Users who synchronize in DSS mode may not have a PC, and so may not be able to 
create a partnership and synchronize using Microsoft ActiveSync. You can install 
the application for each user through a standard partnership, or you can configure 
a stand-alone installer as shown in the following pages.
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During the installation, as shown in Figure 9, the InstallShield Wizard screen 
prompts you by asking, Would you like to deploy a CAB file to enable rapid 
installation for additional devices? You can configure a stand-alone installer by 
selecting Yes.

You are prompted to select a language for the application and to specify a location 
for the CAB file. The installer creates the CAB file in the location you specify.

The CAB file is a self-extracting file that includes all the files needed to install the 
Siebel Handheld application on the handheld device. When you double-click the 
file, the CAB file installs the application.

Figure 9. CAB File Option
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 Synchronization Conflict Handling and
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When multiple end users synchronize with a remote database, transaction conflicts 
may occur which can result in data loss. The Extended Pick and Extended Insert 
functionality minimizes synchronization conflicts. If transaction conflicts are 
unavoidable, then Siebel Handheld Journaling captures the transaction information 
so that the data can be recovered. The combination of Extended Pick, Extended 
Insert, and journaling eliminates the potential for data loss.

Preventing Synchronization Transaction Conflicts
There are two features that minimize synchronization transaction conflicts.

■ Extended Pick processing

■ Extended Insert processing

The next several sections describe these features in detail.

Extended Pick Processing
The handheld is used to capture and record transactions entered by the handheld 
user. During synchronization, these transactions are processed on the server. A 
situation may arise in which a transaction fails when it is applied to the Siebel 
server (through Direct Server Sync) or Siebel Mobile Web Client (through 
Companion Sync)—both of which are referred to as “server.” For example, a Siebel 
ePharma Handheld user creates a professional call activity for one of his contacts. 
However, since he last synchronized with the server, the contact involved in this 
transaction was deleted from the server database. When he tries to synchronize his 
handheld, the server does not find his contact, and the call activity for the contact 
cannot be inserted into the server database. To generalize this example, any 
transaction that involves data selected through pick lists or pick applets will fail on 
the server if that pick data is not present at the time of synchronization.
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With many handheld users synchronizing with Siebel server and modifying data at 
different times, this scenario is not uncommon.

The following describes how a pick transaction is recorded on the handheld device 
and processed on the server during synchronization. Assume that the handheld 
user wants to create a new call activity for the contact. In order to do this, the user 
inserts a new record in the Professional Call screen and “picks” the desired contact. 
When the contact is selected on the handheld, the Row Id of the contact (Contact 
Id) is recorded. However, on the handheld, the application does not record any of 
the pick map fields associated with the contact; only the Contact Id is recorded. 
When the user synchronizes his handheld, that Contact Id is used to locate the 
contact record in the server database. The Contact Id is then used to retrieve all of 
the fields used in the pick map for the Contact Id (Last Name, First Name, Middle 
Initial, Address, City, State, Zip Code, and so on).

In order to minimize pick processing failures, the handheld must record the pick 
row Id and all of the pick map data that is required for a successful transaction. This 
data must be recorded at the time of the pick, so that it can be passed to the server 
for processing. This enhanced functionality is called Extended Pick processing. 
Now, when the user synchronizes, the transaction is processed on the server as 
follows:

■ The synchronization process first looks for the pick record on the server 
database. For example, to add an activity it looks for the contact and, if it finds 
the contact, it retrieves the necessary data and adds the activity. This is the 
default behavior. 

■ If the server does not find the pick map record in the database and extended pick 
processing is enabled, it retrieves the pick record Id and pick map data from the 
handheld transaction and applies the data directly to the server.

Enabling Extended Pick Processing
You can enable Extended Pick processing in two ways:
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■ Configuration file parameter

The configuration file parameter applies globally throughout the application. 
When enabled, every handheld pick transaction is subject to pick processing. 
The parameter is set as follows:

DefaultHandheldSyncPickMode=Mode

Table 20 describes the settings for this parameter.

Table 20. Configuration File Setting

Configuration File Parameter Mode Value Description

DefaultHandheldSyncPickMode NoFail Turns Extended Pick processing ON

FailOnError Turns Extended Pick processing OFF. 
This is the default behavior if the 
parameter is not specified in the .cfg 
file.
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■ Business component user property

The user property is defined on specific business components. The syntax for 
setting Extended Pick on a business component and the parameter values 
(Table 21) follow:

HandheldSyncPickMode=Fieldname|Mode

You may apply Extended Pick processing to multiple fields in a single business 
component, using the following syntax:

HandheldSyncPickMode=Fieldname1|Mode1, Fieldname2|Mode2

The setting on the business component takes precedence over the setting in the 
configuration file. For example, you can use the business component setting to 
nullify the global application of Extended Pick in the configuration file. See 
“Recommended Extended Pick Processing Settings” on page 123 for an example. 
Conversely, you can enable Extended Pick processing on specific business 
components if the configuration file setting has disabled the functionality.

Table 22 shows the combined effect of the settings in the configuration file and on 
a business component.

■ The business component setting always takes precedence over the setting in the 
configuration file. 

■ If there is no setting on a particular business component, the configuration file 
setting applies.

Table 21. Business Component User Property Parameters

Business Component User Property Parameter Value Description

HandheldSyncPickMode Fieldname — Specify the field name 
as defined in Siebel 
Tools.

Mode NoFail Turns Extended Pick 
processing ON.

FailOnError Turns Extended Pick 
processing OFF.
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■ If there is no setting in either the configuration file or on the business 
component, the default behavior is for Extended Pick to be turned OFF.

Recommended Extended Pick Processing Settings
It is recommended that you use the Extended Pick processing settings in the 
following way:

■ Turn Extended Pick processing off globally. This is specified in the configuration 
(.cfg) file.

■ Activate Extended Pick processing on the following fields for critical business 
components:

■ Pharma Professional Call - CE. Last Name|NoFail, Address|NoFail, Contact 
Id|NoFail, Contact Address Id|NoFail

■ Pharma Call Products Detailed - CE. Name|NoFail

■ Pharma Call Sample Dropped - CE. Name|NoFail, Lot Name|NoFail

■ Pharma Account Call - CE. Account Name|NoFail, Address|NoFail, Account 
Id|NoFail, Account Address Id|NoFail

■ Pharma Promotional Items Dropped - CE (Name). Name|NoFail

Table 22. Combined Effect of Extended Pick Settings

Business Component Setting
HandheldSyncPickMode=

Configuration File Setting
DefaultHandheldSyncPickMode=

NoFail FailOnError No Setting in .cfg file

NoFail NoFail NoFail NoFail

FailOnError FailOnError FailOnError FailOnError

No Setting on Business 
Component

NoFail FailOnError FailOnError
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The ePharma Handheld application is shipped with these recommended settings.

NOTE: When Extended Pick processing is enabled, any update conflicts that occur 
for that pick field are resolved using the “Client Wins” conflict resolution directive. 
For fields that do not have Extended Pick processing enabled or that are not pick 
fields, this does not apply. Please make a note of this behavior when using this 
feature.

Extended Insert Processing
When the server executes an insert transaction and the insert fails, there are two 
ways the insert failure can be handled:

■ A record is logged that indicates the insert failed, and synchronization 
continues. This is the default insert behavior. If it is enabled, the Handheld Sync 
Journal can be used to recover the data.

■ The insert failure is logged, including details of the failure, and synchronization 
is interrupted. This is the extended insert behavior. Extended insert behavior 
guarantees that, should an insert fail, data loss does not occur since 
synchronization is stopped until the circumstances causing the failure are 
resolved.

NOTE: If Extended Insert processing takes place, synchronization is interrupted. The 
synchronization process will continue to fail until the problem is resolved. End 
users will need to contact their system administrators to recover from the failure. 
The recovery effort may involve modifying transactions queued for processing, 
modifying data on the server, or reentering transactions through the handheld 
application.

Enabling Extended Insert Processing
You can enable Extended Insert processing in two ways:
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■ Configuration file parameter

The configuration file parameter applies globally throughout the application. 
When enabled, every failed insert interrupts synchronization. The parameter is 
set as follows:

DefaultHandheldInsertMode=Mode

Table 23 shows the settings for this parameter.

■ Business component user property

The user property is defined on specific business components. The setting in the 
business component takes precedence over the configuration file setting. The 
syntax for setting the Extended Insert on a business component and the 
parameter values (Table 24) follow:

HandheldInsertFailMode=Mode

Table 23. Configuration File Setting

Configuration File Parameter Mode Value Description

DefaultHandheldInsertMode NoFail Disables Extended Insert 
processing. This is the default 
behavior if the parameter is 
not specified in the .cfg file.

FailOnError Enables Extended Insert 
processing.

Table 24. Business Component User Property Parameter

Business Component User Property Parameter Value Description

HandheldInsertFailMode Mode NoFail Disables Extended 
Insert processing.

FailOnError Enables Extended Insert 
processing.
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Table 25 shows the combined effect of the setting in the configuration file and the 
setting on a business component.

■ The business component setting always takes precedence over the setting in the 
configuration file. 

■ If there is no setting on a particular business component, the configuration file 
setting applies.

■ If there is no setting in either the configuration file or on the business 
component, the default behavior is for Extended Insert to be disabled.

Recommended Extended Insert Processing Settings
It is recommended that you use the Extended Insert processing settings in the 
following way:

■ Turn Extended Insert processing off globally. This is specified in the 
configuration (.cfg) file.

■ Activate Extended Insert at the business component level for the following 
critical business components:

■ Pharma Professional Call - CE

■ Pharma Call Products Detailed - CE

■ Pharma Call Sample Dropped - CE

■ Pharma Account Call - CE

Table 25. Combined Effect of Extended Insert Settings

Business Component Setting
HandheldInsertFailMode=

Configuration File Setting
DefaultHandheldInsertMode=

NoFail FailOnError No Setting in .cfg File

NoFail NoFail NoFail NoFail

FailOnError FailOnError FailOnError FailOnError

No Setting on Business 
Component

NoFail FailOnError NoFail
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■ Follow the recommendations for Extended Insert processing in conjunction with 
the recommendations for Extended Pick processing.

NOTE: When Extended Pick processing is not enabled, the likelihood of a pick failure 
resulting in an insert failure increases. Therefore, it is recommended that Extended 
Pick be used in conjunction with the FailOnError setting for Extended Insert.

Recovering Data with Siebel Handheld Journaling
Siebel Handheld Journaling compiles the details on all transaction conflicts in a log 
file dedicated for that purpose. This log file, in XML format, can be viewed in a 
Journal Viewer which allows administrators to review data and to copy and recover 
data.

In order to use the handheld journaling, three parameters in the handheld 
configuration (.cfg) file must be set.

The parameters and their default settings are as follows:

EnableJournaling=False
LoggingLevels=23333

■ EnableJournaling=False. This parameter, when set to True, enables journaling. 
The default (False) disables journaling.

■ LoggingLevels=23333. Specifies the level of logging for log records. The default 
is the minimum level of logging required for journaling. See “Configuring Server 
Logging Levels” on page 101 for more information about configuring the 
LoggingLevels parameter.

Location and Name of Journal Log Files
The journal log file resides in the Siebel application directory on the server. The 
name of the file is derived from the AppDir parameter in the handheld .cfg file.

For example, if the AppDir parameter is set as follows:

AppDir=hhsync\phce
Version 7.5.3 Siebel ePharma Handheld Guide for Windows-Powered Devices 127



Synchronization Conflict Handling and Recovery

Companion Sync Journal Files
then the location of the file is: Client Root\log

and the name of the file is: hhsync.phce.journal.log.

Companion Sync Journal Files
Any journal log files that are generated during Companion Synchronization are 
saved in the Siebel application directory on the Mobile Web Client. To facilitate the 
administration of Companion Sync deployments, a mechanism is embedded in 
Siebel Handheld that uses MAPI integration to transfer the journal log files to the 
Siebel Administrator. When this functionality is enabled, if a journal log file is 
generated, it is automatically attached to an email and sent to an email alias. The 
administrator can then use an Outlook macro to concatenate these attachments into 
a single XML file that can then be viewed in the Journal Viewer.

NOTE: This functionality is only available to clients using Microsoft Outlook.

Automatic Forwarding of Journal Log Files
In order for the journal log files to be forwarded to the Siebel Administrator, the 
following parameters need to be set in the handheld .cfg file.

AdminEmail=
JournalGenerations=60

■ AdminEmail—Email alias of the Siebel Administrator. The default is null. If this 
parameter is null, the email with the journal log file is not sent.

■ JournalGenerations—Number of journal log files that are archived on the Mobile 
Web Client. The default value is 60. When the 61st journal log file is archived, 
the oldest file is deleted.

If a network connection is not available when the email is generated, the email 
resides in the end user’s Outbox until a connection with the server is established. 
The forwarding of the log files requires no action on the part of the end user.
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Concatenating Journal Log Files
Siebel Administrators will generally receive numerous emails from end users with 
journal log files attached. To facilitate viewing the journal log files, you can use an 
email macro to concatenate the various files into a single file. Contact Siebel 
Technical Support to obtain this macro.

When it is executed, the macro:

■ Locates all email in the System Administrator’s Inbox whose subject line begins 
with “Sync Journal for.”

■ Concatenates the text from the files that are attached to the emails into a single 
text file. The name of this file, by default, is centraljournal.log.

■ Saves the file to the default location, D:\journalfiles.

■ Deletes the emails after the attached files are processed.

Before you can use the macro, you must add the macro to Microsoft Outlook and 
create the directory where the concatenated journal log file is saved.

Macro Constants
You may modify the following constants and tailor them to your environment. The 
constants and their default values are:

■ Const JOURNALROOTDIR="d:\JournalFiles\"—Specifies the location of the 
concatenated journal log file.

■ Const JOURNALFILE="CentralJournal.log"—Specifies the name of the 
concatenated journal log file.

Viewing Transaction Errors
The Journal Viewer is used to view the journal log files and allows Siebel 
Administrators to recover data. Contact Siebel Technical Support to obtain the 
software for the Journal Viewer. Once you have received the software, run the 
Journal Viewer installer to install the viewer on your machine.
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To open a file

1 From the Windows Start menu, choose Programs > Journal Viewer to start the 
application.

2 Choose File > Open and open the journal log file you wish to view.

Using the Journal Viewer
When you open a journal log file in the Journal Viewer, you will see a list of log 
records. When you double-click on a record in the Journal Viewer, the Error Details 
window displays the following information for the record:

■ Business component

■ Previous field values and new field values

■ Error message describing the sync conflict
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This chapter provides instructions for the end user for installing the Siebel 
Handheld application on their device. Installation instructions are provided for each 
of the different synchronization methods and for installing the application on a 
Compact Flash card. System administrators may also find the information in this 
chapter useful for maintaining their end users’ systems.

Installing on the Handheld
There are two ways to install software onto any Windows-powered handheld 
device. The first is to create a partnership between a desktop or laptop PC and the 
handheld device using Microsoft ActiveSync. The second is to install the application 
from type of external media. See “Reinstalling or Upgrading the Handheld 
Application” on page 135 for more information.

It is important to remember that end users must synchronize their handhelds to 
download the application configuration and populate the database before they can 
use the application. Therefore, an administrator may install the application for an 
end user, but the synchronization must occur using the end user’s name and 
password.
Version 7.5.3 Siebel ePharma Handheld Guide for Windows-Powered Devices 131



Installing the Handheld Application

Installing on the Handheld
Installing for Companion Sync Users
Before you install and use Companion Sync (CS) with the Siebel Handheld 
application, you must first install the Siebel Mobile client on your PC. The Mobile 
Client Installer copies the Companion Sync files to your personal computer. Then 
install the Siebel application on your handheld device.

NOTE: Users can only use Companion Sync to synchronize their Siebel Handheld 
application to a personal computer that already has the Siebel Mobile client 
installed. 

To install the Siebel Handheld application and Siebel Handheld Sync using CS

1 Using Microsoft ActiveSync, establish a partnership between the handheld 
device and the personal computer.

2 On the PC, network, or CD-ROM, locate the folder where the Siebel Handheld 
Application folder is installed. In this folder, double-click setup.exe.

3 Choose the language you want to use for the installation and click OK.

The Welcome Screen appears. 

4 Click Next.

The Synchronization Options screen appears. 

5 Choose the Companion Sync option and click Next.

6 Select the desired language of the Siebel Handheld application and click Next.

A window appears showing the setup status, followed by several DOS windows, 
and the Add/Remove Programs dialog box.
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7 At the Installing Applications dialog box, click Yes to install in the default 
directory.

NOTE: The default directory in the Applications dialog is the directory specified 
by the system administrator in a setup file. So that the application works 
correctly, the Siebel Installer installs the application in the default directory. 
Therefore, even if you specify a different location for the application, the 
application will be installed in the default location.

The Siebel Handheld installation automatically installs SSCE Service Pack 1 and 
overwrites existing files on your system. A message may appear asking if you 
want to replace existing files. Respond by tapping “Yes to All.”

The Siebel Handheld application is installed on the handheld device. During the 
installation, the Installing Applications dialog box displays a progress bar.

It may take several minutes to install on the handheld device. When the 
application has been downloaded to the handheld device, the Application 
Downloading Complete dialog box appears on the PC. 

8 Click OK.

A message appears informing you that setup has finished installing the Siebel 
Handheld application on your computer.

9 Click Finish.

The Siebel Handheld icon appears in the Start > Programs screen on the 
handheld device.

After installing the handheld application and Siebel Handheld Sync, you must 
perform an initial synchronization before you can use the application. If you are 
installing the application for the first time on the device, synchronize the Siebel 
Remote database with Siebel Server, then synchronize the Siebel Handheld and 
Siebel Remote databases. See “Synchronizing Data” on page 157 for the procedure 
for synchronizing your data.

See Chapter 4, “Data Filtering,” for more information on using Companion Sync 
and setting filters.
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Installing for Direct Server Sync Users
Most DSS users do not have access to a PC for creating a partnership with their 
handheld device. In this case, the administrator has to create partnerships with each 
user's device and install the application. Siebel Handheld applications can be 
installed in DSS mode using the Siebel Installer as described in this section.

To install the Siebel Handheld application using DSS

1 Using Microsoft ActiveSync, establish a partnership between the handheld 
device and the PC.

2 On the PC network or CD-ROM, locate the folder where the Siebel Handheld 
Application folder is installed. In this folder, double-click setup.exe.

3 From the Choose Setup Language window, choose the language you want to use 
for the installation and click OK.

4 From the Welcome screen, click Next.

5 At the Synchronization Options screen, choose the Direct Server Sync option and 
then click Next.

The next screen displays and asks, “Would you like to deploy a CAB file to 
enable rapid installation for additional devices?”

NOTE: If you want to create a stand-alone installer, choose Yes, and then click 
Next. See “Reinstalling or Upgrading the Handheld Application” on page 135 for 
details.

6 To install the application on the device, click Next.

7 Select the desired language of the Siebel Handheld Application, and click Next.

A window appears showing the setup status, followed by several DOS windows.
134 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Installing the Handheld Application

Reinstalling or Upgrading the Handheld Application
8 The Add/Remove Programs dialog appears. This is followed by the Installing 
Applications dialog that asks if you want to install in the default directory. Click 
Yes to install the Siebel Handheld application on the handheld device.

NOTE: The default directory in the Applications dialog is the directory specified 
by the system administrator in a setup file. So that the application works 
correctly, the Siebel Installer installs the application in the default directory. 
Therefore, even if you specify a different location for the application, the 
application will be installed in the default location.

The Siebel Handheld installation automatically installs SSCE Service Pack 1 and 
overwrites existing files on your system. A message may appear asking if you 
want to replace existing files. Respond by tapping “Yes to All.”

During the installation, the Installing Applications dialog box displays a progress 
bar. It may take several minutes to install on the handheld device. When the 
application has been downloaded to the handheld device, the Application 
Downloading Complete dialog box displays on the PC.

9 Click OK.

A window appears informing you that setup has finished installing the Siebel 
Handheld application on your computer.

10 Click Finish.

The Siebel Handheld and Siebel Handheld Sync icons appear in the Startup screen 
on the handheld device.

After installing the handheld application and Siebel Handheld Sync, you must 
perform an initial synchronization before the application can be used. Refer to 
“Synchronizing Data” on page 157 for the procedure for synchronizing your data.

See Chapter 4, “Data Filtering,” for more information on using Direct Server Sync 
and setting filters.

Reinstalling or Upgrading the Handheld Application
Follow the steps below to reinstall or upgrade your handheld application.
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To reinstall or upgrade the handheld application

1 Before you reinstall the current application or upgrade to another version of the 
handheld application, you must first uninstall the current application on your 
device. See “Uninstalling the Handheld Application” on page 136 for more 
information.

2 Once you have uninstalled the application, you may then reinstall the 
application or install the newer version. See “Installing on the Handheld” on 
page 131, and follow the instructions for installing the handheld application.

3 Synchronize your handheld application. See “Synchronizing Data” on page 157 
and follow the instructions for synchronizing your data.

NOTE: If you are using Companion Sync to synchronize your data, synchronize the 
Siebel Handheld database with the Siebel Remote database.

Uninstalling the Handheld Application
Uninstalling the application deletes the database files as well as the application files.

CAUTION: Before you uninstall your application, you must synchronize your database 
to save any changes to your data since the last synchronization. If you do not 
synchronize before uninstalling, these changes will be lost.

See “Synchronizing Data” on page 157 and follow the instructions for 
synchronizing your data.

Handheld
PC

To uninstall the handheld application

1 Select Start > Settings > Control Panel.

2 Double tap Remove Programs.

3 From Remove Program Properties dialog, select the Siebel handheld application 
from the list of Programs and tap Remove.
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Pocket PC To uninstall the handheld application

1 Select Start > Settings.

2 Select the System tab and tap Remove Programs.

3 From Remove Programs, select the Siebel handheld application and tap Remove.

NOTE: A dialog box will appear that says that a file cannot be deleted. This occurs 
because a file may still reside in memory. Ignore this message and tap OK to delete 
all application and database files. No additional steps are required to remove the 
application and database files.
Version 7.5.3 Siebel ePharma Handheld Guide for Windows-Powered Devices 137



Installing the Handheld Application

Uninstalling the Handheld Application
138 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Working with Siebel Handheld Applications 8
This chapter provides an overview of the Siebel Handheld application’s interface. 
Once you understand the basics of the interface, you will find it easier to complete 
your tasks. This chapter discusses:

■ Navigating the interface

■ Working with data

■ Using the calendar

■ Setting user preferences

In addition, this chapter also provides procedures for performing the following end-
user tasks:

■ Backing up and restoring data

■ Synchronizing data

Components of the Handheld Interface
The components of the handheld interface include the Screens menu, Show drop-
down list, application-level menu, Queries drop-down list, toolbar, and status bar.
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Components of the Handheld Interface
Figure 10 shows components of the Handheld PC application including the Screens 
menu, Show drop-down list, Queries drop-down list, application toolbar, 
application menu, and the status bar.

Figure 10. Handheld PC Application Window Components

Application-level menu Queries drop-
down list

Screens menu Show drop-down list

ToolbarStatus bar
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Figure 11 shows the components of the Pocket PC application.

Figure 11. Pocket PC Application Window Components
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Screens Menu
The screens menu is the first level of navigation in the Siebel Handheld application. 
When you launch the Siebel Handheld application for the first time, this tab is 
labeled Screens unless you have configured a start up view to appear. When you tap 
the screens menu, a drop-down list of all available screens appears. Tap the desired 
screen in the list to navigate to it. Figure 10 shows that the Activities screen has 
been selected.

For information about configuring a start up view, see “Setting User Preferences” 
on page 155. 

Show Drop-Down List
The Show drop-down list is the second level of navigation in the Siebel Handheld 
application. This is where you choose views for the selected screen.

Application-Level Menu
The application–level menu consists of the File, Edit, View, and Help menus. Tap a 
menu to select a menu option. The options that are available in each menu vary 
depending on the task you are performing.

Queries Drop-Down List
Up to two predefined queries (PDQs) are displayed in the Queries drop-down list. 
The list displays the query chosen when you synchronized (or the default filter if 
you did not change the Set Filters selection) and the All Records query, if it is 
defined. For more information, see “Predefined Query Filters” on page 80.
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Siebel Toolbar
The Siebel toolbar has buttons for frequently used functionality like record 
navigation and querying.

NOTE: There may be a slight variation in your version of Siebel software, and the 
toolbar may not look exactly as shown here. You can configure your toolbar and 
specify which buttons are displayed. See “Configuring User Interface Elements” on 
page 36 for more information on configuring your toolbar buttons.

Figure 12 is an example of the Handheld PC toolbar.

Figure 12. Handheld PC Toolbar Example

Back button

Execute Query buttonNew Record button

New Query button

Forward button

Record Navigation buttons
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Figure 13 is an example of the Pocket PC toolbar.

■ Tap the New Record button to add a new record to the active list or form.

■ Tap the Back button to navigate to the previous view.

■ Tap the Forward button to navigate to the view you were in before you selected 
the Back button.

■ Tap the Record Navigation buttons to move through records in a form or a list.

■ Tap the New Query button to begin a new query in a form or a list.

■ Tap the Execute Query button to run the query you just created.

■ Tap the Maximize Minimize Applet button to expand the active applet so that it 
is the only applet displayed and takes up the entire screen display. This allows 
you to see more columns or more rows of data at one time. Tap again and the 
screen displays two applets.

NOTE: On the Handheld PC operating system, the Maximize Minimize Applet 
button works only on list applets. On the Pocket PC operating system, it works 
on both form and list applets. 

Figure 13. Pocket PC Toolbar Example

New Query button

Execute Query button

Record Navigation buttons

New Record button

Back button

Maximize Minimize 
Applet button
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Customizing the Toolbar
You can customize which buttons appear on your toolbar by selecting View > 
Customize Toolbar from the application menu.

Pocket PC To add and remove buttons from the toolbar, drag and drop the desired buttons 
between the Choose Toolbar Buttons dialog box and the toolbar.

Handheld
PC

From the Choose Toolbar dialog box, select the check boxes for the buttons you 
want to appear on the toolbar.

Minimize Button
The minimize button appears in the upper right corner of your window.

NOTE: Do not confuse the Minimize button that appears in the upper right corner 
with the Maximize Minimize Applet button that appears on the Toolbar.

Pocket PC When you tap the Minimize button, the application minimizes, but does not close. 
To reopen the application, from the Start menu, tap the Siebel Handheld icon. 
Minimizing the application merely hides it; it does not close the application. 

NOTE: Be sure to close the application before you synchronize.

Handheld
PC

The Minimize button appears in the upper right corner of your screen. When you 
tap the button, the application closes.

Status Bar
The status bar appears at the bottom of the application window. It provides 
information about the current view. See Figure 10 on page 140 for an image of the 
status bar.
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Navigating the Handheld Interface
Navigating the Siebel Handheld application is achieved through the screens menu, 
the Show drop-down list, drilling down, drilling across, toolbar buttons, and 
toggling.

Screens Menu
The screens menu provides the first level of navigation. Here you select the screen 
you want to work in. For more information about the screens menu, see 
“Components of the Handheld Interface” on page 139.

Show Drop-Down List
The Show drop-down list is the second level of navigation. After you have selected 
a screen from the screens menu, select a view from the Show drop-down list. Views 
in the Show drop-down list are specific to each screen.

For example, in the Activities screen you can pick the My Activities view from the 
Show drop-down list.

More Info View
To view all of the information available for a record, make sure it is selected, and 
choose More Info from the Show drop-down list.

NOTE: Not all screens have a More Info view.

Toggling Between Applets
A maximum of two applets can be displayed at one time in a Siebel Handheld 
application. In situations where there are more than two applets configured and a 
Toggle button has been configured, you may tap the Toggle button on the applet. Or 
you may select View > Toggle from the menu to toggle between applets.
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Expandable Fields
Due to the limited screen size on the handheld, it is not always easy to view the 
data in a field without scrolling or resizing the field width. Therefore, some fields 
that could contain large amounts of text are expandable—that is, the data can be 
viewed in a text box. An ellipsis (...) appears in the field to indicate that the field is 
expandable. When you tap the ellipsis, a text box opens showing the data in that 
field. When you step off the field, the text box closes.

In form applets, an ellipsis is always visible in those fields that are expandable. 
However, in list applets, due to space constraints, the ellipsis is not always visible 
in expandable fields. When you tap on an expandable field in a list applet, the 
ellipsis appears. Once the ellipsis appears, you tap the ellipsis to open the text box.

Navigating a List of Records
Within the view you select from the Show drop-down list, you can view detailed 
information on a record. When records are displayed in a list, you can drill down 
or drill across the record to get additional details.

Drilling down occurs when you tap a hyperlink in a record and are taken to another 
view within the current screen. For example, if you are in the Accounts screen, and 
tap the Account Name hyperlink, you navigate to the details for that account. You 
do not leave the Accounts screen; you just move deeper into it.

NOTE: Hyperlinks are indicated by blue underlined text as long as they are set up this 
way in User Preferences. For more information see “Setting User Preferences” on 
page 155.

Drilling across a record occurs when you tap a hyperlink in a record and are taken 
to another view in a different screen. For example, tapping a hyperlink in the 
Accounts column of a contact record in the Contacts screen takes you to the record 
for that account in the Accounts screen.
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Dynamic drilldown occurs when you tap a hyperlink in a record and are taken to 
another screen or just another view. Where you navigate to depends on the content 
in the drilldown field. For example, tapping a hyperlink in the Activity field in the 
Activities screen can take you to different places. If you tap an Account Call activity, 
you navigate to the Account Call screen. If you tap a Visit activity, you navigate to 
the Activities More Info view. 

History Arrows
To navigate back to views you have recently displayed, tap the Back button. After 
you have used the Back button, you can use the Forward button to navigate back 
to your original screen and view.

NOTE: The History arrows only allow you navigate between views. They will not 
recover data that may have been entered or deleted in another view.

Record Navigation Buttons
Use the Record Navigation buttons to move back and forth though a set of records. 
The navigation buttons are described in Table 26.

Table 26. Record Navigation Buttons

Button Description

Navigates back to the first record in the list or form.

Navigates back to the previous record in the list or form.

Navigates forward to the next record in the list or form.

Navigates forward to the last record in the list or form.
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Entering Data

Pocket PC There are several different methods for entering data on the Pocket PC operating 
system. Tap the up arrow next to the Input Panel button to select a method. See the 
user guide for your device for information on using the different input methods.

Working with Columns
Data is displayed in lists and forms in your Siebel Handheld application. You can 
organize and work within it in a number of ways to better suit your needs.

There are several ways in which to organize columns in a list. You can:

■ Sort data by up to three columns

■ Resize columns

■ Change the order in which the columns appear

■ Show and hide columns

■ Lock columns for horizontal scrolling

You can sort records in a list by tapping in the column header of the column in 
which you want to sort the records. If the green column sort indicator points up, 
the column is sorted in ascending order. If it points down, the column is sorted in 
descending order.

If you need to sort by more than one column, you can open the Sort Order dialog 
box to sort up to three columns at one time. Open the Sort Order dialog box by 
choosing View > Advanced Sort from the application-level menu.

Resize columns by tapping and dragging the divider between the column headings 
until the column is the desired size.

You can change the order of columns using the Columns Displayed dialog box. 
Open the Columns Displayed dialog box by choosing View > Columns Displayed. 
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Show and hide columns using the Columns Displayed dialog box. In the Available 
columns list, select the items you want to show and tap the arrow to move the 
selected items to the Selected columns list. To hide columns, select the items and 
tap the arrow to move the selected items to the Available columns list.

Lock or unlock columns by tapping and holding the column header.

Finding and Querying Data
You can search for data using the Find or Query functionality in your Siebel 
Handheld application.

Find
Use Find to do a simple search for a record. You can access Find by choosing Edit 
> Find from the application-level menu. This launches the Find dialog box, in 
which you can enter your search criteria. The asterisk wildcard function (*) can be 
used in the search criteria. Figure 14 shows an example of the Find dialog window 
with the following fields: Look In, Last Name, Type, Last Call Date, Primary 
Specialty, and Rep Specialty.

NOTE: There may be a slight variation in your version of Siebel software, and the 
Find dialog box may not look exactly as shown here. 

Figure 14. Find Dialog Box
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Query
Use Query to locate a number of records containing a specific set of criteria. There 
are a number of ways in which to perform query tasks in your Siebel Handheld 
application.

Creating a Query
To begin a query, you can choose Edit > Query > New from the application-level 
menu, or you can tap the New Query button on the toolbar. Both will provide you 
with a blank form or list where you can enter your query criteria, depending on 
where you are in the application when you invoke the command. The asterisk wild 
card function (*) can be used in the search criteria.

Executing a Query
After you have created the query, you can execute it by choosing Edit > Query > 
Run from the application-level menu or by tapping the Execute Query button in the 
toolbar.

Refining a Query
You can refine your current query by choosing Edit > Query > Refine from the 
application-level menu.

Printing
You may print from any view in the handheld application that has been configured 
to support printing. When you print from the handheld, a document that has been 
configured for the view is printed. You can print directly to a printer, or, if you are 
not connected to a printer at the time, you can queue your print jobs and wait until 
you have access to a printer to print your documents.

NOTE: When you print from a view, you are not necessarily printing what is visible 
on the screen at the time. Every field on the screen may not be relevant for the 
document. The document may contain only a portion of what is in the view, and it 
may also contain data that is not viewable at the time. A separate applet, which 
often cannot be viewed in the user interface, is configured specifically for printing.
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The print templates used to generate the printed documents are downloaded to the 
handheld during the synchronization process. After you have synchronized your 
handheld with the server or a desktop computer, you are ready to print.

For a list of supported printers, see the system requirements and supported 
platforms documentation for your application.

Printing From the Handheld Device
Your handheld device is configured for a particular printer by the Siebel 
administrator. You may print directly to this printer, or, if your handheld is not 
connected to a printer, the print job is sent to a print queue. Print jobs may be 
queued until you have access to a printer, at which time you may print all of the 
jobs in the queue. 

Print from the Siebel Handheld application by choosing File > Print. If you are 
connected to a printer, the print job will run. If you are not connected to a printer, 
the print job is sent to a print queue. View the print queue by choosing File > Print 
Queue.

Exporting Data
You may export data from any view in your application in HTML format or as tab 
delimited text and save it to a file. This file can be viewed in applications such as 
Microsoft Pocket Word, Microsoft Pocket Excel, and Internet Explorer.

To export data, select File > Export... to open the Export dialog box.

In the Export dialog box, you may specify the following:

■ Format. Specify either HTML or Tab delimited text file. (On the Handheld PC 
platform, this field is labeled Output format.)

■ Export. Select Only active applet to export only the data in the active applet. 
Select All applets in view to export the data in all visible views. (On the 
Handheld PC platform, this field is labeled Applets to export.)

■ Output file name. By default, the file is saved in the temp directory with the 
filename “output.” You may tap Browse to specify a different location or 
filename.
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■ And paste output to clipboard. Select the checkbox to save the data to the 
clipboard.

■ And open file. This option is only available on the Pocket PC platform. Select the 
checkbox to automatically open the file. When you tap OK in the Export dialog 
box, the data is exported to the specified file, and the file is automatically 
opened.

■ And run. This option is only available on the Handheld PC platform. Tap Browse 
and navigate to an application on the device. When you tap OK, the application 
exports the data and opens the file with the application you specified.

NOTE: You must specify a valid output format for the application. See Table 27 for 
the correct formats to specify for the supported applications.

Table 27 describes how to set the parameters to export data to specific applications.

Calendar and Calendar Views
To view your calendar, choose Calendar from the screens menu.

You can view your calendar in a monthly, a weekly, or a daily format. To navigate 
within the calendar, select the calendar view you want to see from the Show drop-
down list.

Table 27. Exporting Data

To export data to Do the following

Microsoft Word Set Format (or Output Format on the Handheld PC 
platform) to “Tab delimited text file.”

Microsoft Excel Select the “And paste output to clipboard” check box. 
The Output format may be set either to HTML or “Tab 
delimited text file.” Paste the data from the clipboard 
into an Excel spreadsheet.

Internet Explorer Set Format (or Output Format on the Handheld PC 
platform) to HTML. 
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Calendar Icons
Calendar icons appear in the monthly calendar to make it easier to see and 
understand your schedule at a glance. These calendar icons are explained in 
Table 28.

Customizing the Calendar
You can customize aspects of your calendar from the User Preferences view. For 
more information, see “Setting User Preferences” on page 155.

NOTE: Siebel Handheld Calendar does not support modification of single instances 
of recurring activities. For example, if you delete or modify an appointment 
scheduled to recur daily for 10 days, the entire series will be deleted.

Table 28. Calendar Icons

Icon Description

Current day without an appointment

Day with appointment before and after 12 pm

Day with appointment before 12 pm

Day with appointment after 12 pm
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Setting User Preferences
You can customize aspects of your Siebel Handheld application from the User 
Preferences dialog box. Access the User Preferences dialog box by choosing View > 
User Preferences from the application-level menu.

In the User Preferences dialog box you can:

■ Set a default startup screen.

■ Set number of maximum history threads to be saved.

■ Set the maximum percentage of the display area that the parent applet can take 
up (Pocket PC operating system only).

■ Change font size.

■ Customize list spacing, column width settings, and grid lines.

■ Customize your calendar’s default view, start time, time slot interval, and 
default appointment duration.

■ Specify screen aesthetics such as alternating colors for rows and showing 
drilldown sources as hyperlinks.

Backing Up and Restoring Data
It is recommended that you back up your data to an external device—for example, 
a CompactFlash card or a Secure ID card. If the handheld device is damaged, the 
backup may not be retrievable. If you store your backups in RAM, depending on the 
size of your application and data extract, you may decrease the amount of memory 
available for the application, and your application performance may suffer.
Version 7.5.3 Siebel ePharma Handheld Guide for Windows-Powered Devices 155



Working with Siebel Handheld Applications

Backing Up and Restoring Data
Automatic Backup After Synchronization
The automatic backup feature must be enabled in the application by your System 
Administrator. If the backup feature is enabled, a backup is automatically created 
at the end of every synchronization. This way, you have an up-to-date snapshot of 
the database. You must never synchronize your data to the handheld device and 
then restore the database using an older copy of the database. If you do, the next 
time you synchronize, the application will try to rewrite changed transactions. This 
can cause data integrity problems. Therefore, when the database backup feature is 
enabled, a database backup occurs automatically at the end of each 
synchronization. Keep in mind that this will make the overall time to synchronize 
somewhat longer. The size of the database and the speed of the CompactFlash card 
also affect the time it takes to complete synchronization.

Backing Up Data
The following procedure describes how to back up the database on the handheld 
device.

To back up the database

1 From the application-level menu, choose File >Backup.

NOTE: If the Backup menu item is disabled, contact your system administrator to 
have backup enabled in your application.

A dialog box appears, telling you that backing up the data will restart the 
application and prompts you to confirm that you want to continue.

2 Tap Yes to start the backup.

A status dialog box appears indicating that the backup is in progress and may 
take a few minutes. The Handheld configuration files and data are copied to the 
backup location specified in the setup.ini file. Typically, the backup location is a 
CF or SD card. In some cases, the location is a directory in memory.

A dialog box appears telling you if the backup succeeded and asks if you want 
to return to the application.
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3 Tap Yes to return to the application.

NOTE: If the backup fails, consult your system administrator.

Restoring Data from a Backup
In order to restore the application to its previous state, the user should contact the 
system administrator. Any work performed on the handheld device since the last 
backup will be lost.

To restore the database

1 Remove the external flash card from the damaged device and place it in a new 
handheld device where the application has been installed.

2 Navigate to the \Program Files\Siebel Handheld folder.

3 Start the restore by tapping the BackupUtility file twice.

A dialog box appears, asking you to confirm that you want to restore the device 
from a previous backup.

4 Tap Yes.

A status dialog box appears, indicating that the restore is in progress. The 
backup utility restores the files to the state when the backup was performed. A 
dialog box appears telling you if the restore was successful. If successful, it asks 
you to confirm that you want to restart the Siebel Handheld application.

5 Tap Yes to start using the application.

Synchronizing Data
You must synchronize the data on your handheld device:

■ After you install or upgrade the handheld application

■ Before uninstalling the handheld application
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■ On a regular basis to keep your data synchronized with Siebel Server and Siebel 
Mobile Web Client

The sections that follow describe how to synchronize using Companion Sync (CS), 
Direct Server Sync (DSS) and Direct Server Sync via Proxy (DSSvP), and provide 
some troubleshooting tips.

Using Siebel Handheld Synchronization
Siebel Handheld Synchronization differs depending on whether users synchronize 
through Companion Sync or Direct Server Sync. The following procedures show 
how to launch and use Handheld Synchronization for each method.

NOTE: A given user can only synchronize using one method. For example, it is not 
possible to install a handheld application that a particular user will synchronize 
both to the Siebel Mobile Web Client database through Companion Sync and also 
to the Siebel Server database directly through Direct Server Sync.

Using Companion Synchronization
End users that synchronize their data using Companion Sync must follow a 
three-step process to synchronize their handheld, remote, and server databases. 
Immediately before and after every Siebel Remote sync, you must perform a 
Companion Sync. This process can be time consuming for the end user and difficult 
for the administrator to enforce. 

Integrated Sync eliminates the need for you to initiate three separate sync sessions 
for each Siebel Remote sync. Integrated Sync is a one-button process that 
automatically initiates each of the following synchronization steps:

1 Handheld Upload and Processing—Handheld transactions are uploaded to the 
companion PC and processed.
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2 Siebel Remote Synchronization—The Siebel Mobile Client is synchronized with 
Siebel server. Transactions on the mobile client database are uploaded to Siebel 
server, and changes to Siebel server are downloaded to the mobile client 
database.

NOTE: If there is a handheld patch staged on the server, synchronization terminates 
and the patch is installed. After the patch installation is completed, the handheld 
user is prompted to synchronize again (using either Integrated Sync or Companion 
Sync) to complete the data extraction and download (that is, Step 3). It is critical 
that the handheld user synchronize a second time after the patch installation is 
completed. If he fails to do so, he will not be able to start the handheld application.

3 Handheld Data Extract and Download—Data is extracted from the mobile client 
database to the handheld device database.

You may use Companion Sync to synchronize your handheld with Siebel Mobile 
Client as many times as you wish between Integrated Sync sessions. However, it is 
recommended that you conduct Integrated Sync sessions frequently so that the 
Siebel Remote synchronization process does not take long periods of time to 
complete and update conflicts are minimized.

Synchronizing the Handheld for Companion Sync Users
When you synchronize, you have the option of either doing an Integrated Sync or 
Companion Sync. To do an Integrated Sync, select Perform Remote Sync when the 
Siebel Handheld Sync dialog box appears.

To perform Companion Sync

NOTE: You must close your handheld application before synchronizing your 
application.

1 From the companion PC, establish a Microsoft ActiveSync connection to the 
handheld device. 
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2 From the device, verify that the Siebel Handheld application is closed.

NOTE: On the Pocket PC 2002 operating system, the Minimize button (the button 
with the “X” in the top right corner of the application) minimizes but does not 
close the application. To close out the Handheld application in preparation for 
synchronization, you must use the File > Exit command.

3 From the companion PC, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

a Enter your user name and password.

b By default, Perform Remote Sync is selected. To perform an Integrated Sync, 
accept the default setting.

If you want to do Companion Sync only, then unselect the Perform Remote 
Sync box.

Selecting Bypass Set Filters skips the step of selecting the filters and 
immediately starts the synchronization process. If you select Bypass Set 
Filters, then the filters that you selected the last time you synchronized are 
used. If this is the first time you are synchronizing, then the default filters are 
used.

4 Tap Login.

5 Tap Set Filters.

The Filters dialog box appears.

6 From the Filter list box, select the screen for which you want to choose a filter.

7 From the Choose drop-down box, select the filter you want to associate with the 
screen you selected in Step 6.

NOTE: Tap Default Filters to restore the filter selection to the default setting.

8 Tap OK and tap Start to begin synchronization.
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a The Siebel Handheld Sync dialog box appears. If “Perform Remote Sync” was 
selected, this is followed by the Siebel Remote dialog box. When 
synchronization has successfully completed, the Finished dialog box 
appears.

b If a handheld patch needs to be installed, the synchronization process is 
interrupted and the patch is installed. After the patch is installed, you must 
restart Siebel Handheld Sync to complete the data extract process. If you fail 
to do this, you will not be able to start your application.

c The Finished dialog box appears indicating that the synchronization has 
successfully completed.

9 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Using Direct Server Synchronization
There are two methods for synchronizing between the handheld device and the 
Siebel application server:

■ Direct Server Sync (DSS) provides synchronization between the Siebel Handheld 
application and the Siebel application server.

■ Direct Server Sync via Proxy (DSSvP) provides synchronization between the 
Siebel Handheld application and the Siebel application server, using the desktop 
or companion PC to provide the network connection between the handheld 
device and the server.

NOTE: DSSvP is only supported on the Pocket PC 2002 platform.

To synchronize with the Siebel application server

NOTE: You must close your handheld application before you synchronize with the 
Siebel application server.
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1 If you are synchronizing using DSS, create a direct network connection through 
a modem or a direct LAN connection.

If you are synchronizing using DSSvP, establish an ActiveSync connection 
between the handheld device and the PC.

2 From the device, verify that the Siebel Handheld application is closed.

3 From the device, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

4 Enter your user name and password.

Selecting Bypass Set Filters skips the step of selecting the filters and immediately 
starts the synchronization process. If you select Bypass Set Filters, then the 
filters that you selected the last time you synchronized are used. If this is the first 
time you are synchronizing, then the default filters are used. 

5 Tap Login.

The Siebel Handheld Sync dialog box appears.

6 Tap Set Filters.

The Filters dialog box appears.

7 From the Filter list box, select the screen for which you want to choose a filter.

8 From the Choose drop-down box, select the filter you want to associate with the 
screen you selected in Step 6.

NOTE: Tap Default Filters to restore the filter selection to the default setting.
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9 Tap OK, and then tap Start to begin synchronization.

NOTE: If a handheld patch needs to be installed, the synchronization process is 
interrupted and the patch is installed. After the patch is installed, you must 
restart Siebel Handheld Sync to complete the data extract process. If you fail to 
do this, you will not be able to start your application.

The Finished dialog box appears indicating the synchronization has successfully 
completed.

10 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Troubleshooting
This section lists potential error messages that are associated with synchronization. 
In addition, this section explains how to fix transaction errors.

General Synchronization Errors
There are a number of different errors that can occur when synchronization does 
not complete successfully, for example:

■ Faulty wire connection

■ Server crash

■ Insufficient memory

■ Login error

When these errors occur, the user should exit Siebel Handheld Sync and launch the 
application again.

NOTE: When you restart Siebel Handheld Sync, you may see an error message that 
says that another instance of syncmanager.exe is running. You will be asked 
whether you want to terminate the first instance or not, and you should choose Yes.
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Transaction Conflicts
Transaction conflicts are minimized when customers adhere to the standard 
configuration practices outlined in this document. However, even when proper 
configuration practices are followed, conflicts can occur for a variety of reasons. For 
example, if a field value is updated on both the handheld client and the server 
between synchronization events, a transaction update conflict will occur. In this 
instance, the user will be presented with an error dialog after synchronization has 
completed.

A transaction consists of one or more smaller transactions called mini-transactions. 
For example, if you update several fields in a record, the update to the record counts 
as a single transaction, and each update to a field is a mini-transaction. The Siebel 
Handheld application behaves in the same way as the Siebel Web application in that 
if any part of the transaction fails, the entire transaction fails. Assume, for example, 
that you update four fields in a record. If, during synchronization, three fields 
update correctly and one field fails to be updated, none of the fields in the record is 
updated.

Improving Application Performance
If you find that the performance of the Siebel Handheld application is very slow or 
begins to degrade, the following can help to improve the application performance:

■ Verify that your device meets the minimum memory requirements. See Siebel 
System Requirements and Supported Platforms documentation for your Siebel 
application.

■ When you run the Siebel Handheld application, it is recommended that you do 
not run any other applications. By doing so, you maximize the amount of 
memory that is available to run the application.

■ Increase the amount of memory that is allocated for running applications.

■ Installing the binaries to a CompactFlash card. For more information, see 
“Setting up Installation on a CompactFlash Card” on page 113.

Handheld
PC

To increase application memory

1 From the Start menu, select Settings >Control Panel >System.
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2 In the System Properties dialog box, go to the Memory tab.

3 Move the slider bar so that more memory is allocated to Program Memory, then 
tap OK.

Pocket PC To increase application memory

1 From the Start menu, select Settings.

2 Select the System tab and tap Memory.

3 Move the slider bar so that more memory is allocated to Program Memory, then 
tap OK.
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Using ePharma Handheld 9
Siebel ePharma Handheld helps pharmaceutical companies increase sales 
representative productivity by providing a portable means to access and record key 
information. With Siebel ePharma Handheld, sales representatives can use waiting 
time between calls to record call notes, update customer profiles, schedule new 
calls, or prepare for their next call. Pharmaceutical companies can use Siebel 
ePharma Handheld in conjunction with Siebel Life Sciences Web client application 
or as a standalone product. 

This chapter explains how to use Siebel ePharma Handheld to complete tasks in a 
typical work sequence performed by a sales representative. Your company may 
follow a different sequence according to its business requirements.

Sales representatives can use the handheld to record contact and account calls, 
capture electronic signatures directly in the handheld device, manage samples, 
create expense reports, and plan MedEd events. Administrators, such as sales 
administrators and sales managers, can customize the software to fit business 
needs.

Managing Contacts
A contact is typically a physician, nurse, pharmacist or other medical professional. 
In a more general sense, a contact is any individual a pharmaceutical company 
deems significant to their business process, such as a formulary director, contracts 
administrator, or medical education event speaker.

Sales representatives use Siebel ePharma Handheld to add and update contact 
profile information which may include adding new contacts, creating new contact 
addresses, tracking affiliations between contacts and accounts, recording the best 
times to call on a contact, transcribing relevant notes, and viewing prescription 
data.
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This section describes how to manage contact information using all of the views 
accessible from the Contacts screen’s Show drop-down list, except for Calls and 
Activities. 

Contact Management Procedures
The following procedures are included in this section:

■ “Adding Contacts” on page 169

■ “Adding Contact Addresses” on page 170

■ “Adding and Editing License Information” on page 171

■ “Specifying the Best Time to Call on a Contact” on page 172

■ “Adding Private or Shared Notes About a Contact” on page 173

■ “Indicating Affiliations Between Contacts and Accounts” on page 173

■ “Viewing Prescription Data” on page 174

For information on the Calls and Activities views, see “Creating Contact Calls” on 
page 187 or “Creating General Activities” on page 202.
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Adding Contacts
Using the Contacts screen and the My Contacts view, you can add contacts and 
update contact information directly in Siebel ePharma Handheld. 

To add contacts

1 Navigate to the Contacts screen.

The My Contacts list appears.

2 On the toolbar, tap the New Record button.

3 Complete the Last Name, First Name, Main Phone, Type, and Title fields for the 
new record.

To add additional contact information

1 Navigate to the Contacts screen.

2 In the My Contacts list, select the contact record.

3 From the Show drop-down list, choose More Info.

4 Add or edit information in the available fields. 

The fields are described in the following table.

Field Comments

Address Read only. A contact can have more than one address. One address 
must be specified as primary. Addresses are entered using the 
Addresses view. For more information on adding addresses, see 
“Adding Contact Addresses” on page 170.

Last Call Date Read only. The date of the most recent call that has been 
submitted. 

OK to Sample Checking this box indicates that it is permissible to drop samples 
off with this contact.

Primary Specialty Read-only. Siebel administrators define this value.

Rep Specialty The specialty or area of expertise associated with this contact 
within the contact’s organization.
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Contact addresses are entered in the Addresses view. Since a contact can have 
multiple addresses, and multiple contacts may share an address, take care when 
editing an address as the changes may affect more than one contact.

When entering addresses, specify one address as the primary. Each sales 
representative can specify a different primary address for an assigned contact. For 
example, one representative might specify a private office as the primary address, 
while another representative might designate a hospital department as the primary 
address.

The More Info form only displays the primary address, not all the addresses 
associated with the contact.

To add contact addresses

1 Navigate to the Contacts screen.

2 In the My Contacts list, select a record.

3 From the Show drop-down list, select Addresses.

The Addresses view appears.

4 Tap the list of addresses to select it.

5 On the toolbar, tap the New Record button.

6 In the Addresses list, do one of the following:

■ Tap New to add a record, and then complete the necessary fields.

■ Tap an existing address in the list, and then tap OK.

Route Allows users to select when to visit an account from a predefined 
route schedule.

Title Must be filled in before a contact can sign for receipt of samples.

Type Indicates the type of contact. 

Field Comments
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7 In the Address list, tap the check box in the record’s Primary field to designate 
the record as the contact’s primary address.

A check mark appears in the box to designate the primary address.

Adding and Editing License Information
Using the License Numbers view, you can add the contact’s professional license 
number, such as a state medical license number or a physician investigator’s AMA 
number. 

Before a physician can sign for samples dropped, you must enter the physician’s 
license numbers and additional license information. The contact must have a valid 
license number for the state corresponding to the address where samples are 
disbursed.

To add and edit license information

1 Navigate to the Contacts screen.

2 In the My Contacts list, select the contact.

3 From the Show drop-down list, select License Numbers.

The License Numbers view appears.

4 Tap the License Numbers list to select it, and then do one of the following:

■ On the toolbar, tap the New Record button, and then complete the fields for 
State, Licence number, License Expiration Date, and license Status.

■ Tap a License Number record to select it, and then edit the information in the 
fields.
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Specifying the Best Time to Call on a Contact
Using the Best Time to Call view, you can enter the best times to call on a contact 
based on a selected address. You can then query for contacts available during a 
specific time period.

To specify the best times to call on contacts

1 Navigate to the Contacts screen.

2 In the My Contacts list, select the contact.

3 From the Show drop-down list, select Best Times to Call.

4 Tap the Best Times to Call list to select it.

5 On the toolbar, tap the New Record button.

A new row appears in the Best Times to Call list.

6 Complete the fields for the record, as described in the following table.

 

Field Comments

Address Indicates which contact address pertains to this best time to call 
information. Select the address from the Pick Location dialog 
box, and tap OK. The Pick Location dialog box displays all 
addresses associated with that contact.

Start Day Indicates the day that the contact is available for a call at that 
address.

Start Time Indicates the start time for the selected day that the contact is 
available for a call.

End Time Indicates the end time for contact availability.

Comments Text field for information about time period constraints and other 
relevant notes.
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Adding Private or Shared Notes About a Contact
Using the Private Notes and Shared Notes views you can create and update notes 
on contacts. Private notes are visible only to the creator of the note; shared notes 
are available to other sales representatives calling on the contact.

To add notes about contacts

1 Navigate to the Contacts screen.

2 In the My Contacts list, select the contact.

3 From the Show drop-down list, select one of the following:

■ Private Notes. Limits access to the note to the person creating it.

■ Shared Notes. Allows all account team members to access the note.

4 Tap the Private Notes or Shared Notes list to select it.

5 On the toolbar, tap the New Record button.

A new row appears in the list.

6 Complete the necessary fields for the record.

Tap in the Note field, and then tap the ellipsis (...) to view the entire note while 
you are entering text.

Indicating Affiliations Between Contacts and Accounts
Using the Affiliations view, you can associate a contact with an account. One reason 
to establish these affiliations is for call reporting purposes. Affiliations between 
accounts and contacts also can be established using the Accounts screen.

To specify affiliations between contacts and accounts

1 Navigate to the Contacts screen.

2 In the My Contacts list, select the contact.

3 From the Show drop-down list, select Affiliations.

The Account Affiliations view appears.
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4 Tap the Account Affiliations list to select it, and then tap the New Record button.

5 Complete the necessary fields for the new record.

Some of the fields are automatically populated based on the chosen Account. 
Other fields are described in the following table.

Viewing Prescription Data
Using the Rx Data view, you can view prescription data to better target medical 
professionals. Data about physicians and prescribed drugs helps pharmaceutical 
companies define their market for better strategic business planning and national 
account management. Prescription data can be analyzed to measure market 
potential, target customers, align sales territories, and track market shifts.

To view prescription data

1 Navigate to the Contacts screen.

2 In the My Contacts list, select a contact.

3 From the Show drop-down list, select Rx Data.

The Rx data associated with the contact appears in the RX Data list.

Field Comments

Account The account to be affiliated with the selected contact. Select a 
predefined account from the Pick Account list, and then tap OK.

Comments Text field for user comments.

Direct If a check mark appears in this field, profile data for the contact is 
routed to members of the team assigned to the affiliated account.

If no check mark appears in this field, the profile data is routed only to 
the members of the team assigned to the contact. Tap the check box to 
specify a direct affiliation between a contact and an account.

Primary If a check mark appears in this field, the account is the primary 
affiliation for the contact. Tap the check box to display a check mark.

Start Date The beginning date on which the contact became affiliated with this 
account.
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4 In the list, review the prescription data on a market-by-market basis.

Managing Accounts
An account is any health care business that generates sales for your company or that 
could potentially generate business. Typical examples of accounts include hospitals, 
clinics, HMOs, wholesalers, group purchasing organizations (GPOs), and 
pharmacies. An account can also be any organization with which multiple contacts 
are associated, such as a group practice or an assisted-living facility. 

Sales representatives in the field use Siebel ePharma Handheld to add and update 
account profile information. Representatives use Siebel ePharma Handheld to add 
new accounts, create new account addresses, record the best times to call on an 
account, and record relevant notes. Sales representatives can also view sales data 
on Siebel ePharma Handheld to help them evaluate the business potential of 
accounts.

This section describes how to manage account information using all of the Accounts 
views accessible from the Show drop-down list, except the Calls and Activities 
views. For information on those views, see “Creating Account Calls” on page 197 or 
“Creating General Activities” on page 202. 

Account Management Procedures
The following procedures are included in this section:

■ Adding Accounts on page 176

■ Adding Account Addresses on page 177

■ Specifying Best Times to Call Accounts on page 178

■ Adding Notes About Accounts on page 178

■ Indicating Affiliations Between Accounts and Professionals on page 179

■ Viewing Sales Data on page 180
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Adding Accounts
Accounts are businesses and organizations that either currently generate sales for 
your company or have the potential to do so. You can add or edit accounts using 
the My Accounts view.

NOTE: Only a Siebel administrator can delete an account. 

To add an account

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 On the toolbar, tap the New Record button.

3 Complete the necessary fields for the new record.

4 To enter information in additional fields, select More Info from the Show drop-
down list.

Some of the fields are described in the following table. 

Field Comments

Account Account name. Tapping the account name hyperlink opens the Call 
Activities view.

Address The account can have more than one address. One address must 
be specified as primary. Account addresses must be entered in the 
Addresses view. For more information on adding addresses, see 
“Adding Account Addresses” on page 177.

Site A unique location identifier that distinguishes this account from 
any other accounts with the same name.

Mkt Potential Used to evaluate the business potential of the account.
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Adding Account Addresses
Addresses for accounts are entered in the Addresses view. Since an account can 
have multiple addresses, care should be taken when editing an account address, as 
changes affect all accounts associated with the address.

When entering account addresses, designate one address as the primary. Each sales 
representative assigned to an account can specify a different primary address. For 
example, one representative might specify a private office as the primary address, 
while another representative might specify a hospital department as the primary 
address.

The More Info form displays the primary address, not all the addresses for the 
contact.

To add account addresses

1 Navigate to the Accounts screen.

2 In the My Accounts list, select an account.

3 From the Show drop-down list, select Addresses.

4 Tap the Addresses list to select it.

5 On the toolbar, tap the New Record button.

6 In the Add Address dialog box, do one of the following:

■ Tap New to create a new address record, and then complete the fields.

■ Select an existing address from the list, and then tap OK.

7 In the Primary field, tap the check box to display a check mark if this is the 
account’s primary address.
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Specifying Best Times to Call Accounts
Use the Best Times to Call view to specify appropriate time periods for account 
calls. 

To specify best times to call accounts

1 Navigate to the Accounts screen.

2 In the My Accounts list, select an account.

3 From the Show drop-down list, select Best Times to Call.

The Accounts Best Times to Call view appears.

4 Tap the Best Times to Call list to select it.

5 On the toolbar, tap the New Record button.

6 Complete the necessary fields for the new record. 

The fields are described in the following table.

 

Adding Notes About Accounts
Using the Private Notes and Shared Notes views, you can create and update private 
and shared account notes. Private notes are visible only to the note creator; shared 
notes are available to other sales representatives calling on the account.

To add account notes

1 Navigate to the Accounts screen.

2 In the My Accounts list, select an account.

Field Comments

Start Day Indicates the days that the contact is available for a call.

Start Time Indicates the time that the contact is available for a call.

End time Indicates end of available time period.

Comments Text field for schedule information.
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3 From the Show drop-down list, select one of the following:

■ Private Notes. Limits access to the note to the person creating it.

■ Shared Notes. Allows all account team members to access the note.

4 Tap the Notes list to select it.

5 On the toolbar, tap the New Record button.

6 Complete the fields for the new record.

Tap in the Note field, and then tap the ellipsis (...) to view the entire note while 
you are entering text.

Indicating Affiliations Between Accounts and Professionals
For accounts where you have contact with multiple professionals, you can indicate 
the affiliation of those professionals with the account by using the Affiliations view. 
Creating affiliations between accounts and contacts promotes efficiency in call 
reporting.

To indicate affiliations between accounts and contacts

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account.

3 From the Show drop-down list, select Affiliations.

4 Tap the Contact Affiliations list to select it.

5 On the toolbar, tap the New Record button.
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6 Complete the necessary fields for the new record.

Some of the fields are described in the following table.

Viewing Sales Data
Sales data can be analyzed to measure market potential, target customers, align 
sales territories, and track market shifts. Sales data is typically syndicated 
information that is loaded periodically by the Siebel administrator. 

You can review this information using the Sales Data view. 

To view sales data

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account.

3 From the Show drop-down list, select Sales Data.

4 Review the data in the list on a product-by-product basis.

Field Comments

Last Name The contact affiliated with this account. Tap the field, select the contact 
from the Pick Contact list, and then tap OK.

Start Date The beginning date on which the account became affiliated with this 
contact.

Direct Tap the check box to display a check mark. 

If a check mark appears in this field, profile data for that person is 
routed to all members of the team assigned to the affiliated account.

If no check mark appears in this field, the profile data is routed only to 
members of the team assigned to the person.
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Planning and Recording Calls
Planning calls in Siebel ePharma Handheld consists of configuring personal lists 
and creating account and contact calls. Recording calls involves entering 
information on products detailed, samples and promotional items dropped, and 
decision issues that occurred during the call.

About Personal Lists
Personal lists allow for faster call reporting by limiting the number of products that 
appear in drop-down lists in the Call Products Detailed, Samples Dropped, and 
Promotional Items Dropped views.

About Contact and Account Calls
Contact and account calls are types of activity records, although contact and 
account calls cannot be created from the Activities view. 

Contact calls can be created by tapping the New Call or Auto Call button from the 
My Contacts view, by creating a new record from the Contacts screen’s Calls view, 
or by creating a new record from the Contact Calls screen.

Account calls can be created by tapping the New Call or Auto Call button from the 
Accounts screen, by creating a new record from the Accounts screen’s Calls view, 
or by creating a new record from the Account Call screen.

■ Contact call. Used to track a planned or past call activity with a contact. You can 
record details about contact calls such as the products detailed, the samples and 
promotional items dropped, and decision issues discussed. Before you can 
record details about a contact call, you must set up personal lists.

■ Account call. Used to track a planned or past call activity at an account. You can 
record products detailed, attendees, promotional items dropped, and decision 
issues discussed.

About Auto Call, Smart Call, and Auto Update
Siebel ePharma Handheld provides several features to manage contact and account 
call records:
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■ Smart Call. Specifying a Smart Call template for the call record associates a 
prepopulated call template with this call. 

A Smart Call is a template that you can apply to contact calls and account calls 
to simplify and speed up the call-reporting process. A Smart Call defines a set of 
information about the products detailed, the samples distributed, and the issues 
discussed on a call. Smart Call templates are created in Siebel ePharma, not in 
the handheld application.

Smart Calls can be also used for calls related to a particular campaign or 
promotional effort, or for everyday call reporting. They are intended for 
situations where sales representatives report details about a number of calls that 
are identical in content (the same products are detailed in the same order, the 
same samples are dropped, and so on). After you apply a Smart Call template to 
a call, you can make additional edits in any fields in the Contact Call screen’s 
Details view.

■ Auto Call. Selecting the Auto Call button creates a new call and populates the 
record with items from the personal lists.

Auto Call is designed to help minimize the time in front of a physician by pre-
populating the call with products from your personal list. Apply Auto Call as a 
part of the call planning process. Once the call has been created, you can access 
auto-created calls to record call information directly on the handheld in front of 
a physician.

Auto Call speeds up call reporting because you do not have to individually select 
the products and samples while recording the call. After selecting Auto Call, the 
Status field in the Contacts view displays Auto-Created.

■ Auto Update. Selecting Auto Update deletes from the database unused auto-
created call records.
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Business Scenarios
The following scenarios depict typical work sequences followed by sales managers 
and representatives using Siebel ePharma and ePharma Handheld. Your company 
may follow a different sequence according to its business requirements. 

Setting Up Personal Lists
A sales representative has recently joined a pharmaceutical company that uses 
Siebel ePharma Handheld in the field. During her sales training, the representative’s 
sales manager tells her that before she can record calls within the system, she must 
first set up her personal lists. The sales manager explains that personal lists allow 
faster call reporting by limiting the number of products that appear in the 
application’s drop-down lists. The sales manager then demonstrates how to add 
products to the sales representative’s Details, Samples Dropped, and Promotional 
Items views. Following her manager’s instruction, the sales representative updates 
her personal lists and is ready to record call details.

Planning Calls in Siebel ePharma and Recording Calls in Siebel 
ePharma Handheld
A sales representative for a pharmaceutical company wants to set up visits to her 
customers over the next few days. To do so, she first uses Siebel ePharma on her 
laptop to plan contact calls. Then she synchronizes the data with Siebel ePharma 
Handheld on her handheld device, which she carries with her to record call details. 

To plan her calls, she begins by analyzing the physicians’ prescribing habits. She 
then queries on geographical location, specialties, and time lapse since she last 
called on them to determine which physicians she should call on.

Using Siebel ePharma, she applies a Smart Call template to those calls so that 
information about the samples products is automatically copied into the call 
records. She has now prepopulated the calls with the details that she wants to speak 
about with each physician as well as the samples she wants to drop off.

The sales representative synchronizes her handheld so that she can carry these 
details with her and record her progress throughout the day. The information she 
has available on her handheld includes previous calls and other activities, notes, 
and physician prescription history.
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Before meeting with the physician, she goes to the samples closet in his office and 
drops off the samples. She records the lot numbers on her handheld device.

When she meets with the doctor, she describes the samples she has left for him, 
explains the benefits of key products, and discuss the doctor's concerns. He 
expresses interest in additional product samples so she records additional samples 
to the contact call. She then captures the doctor’s signature on the handheld device. 

After the meeting, the sales representative records the information on the products 
detailed and promotional items and issues discussed. After she has reviewed the 
information and verified that it is accurate, she submits the call. 

Planning and Recording Calls in Siebel ePharma Handheld
That same day, another sales representative sets off to visit several clinics. Unlike 
the first sales representative, this representative does not schedule his calls on his 
laptop beforehand for two reasons. First, he plans to call on group practices with 
many physicians, and he cannot be sure which physician will be signing for the 
samples. Secondly, he prefers to enter sample information manually rather than 
using a Smart Call template.

Before he enters the first clinic, he queries for physicians associated with that 
address. Seven names appear. When he walks in, he encounters one of the doctors 
so he selects that physician’s record and adds a new call. While speaking with the 
doctor about the benefits of the product, the sales representative hands him some 
samples and records the samples dropped information. He then obtains the doctor’s 
signature on the handheld device. After adding a comment about the call and 
recording products detailed, the sales representative submits the call.

Call Management Procedures
This section provides the following procedures related to planning, recording, and 
submitting calls.

■ Updating personal lists:

■ To create personal lists on page 186

■ Creating, recording, and submitting contact calls:

■ To add a contact call from the Contacts view on page 187
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■ To add a contact call from the Contact Calls view on page 189

■ To apply a Smart Call template on page 189

■ To delete unused records created from the Auto Call button on page 190

■ To record information about products detailed on page 191

■ To record information about samples dropped on page 192

■ To record information about promotional items dropped on page 193

■ To record information about decision issues discussed during the call on 
page 194

■ To capture a signature on page 195

■ To submit a completed contact call on page 195

■ Creating, recording, and submitting account calls:

■ To add an account call from the Accounts view on page 197

■ To add an account call from the Account Call view on page 198

■ To delete unused account call records created from the Auto Call button on 
page 199

■ To enter products detailed information for an account call on page 200

■ To enter attendee information for an account call on page 200

■ To submit a completed account call on page 201
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Creating Personal Lists
Personal lists determine which products appear in the drop-down lists of the Call 
Products Detailed, Samples Dropped, and Promotional Items Dropped views. 
Limiting the number of products in the lists allows for faster call reporting.

Before you can record call details, you must configure personal lists of the products 
you promote, the products you distribute as samples, and the products you provide 
as promotional items. In addition, you must specify at least one product in a 
personal list or the corresponding drop-down list will be empty when you try to 
enter call details.

Setting up personal lists is a one-time setup procedure. After you have completed 
this task, you do not need to repeat it. You can revise personal lists at any time to 
delete or add products as necessary.

To create personal lists

1 Navigate to the Personal Lists screen.

2 From the Show drop-down list, select Products, Promotional Items, or Samples 
to include that item on this personal list.

3 On the toolbar, tap the New Record button.

4 In the new row, complete the necessary fields. 

Some of the fields are described in the following table.

 

Field Comments

Order Enter a number that indicates where this product should appear 
in the drop-down list. This field appears in the Product list, 
Samples list, and Promotional Items list.

For example, if you want a product in the Product list to appear 
first, enter 1. If this field is null for all products in the list, the 
products will appear in alphabetical order. If this field is null for 
some products but not for others, records with a null Order field 
appear at the beginning of the list, in alphabetical order. 

Product The products being detailed during contact and account calls. 
This field appears in the Personal Lists, Products view.
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Creating Contact Calls
You can create contact calls and update contact call details using Siebel ePharma 
Handheld. Because contact calls are a type of activity, they also appear in the 
Calendar view.

As a shortcut for creating contact calls, you optionally may apply a Smart Call to 
the new record or auto-create a record to populate it with predefined data. For more 
information, see “About Auto Call, Smart Call, and Auto Update” on page 181. 
Before you can enter information about products detailed, samples, and 
promotional items dropped during a contact call, you must set up personal lists. For 
more information, see “Creating Personal Lists” on page 186.

To add a contact call from the Contacts view

1 Navigate to the Contacts screen.

2 In the Contacts list, select a contact. 

NOTE: If you are using the Auto Call feature, you can select several contacts from 
the list. Selecting the Auto Call button creates new calls for the selected contacts. 
Users should be advised that selecting more than one contact at a time to 
generate Auto Calls impacts performance.

3 In the Contacts list, do one of the following:

■ Tap the Auto Call button to populate the new call with items from your 
Personal List and then select Calls from the Show drop-down list. 

After selecting Auto Call, the Status field in the Contacts Calls view displays 
“Auto-Created.”

Promotional Item The promotional items being dropped during contact and account 
calls. This field appears in the Personal Lists, Promotional Items 
view.

Sample The products to be dropped as samples during contact and 
account calls. This field appears in the Personal Lists, Samples 
view.

Field Comments
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■ Tap the New Call button and complete the fields in the new form.

Some of the fields are described in the following table.

4 To specify which products to detail during the call:

a From the Show drop-down list, select Details.

b Tap the Call Products Detailed list to select it, add a new record, and complete 
the necessary fields.

5 To specify which samples to drop off during the call:

Field Comments

Last Name The contact to be visited during this call. 

Ref # A reference number for this call. This reference number becomes the 
transaction number (Transaction # field) for a samples transaction 
corresponding to this call. 

Smart Call Smart Call is a prepopulated call template that can be associated 
with this call. Make a selection from the Pick Smart Call dialog box. 

Status The status of this call. The default value is Planned. After 
synchronization, this value changes to Synchronized for calls that 
have not been submitted. 

You cannot select the value Submitted. To change the status of the 
call to Submitted, you must submit the call.

Paper Sign Indicates that the contact provided a paper signature for a sample 
disbursement.

Remake 
Receipt

Used to create an updated sample receipt and signature in the event 
that the original call information was incorrect.

For example, if Dr. Smith mistakenly signs for the receipt of samples 
on a request form having a different physician's name (such Dr. 
Jones), then the sample form is inaccurate. In this example, the sales 
representative must change the name on the original call to the 
correct physician (Dr. Smith) and have Dr. Smith sign again. 

Using the Remake Receipt check box, the sales representative can 
capture of a second signature on the corrected sample form. Siebel 
ePharma Handheld automatically tracks the appropriate audit trail 
information required by the FDA in the remake receipt functionality.
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a From the Show drop-down list, select Samples Dropped.

b Tap the Samples Dropped list to select it, add a new record, and complete the 
necessary fields.

6 To specify which products are promotional items:

a From the Show drop-down list, select Promotional Items.

b Tap the Promotional Items list to select it, add a new record, and complete 
the necessary fields.

7 To specify which issues were discussed during a call:

a From the Show drop-down list, select Issues.

NOTE: Decision issues are the objections a contact may raise when evaluating 
a product before making a prescribing decision. 

b Tap the Issues list to select it, add a new record, and complete the necessary 
fields.

For more information on how to enter information, see “Recording Contact Calls” 
on page 191.

NOTE: If you applied a Smart Call to the call, you may only need to verify that the 
information in the four lists is accurate.

To add a contact call from the Contact Calls view

1 Navigate to the Contact Call screen.

2 Tap the Contact Call form to select it.

3 On the toolbar, tap the New Record button.

4 Complete the necessary fields.

To apply a Smart Call template

1 Navigate to the Contact Call screen. 
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2 Tap the Contact Call form to select it.

3 On the toolbar, tap the New Record button.

4 In the new record, complete the necessary fields. 

5 In the Smart Call field, tap the drop-down list arrow.

6 In the Pick Smart Call dialog box, select a Smart Call template.

To delete unused records created from the Auto Call button

1 Using the Sign button:

■ From the parent Contact Call form, tap the Sign button. 

Selecting the Sign button deletes all dropped records from unused samples, 
making sure that the physician only signs for samples that he or she was 
actually given. To delete detailed records for unused products, select the 
Submit button.      

2 Using the Auto Update button:

■ From the My Contacts view, tap the Auto Update button.

For example, suppose you have used the Auto Call button to create three 
contact calls, but were unable to visit one of the physicians. Selecting Auto 
Update deletes the unused record.

NOTE: Performance is impacted if users select Auto Update when they have 
more than one unused auto-created call. It is recommended that users have 
no more than three unused auto-created calls when using the Auto Update 
feature.
190 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Using ePharma Handheld

Planning and Recording Calls
Recording Contact Calls
Contact calls are used to track a planned or past call activity with a contact. You can 
enter contact call details directly in Siebel ePharma Handheld. 

To record a contact call, users must complete the following tasks:

■ Enter information on products detailed

■ Enter information about samples dropped

■ Enter information about promotional items dropped (optional)

■ Record any decision issues (optional)

■ Submit the call

The next sections explain how to perform each of these tasks. If you have not yet 
set up your personal lists, you must do so before you can proceed with the next 
steps. For more information, see “Creating Personal Lists” on page 186.

To record information about products detailed

1 Navigate to the Contact Call screen.

2 Select the desired contact call.

NOTE: If you have not yet set up your personal lists, you must do so before you 
can proceed with the next step.

3 From the Show drop-down list, select Details.

The Product Details view appears.

4 Tap the Product Details list to select it.

5 On the toolbar, tap the New Record button to add a record for each product 
discussed during the call.
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6 Complete the fields for each record. 

Some of the fields are described in the following table.

 

To record information about samples dropped

1 Navigate to the Contact Call screen.

2 Select the desired contact call.

3 In the Contact Call form, enter a reference number (if required) in the Ref # field.

4 From the Show drop-down list, select Samples Dropped.

The Samples Dropped list appears.

Field Comments

Indication The purpose or therapeutic area for which a drug is designed.

Priority Priority of this product relative to others discussed during the 
call.

Name The name of the product detailed during the call. The products 
appearing in this drop-down list are based on the products added to 
your Personal list. For more information on adding products to your 
personal lists, see “Creating Personal Lists” on page 186
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5 Tap the Samples Dropped list to select it, and then add a record and complete 
the fields for each product dropped during the call.

Some of the fields are described in the following table.

 

NOTE: If the samples you dropped do not appear in the Name field drop-down 
list, you may need to acknowledge the receipt of the samples within the system. 
Go to the Samples Received view and submit any records with a status of In 
Progress. For more information, see “Acknowledging Receipt of a Samples 
Transfer” on page 219. If the samples you dropped still do not appear, contact 
your samples administrator.

To record information about promotional items dropped

1 Navigate to the Contact Call screen.

2 Select the desired contact call.

3 From the Show drop-down list, select Promotional Items.

The Promotional Items view appears.

Field Comments

Lot # The lot number (if applicable) of the products dropped during the call. 
If tracking samples by lot number, select a lot number in the Pick Lot 
dialog box.

Name The name of the products dropped during the call. The products 
appearing in this drop-down list are based on the products available in 
your samples inventory. For more information on samples, see 
“Managing Samples” on page 206.

Quantity The quantity of samples dropped during the call.
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4 In the Promotional Items list, add a record for each item dropped during the call, 
and complete the necessary fields.

Some of the fields are described in the following table.

 

To record information about decision issues discussed during the call

1 Navigate to the Contact Call screen.

2 Select the desired contact call.

3 From the Show drop-down list, select Issues.

The Professional Issues view appears.

4 Tap the Issues list to select it.

5 On the toolbar, tap New Record to add a record for each issue discussed during 
the call.

6 Complete the necessary fields for each new record.

NOTE: Decision issues are the objections a contact may raise when evaluating a 
product before making a prescribing decision. 

You can use Siebel ePharma Handheld to electronically capture signatures. For the 
application to accept a signature:

■ Make sure the title field for the contact from Contacts, My Contacts view is 
populated. 

■ Make sure the contact’s license number appears in the License # field of the 
Contact view. Licenses are associated with the contact's address.

Field Comments

Name The promotional item dropped during the call. The items appearing in 
this drop-down list are based on items added to your Personal 
Promotional Items list. For more information, see Creating Personal 
Lists on page 186.

Quantity The quantity of the promotional item dropped during the call.
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To capture a signature

1 Navigate to the Contact Call screen.

2 Select the desired parent Contact Call form.

3 Tap the Sign button to launch the Signature Capture view.

The Signature Capture view contains the company name, samples recorded 
when the call gets submitted, a disclaimer (as set up by the administrator on the 
Web client), and contact information.

If you want to invert the signature display, tap the Signature Flip button instead 
of the Sign button. Inverting the signature display allows you to extend the 
handheld device toward the contact for a signature without turning the device 
around.

4 In the Signature Capture view, have the contact sign on the white surface.

5 Perform one of the following actions:

■ Tap OK to submit the record.

■ Tap Cancel to abort the procedure.

■ Tap Clear to erase the signature area.

■ Tap Change Contact to select the correct contact whose signature you are 
capturing.

NOTE: The application automatically locks the keyboard hot keys when the Signature 
Capture view is displayed.

To submit a completed contact call

1 Navigate to the Contact Call screen.

2 Select the desired contact call.

NOTE: You cannot submit a call with a future date. 
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3 Verify that the information for the Contact Call is accurate and complete. For 
more information, see:

■ To record information about products detailed on page 191

■ To record information about samples dropped on page 192

■ To record information about promotional items dropped on page 193

■ To record information about decision issues discussed during the call on 
page 194

NOTE: After you submit a call, you cannot modify any fields except the Comment 
field.

4 If you dropped samples when making the call, verify that you entered a samples 
reference number in the Ref # field in the Contact Call form.

CAUTION: If you are a mobile user, submit your calls before connecting to the 
server, and then synchronize. Mobile users should not submit calls while 
connected to the server or they run the risk of introducing errors into their 
inventory counts.

5 Contact Call form, tap Submit.

If the call passes all of the validations, the application:

■ Creates a samples disbursement transaction with a line item for each 
dropped sample recorded for the call.

■ Submits a disbursement transaction to update the samples inventory. If the 
submission of the disbursement transaction is successful, the application 
changes the call's Status field to Submitted.

■ Sets appropriate fields in the call record to read-only.

For more information on submitting records, see “How Siebel Samples 
Management Works with Calls” on page 209.
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Creating Account Calls
Account Calls are used to track a planned or past call activity at an account. You 
can enter account call details directly in Siebel ePharma Handheld. 

For more information on entering call details, see “Recording Account Calls” on 
page 199.

NOTE: Before users can enter information about products detailed and attendees 
associated with an account call, they must set up their personal lists. For more 
information, see “Creating Personal Lists” on page 186.

To add an account call from the Accounts view

1 Navigate to the Accounts screen.

2 In the Accounts list, do one of the following:

■ Select the Auto Call button to populate the new call with items from the 
Personal Lists, and then select Calls from the Show drop-down list. 

NOTE: When you select Auto Call in the My Accounts view, the application 
populates the product Details list for all attendees associated with the 
account call. When you select Auto Call in the Account Calls, Attendees view, 
the application populates the Samples Dropped list for the selected attendees.

After selecting Auto Call, the Status field in the Accounts view displays 
“Auto-Created.”
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■ Tap the New Call button and complete the fields in the new form. 

Some of the fields are described in the following table.

3 From the Show drop-down list, select the following and add records, if 
necessary:

■ Details

■ Attendees

4 From the parent Account Call form, select the Submit button.

For more information entering information in the Details and Attendees lists and 
submitting a call, see “Recording Account Calls” on page 199.

To add an account call from the Account Call view

1 Navigate to the Account Call screen.

2 On the toolbar, tap the New Record button.

3 In the Account Call form, complete the necessary fields.

Field Comments

Name The account to be visited during this call. Make a selection from the 
Pick Account dialog box.

Site A unique location identifier that distinguishes this account from any 
other accounts with the same name. 

Smart Call The Smart Call template to be associated with this call. Make a 
selection from the Pick Smart Call dialog box. 

A Smart Call is a template that you apply to contact calls that defines 
information about the products detailed, samples and promotional 
items distributed, and issues discussed on a call. After you apply a 
Smart Call template to a call, you can make additional edits. 

Status The status of this call. The default value is Planned. You cannot 
select the value Submitted. To change the status of the call to 
Submitted, you must submit the call. For more information, see “To 
submit a completed account call” on page 201. 
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To delete unused account call records created from the Auto Call button

1 Using the Sign button from an Attendee Call:

■ From the Attendee Call form, select the Sign button. 

Selecting the Sign button deletes all unused samples dropped records, 
making sure that the physician only signs for samples that he or she was 
actually given. To delete unused products detailed records, select the Submit 
button.      

2 Using the Auto Update button:

■ From the My Accounts view, select the Auto Update button.

For example, suppose you used the Auto Call button to create three contact 
calls but were unable to visit one of the physicians. Selecting Auto Update 
deletes the unused record. 

NOTE: Performance will be impacted if you select Auto Update when you have 
more than one unused auto-created call. Users are advised to have no more 
than three unused auto-created calls when using the Auto Update feature. 

Recording Account Calls
Account calls are used to track a planned or past call activity with an account. You 
can enter account call details directly in Siebel ePharma Handheld. 

To record an account call, users must complete the following procedures:

■ Enter information on products detailed

■ Enter attendee information (the names of contacts met and any samples 
dropped)

■ Enter information about any activities related to the call (optional)

■ Submit the call

The next sections explain how to perform each of these tasks. You must set up your 
personal lists before you can complete this procedure. For more information, see 
“Creating Personal Lists” on page 186.
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To enter products detailed information for an account call

1 Navigate to the Account Call screen.

2 Select the desired account call.

3 From the Show drop-down list, select Details.

4 In the Details list, add a record for each product detailed during the call, and 
complete the necessary fields.

Some of the fields are described in the following table.

 

To enter attendee information for an account call

1 Navigate to the Account Call screen.

2 Select the desired account call.

3 From the Show drop-down list, select Attendee.

4 Tap the Attendee list, to select it.

5 On the toolbar, tap the New Record button to add a new record for each 
attendee.

6 Complete the fields for each attendee.

a In the Last Name field, tap the drop-down list arrow. 

Field Comments

Indication The purpose or therapeutic area for which a drug is designed.

Priority Priority of this product relative to others discussed during the call.

Name The product detailed during the call. The products appearing in this 
drop-down list are based on the products added to your Personal List.
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b From the Pick Contact dialog box, select those contacts you want to add as 
attendees.

The application creates an attendee call record (similar to a contact call) for 
each contact you include as an attendee of the account call. These attendee 
call records are child records of the account call and can be accessed by going 
to the Account Call and finding the associated attendee. Drilling down on the 
attendee last name hyperlink enable you to navigate to and access the 
appropriate attendee call details view. 

7 To create an attendee call, do one of the following:

■ Select the Auto Call button to populate the attendee call with items from the 
personal lists, and then select Calls from the Show drop-down list. 

After selecting Auto Call, the Status field in the Accounts view displays 
“Auto-Created.”

■ Drill down on the Last Name hyperlink and complete the fields in the Contact 
Calls details.

NOTE: You must set up your personal lists before you can complete the next step. 
For more information, see “Creating Personal Lists” on page 186.

To submit a completed account call

1 Navigate to the Account Call screen.

2 Select the desired account call.

NOTE: You cannot submit a call with a future date. 

3 Verify that the information for the Account Call is accurate and complete.

For more information, see:

■ To enter products detailed information for an account call on page 200
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■ To enter attendee information for an account call on page 200

CAUTION: If you are a mobile user, submit your calls before connecting to the 
server, and then synchronize. Mobile users should not submit calls while 
connected to the server or they run the risk of introducing errors into their 
inventory counts.

4 In the Account Call form, select Submit.

For more information on the validation process when a user selects the Submit 
button, see “Validation Logic of the Sign and Submit Buttons” on page 4-26.

If the call passes all of the validations, the application:

■ Creates a samples disbursement transaction with a line item for each 
dropped sample recorded for the call.

■ Submits a disbursement transaction to update the samples inventory. If the 
submission of the disbursement transaction is successful, the application 
changes the call's Status field to Submitted.

■ Sets many fields in the call record to read-only.

NOTE: If attendees are recorded in an account call, an attendee call is created for 
each attendee, and the process described above is performed for each attendee 
call. Attendee calls are the same as contact calls except that they do not appear 
in the Activities view and they are submitted automatically when the account 
call is submitted. 

Creating General Activities
Sales representatives use general activities to manage time and schedule demands 
and to keep their manager informed of their workload. A general activity in Siebel 
ePharma Handheld is used to track non-call tasks such as to-do items, personal 
events, and correspondence.
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In a typical scenario, a sales manager for a pharmaceutical company uses the 
Activities screen to create and track the activities on which she plans to spend her 
time during the next month. After scheduling a contact call with a customer, she 
uses the Calendar to review scheduled activities for the upcoming weeks.

This section provides procedures for adding activities from the Activities and 
Calendar views.

Adding General Activities From Activities
All activities with valid dates and times appear in the Siebel ePharma Handheld 
Calendar views as well as in the Activities views. The Calendar views provide a 
visual representation of each user’s scheduled activities. 

NOTE: The Planned Start and Duration fields in general activities and appointments 
must contain entries in order for the appointments and activities to appear in the 
correct time period in the Daily Calendar view. While the Planned Start field is 
visible in the Activities screen’s My Activities view, this field is not visible in the 
Contacts screen’s Activities and Accounts>Activities views. The Planned Start field 
can be exposed during application configuration.

To add a general activity from the Activities view

1 Navigate to the Activities screen.

2 On the toolbar, tap the New Record button.
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3 In the new row, complete the necessary fields. 

NOTE: Select More Info from the Show drop-down list to edit additional fields for 
each record.

Some of the fields are described in the following table.

Adding General Activities Using Calendar
General activities and appointments must have the Planned Start and Duration 
fields populated in order to be displayed in the correct time slot on the Daily 
Calendar view.

To add a general activity in the Calendar view

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select My Daily, My Weekly, or My Monthly.

Field Comments

Activity Activities entered here are set as “General” and are not editable. 
Calls created from the New Call button are set as “Contact Call” or 
“Account Call” depending on whether these calls were created for a 
contact or an account. Previously created Contact Calls and Account 
Calls are displayed on the Activities view. 

Activity Type The type of activity. The values displayed in this drop-down list 
depend on the value of the Activity field. For example, the activity 
types that you can select for a contact call are different from those 
that you can select for a general activity. 

Assigned To The sales representative responsible for the activity. The Assigned 
To field in all Activities views (Activities, My Activities list; 
Activities, More Info form; Contacts, Activities list; and Accounts, 
Activities list) is read-only. 

Duration The length of time, in minutes, that you expect the activity to take.

Last Name The last name of the contact associated with the activity. The Last 
Name field on the Activities, My Activities view and the Accounts, 
Activities view is read-only. 
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3 For My Weekly or My Monthly, select the day and time on which you want to 
schedule a general activity.

4 On the toolbar, tap the New Record button or double-tap on a row. 

5 In the new record, complete the necessary fields.

Some of the fields are described in the following table.

6 To specify contact participants:

a From the Show drop-down list, select Contact Participants.

b Tap the Contacts list to select it.

c On the toolbar, tap the New Record button.

d In the Add Contacts dialog box, select participants and then tap OK.

7 To specify employee participants:

a From the Show drop-down list, select Employee Participants.

b Tap the Employee Participants list to select it.

c On the toolbar, tap the New Record button.

d In the Add Employees dialog box, select participants, and then tap OK.

Field Comments

Account Complete this field if the activity is related to a particular account. 

Planned Start If you started from the Daily Calendar view, this date reflects the 
time selected when you created the new appointment. If you started 
from the Weekly Calendar or Monthly Calendar view, the first time 
slot of the day is supplied.

Type The type of activity. The values displayed in this drop-down depend 
on the kind of activity. 

Repeat Until The end date of a repeating appointment. If you do not select a 
value, 12 more appointments will be scheduled. 
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Managing Samples
Most pharmaceutical manufacturers provide free samples to health care 
professionals in an effort to influence the prescribing habits of physicians and 
accounts across the United States and the world. In the United States, samples 
distribution is regulated by the FDA and must be reconciled at least once a year. 

Siebel ePharma Handheld maintains a samples transaction record for samples 
transfer, receipt, disbursement, order, and inventory adjustment. The application 
assigns each samples transaction record a unique identifier for tracking purposes. 
Depending on the type of transaction, you can display this identifier as a transaction 
number, an order number, an invoice number, or a transfer number. 

This section describes managing and maintaining an electronic inventory of 
samples and promotional items within Siebel ePharma Handheld. As part of 
managing samples, you can track an electronic inventory of samples stock, create 
request orders and transfers for samples, and acknowledge receipt of sample 
transfers directly in Siebel ePharma Handheld. You can use either Siebel ePharma 
or Siebel ePharma Handheld to manage your samples, however you cannot use both 
applications to handle samples transactions. Reconciling inventory must be 
performed in Siebel ePharma.

Procedures for Managing Samples
This section provides instructions for the following procedures:

■ Creating a Samples Order on page 215

■ Creating a Samples Transfer on page 217

■ Acknowledging Receipt of a Samples Transfer on page 219

■ Adjusting a Samples Transaction on page 221
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Keeping Server and Handheld Samples Records in Sync
Administrators can manage samples inventory using either Siebel ePharma 
Handheld or Siebel ePharma, but should not use both. In order to keep samples 
inventories in sync, end users should be prevented from submitting a samples 
transaction on the server when the same record is still editable on their handheld 
device.

When a user submits a record, the status changes to Submitted and it becomes read-
only, meaning no additional operations are allowed on the record. By updating a 
user property and writing two small Visual Basic scripts, you can specify that 
synchronized records are also read-only. 

■ First, the administrator changes the value of the user property “Update Status To 
Synchronized” to Y. 

Making this change invokes the UpdateStatusToSynchronized method on the 
Sample Txn business component. 

■ Then, the administrator writes a small Visual Basic script for this method to 
change the status on the Sample Txn to “Synchronized.” 

■ Finally, the administrator writes another Visual Basic script to specify that the 
record becomes read-only when its status changes to “Synchronized.” 

This prevents users from accidentally submitting the sample transactions on the 
server while the same record is still editable on their handheld device.
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Business Scenario
This scenario is an example of a workflow performed by an end user. Your company 
may follow a different workflow according to its business requirements.

Near the end of the quarter, a sales representative in the U.S. prepares for FDA-
mandated inventory reconciliation. She is required to take a physical inventory of 
her samples and make sure the quantities match the electronic inventory. To do so, 
she needs to make sure that all her sample transactions are up-to-date for the 
current period before submitting the inventory count.

The sales representative remembers that she made a sample disbursement mistake 
earlier in the day. She accidentally had a physician sign for 10 samples when she 
really only dropped off five. Therefore, she needs to make a samples adjustment for 
this transaction. 

In Siebel ePharma Handheld, she finds the sample transaction record. Then, she 
selects the adjust quantity feature, which automatically shifts the transaction status 
to “In Progress” for the new adjustment record and to “Adjusted” for the already-
submitted sample transaction. When she submits the adjustment record, Siebel 
ePharma Handheld updates her inventory to reflect the lower quantity that was 
disbursed and changes the sample quantity for the actual call from ten to five.

The sales representative also had some samples that had expired, which she 
physically mailed back to her samples administrator. She now has to record this 
transaction into her electronic inventory. In the Samples Transfer view, she creates 
a new record. Then she adds three new sample line item records and selects the 
Submit button. This changes the status to submitted, locks the records, and updates 
the handheld inventory to reflect the transfer.

The sales representative is now ready for the actual inventory count. While 
physically standing in her personal samples closet with her handheld device, she 
opens the Samples Inventory Count view. From this view, she sees the products 
listed in her personal inventory according to the electronic count. She goes down 
the list, product by product, lot by lot, counting each product and lot number 
combination. 
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She enters the actual quantity that she finds into Siebel ePharma Handheld and 
notices that the application automatically updates the difference field to reflect 
discrepancies between the on-hand and electronic inventory. When she is finished, 
she verifies that the differences are zero. She is now ready to submit her inventory 
count. Submitting causes a new inventory period to open, displaying the current 
date and time.

How Siebel Samples Management Works with Calls
This section describes how Siebel Samples Management works with the Contact 
Call Detail and Account Call Detail views. For more information on recording calls, 
see “Planning and Recording Calls” on page 181. 

When you select the Submit button in either the Contact Call and Account Call 
forms, the application verifies that:

■ The call’s date and time is the same as or earlier than the current date and time. 
A call cannot be submitted with a future date.

If dropped samples are recorded for the call, the application checks that:

■ The Ref# field is not empty. This is controlled by the user properties setting. If 
the user property for reference number required is set to Y, then the application 
displays an error message if this field is not populated by the user. Otherwise, 
the application will automatically populate this field. 

■ The samples exist in the inventory for the period indicated by the call’s date and 
time.

■ The period into which the samples will be recorded is an unreconciled period. 
If it is a reconciled period, a warning message appears.

■ A valid lot number has been specified for dropped samples tracked by lot 
number.

If the call passes these checks, the application:

■ Creates a samples disbursement transaction with a line item for each dropped 
sample recorded for the call. 
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■ Submits a disbursement transaction to update the samples inventory. If the 
submission of the disbursement transaction is successful, the application 
changes the call’s Status field to Submitted. 

■ Converts many fields in the call record to read-only. 

An administrator can change the fields that become read-only after a call is 
submitted. 

NOTE: If attendees are recorded in an account call, an attendee call is created for 
each attendee, and the process described above is performed for each attendee 
call. Attendee calls are the same as contact calls except that they do not appear 
in the Activities view and they are submitted automatically when the account 
call is submitted. 

About Inventory Periods
Siebel Samples Management provides three types of inventory periods for 
maximum flexibility. These period types are described in Table 29.

 

Table 29. Samples Inventory Periods

Period Type Description

Active The current period; it shows no end date and it is not reconciled. You can 
enter any type of samples transaction, including adding new products; 
inventory counts will be adjusted accordingly.

Inactive A past, unreconciled period; it shows an end date but has not been 
reconciled yet. Except for adding new products into inventory, you can 
enter any type of samples transaction.

Reconciled A past, inactive period; reconciled periods will not display on the handheld 
application.
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About Establishing an Initial Inventory Count
Establishing an initial master inventory is only necessary if you are manually 
entering and tracking samples. Either an administrator or an end user may establish 
an inventory. However, because Siebel Samples Management routes and maintains 
transactions by Employee ID, only the user who creates an inventory (the initial 
inventory count) can create or manipulate that inventory. 

Before adding products to the master inventory, you must verify that the products 
are correctly defined for inventory tracking. In particular, make sure that the 
products are Orderable and have either Inventory or Lot # tracking. 

NOTE: End users do not need to perform the procedures described in this section if 
their initial counts consist only of samples transfers routed to them by their samples 
administrator. Instead, they should simply acknowledge the receipt of those 
shipments. For more information, see “To acknowledge receipt of a samples 
transfer” on page 219. However, end users do need to perform the procedures 
described in this section if their initial counts contain any records that they entered 
manually. End users who enter records manually must submit those counts and 
reconcile the initial inventory period.

To establish an initial master inventory:

■ Count products on hand. Establish an inventory count by physically counting the 
products currently on hand. This process creates a list of the products in your 
inventory and an inventory period solely for your initial count. 

■ Add products and submit count. Add products to the inventory and submit an 
initial count. (See “To add products to inventory and submit an initial count” on 
page 211.)

■ Submit adjustments. Create and submit adjustments for the initial count. (See “To 
create and submit initial count adjustments” on page 214.)

■ Reconcile. Reconcile the initial inventory period using Siebel ePharma. 

To add products to inventory and submit an initial count

1 Navigate to the Samples Adjustments screen.
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2 From the Show drop-down list, select Inventory Count. 

The Inventory Count list appears.

3 On the toolbar, tap the New Record button to add a new row.

4 Complete the necessary fields. 

NOTE: Some of the fields are described in the following table. Users cannot sort 
on the Difference and On Hand Qty fields in the Inventory Count applet.

 

5 Tap Submit.

The Difference field is cleared for all records. The application transfers the 
number you entered in the Count field to the On Hand Quantity field and clears 
the Count field. 

Once you submit an initial count, the Siebel Samples Management deactivates 
the inventory period into which you entered your initial counts and creates a 
new active inventory period. You can view this change using the My Samples 
History filter.

Field Comments

Count The amount of your initial inventory.

Difference Shows a negative number after you enter a value in the Count field. 

Lot The lot number for this sample.

Sample The name of the sample to be added.
212 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Using ePharma Handheld

Managing Samples
6 From the Show drop-down list, select Samples History.

The Samples History view appears. The inventory period into which you entered 
your initial counts becomes inactive—a date and time appear in the End Date 
field, and there is no check mark in the Active field. In addition, a new active 
period has been opened. 

NOTE: You cannot submit an adjustment transaction if the product is not 
currently active. Siebel Samples Management considers a product inactive if the 
administrator has made it inactive, or the product does not exist in the inventory 
count list. 
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To create and submit initial count adjustments

1 Navigate to the Samples Adjustments screen.

2 From the Show drop-down list, select Adjustments.

The Samples Adjustments list appears.

3 On the toolbar, tap the New Record button add a new record.

The Sample Adjustment Details form and list appear.

4 Complete the necessary fields. 

Some of the fields are described in the following table.

 

5 From the Show drop-down list, select the Adj. Details view.

6 On the toolbar, tap the New Record button.

7 Complete the necessary fields. 

Repeat Step 3 and Step 4 to enter a line item for each sample needing 
adjustment.

Field Comments

Adjustment Reason Select Initial Count from the drop-down list.

Transaction # The application automatically generates an unique identifier. 
You can change this value. 

Transaction Date The date of the adjustment transaction. Make sure that this date 
falls within the valid date ranges for the appropriate Inventory 
Period. 

Status The application automatically changes this field value to 
Submitted when you submit the adjustment.
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8 Tap Submit.

The values in the Transaction Status field (in the Samples Adjustment form) and 
the Item Status fields (in the Line Items list) change to Submitted. 

NOTE: You must reconcile using Siebel ePharma. For more information, see Siebel 
Life Sciences Guide.

About Siebel ePharma Handheld Samples Views
Siebel ePharma Handheld contains these main screens related to sample 
management:

■ Samples. Navigate to this screen to display a history of samples and an inventory 
list.

■ Samples Adjustments. Navigate to this screen to adjust sample transaction 
records, such as correcting quantities dropped off, or to display your on-hand 
inventory count.

■ Samples Receipts. Navigate to this screen to acknowledge the receipt of a 
samples transfer or to display a list of receipts, and to review receipt details.

■ Samples Transfers. Navigate to this screen to create a transfer, to display a list of 
transfers to or from your inventory, and to review transfer details.

■ Samples Orders. Navigate to this screen to create an order for samples, to display 
a history of orders, and to review order details.

Creating a Samples Order
You can request additional samples by creating a samples order using Siebel 
ePharma Handheld. 

After synchronizing, Siebel ePharma routes the samples order to the samples 
administrator. The samples administrator then creates a samples transfer that is 
routed back to the requestor. After the requestor acknowledges receipt of the 
transfer, Siebel Samples Management automatically enters the new inventory into 
their inventory counts.
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To create a samples order

1 Navigate to the Samples Orders screen.

2 From the Show drop-down list, select Orders.

3 On the toolbar, tap the New Record button.

4 In the new record, complete the necessary fields.

The application automatically sets the Order Date field to a date and time in the 
active period. It also automatically generates values for the Order # field, but it 
can be edited. You might want to edit this value to have the items appear in a 
particular order (other than the order in which you entered them).

NOTE: It is not necessary to change the Order Type field. You can include both 
samples and promotional items in a single order.

5 Drill down on the Order # hyperlink.

6 Tap the Samples Order Details list on the right to select it.

7 On the toolbar, tap the New Record button.

8 Complete the necessary fields for the new record. 

Some of the fields are described in the following table.

 

9 Repeat Step 7 and Step 8 to enter a line item for each product or promotional 
item you want to order. 

Field Comments

Item Status Initially set to In Progress. The application automatically changes this 
field value to Submitted when you submit the transaction.

Sample The product to be ordered. Tap the arrow in the Sample field, choose 
the product from the Pick Product list, and then tap OK.

Quantity The sample quantity that you are ordering.
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10 Tap Submit. 

NOTE: You cannot modify or delete an order after it has been submitted.

The values of the Status field (in the form) and the Item Status field (in the list) 
change to Submitted. 

Creating a Samples Transfer
You can create a samples transfer to exchange samples between one another or to 
return samples to the home office. 

After the samples transfer is submitted into the system, the recipient receives a 
samples transfer. After the recipient acknowledges the receipt of the transaction, the 
application enters the new inventory into his or her inventory count.

NOTE: Samples returns are defined as transfer transactions for which corresponding 
received shipment transactions have not been created. Returned samples are 
subtracted from the sender’s inventory counts but are not added to the master 
inventory, as they are typically expired or damaged products.

To create a samples transfer

1 Navigate to the Samples Transfers screen.

2 From the Show drop-down list, select Transfers.

3 On the toolbar, tap the New Record button.
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4 In the new row, complete the necessary fields. 

Some of the fields are described in the following table.

5 Drill down on the Transfer # hyperlink.

6 Tap the Sent Samples Details list to select it.

7 On the toolbar, select the New Record button.

Field Comments

Transfer # The application automatically generates a unique identifier. You 
can change this value. 

Transfer Date The application automatically generates a date and time value that 
falls in the active period. 

Transfer Status The application automatically changes this field value to 
Submitted when you submit the transaction.

Transfer Last 
Name

The employee to whom you are transferring the samples. If the 
value of the Transfer Type field is Transfer Out, then you must 
complete this field. Leave this field empty if the value of the 
Transfer Type field is Return. 

Transfer Type Select the appropriate value:

■ Transfer Out - Indicates you are transferring samples to another 
employee.

■ Return - Indicates you are returning samples to the home 
office. Samples are typically returned because they are expired 
or damaged products that should be destroyed. Transfers with 
the Transfer Type field set to Return do not generate shipment 
transactions (because there is no recipient), and they are not 
added to the master inventory counts.
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8 In the new row, complete the necessary fields. 

Some of the fields are described in the following table.

 

9 Repeat Step 7 and Step 8 to enter a line item for each product or promotional 
item you are transferring. 

10 Tap Submit.

NOTE: You cannot modify or delete a transfer transaction after it has been 
submitted. The transaction will appear in the Samples History list as part of the 
Inventory List view.

Acknowledging Receipt of a Samples Transfer
Siebel Samples Management supports two ways of electronically moving samples 
inventory:

■ By creating a samples transfer (see “Creating a Samples Transfer” on page 217)

■ By creating a samples order (see “Creating a Samples Order” on page 215)

In either case, the application creates a samples transfer transaction and routes it to 
the recipient for acknowledgement. After the recipient submits a receipt, the 
application transfers the new inventory into the recipient’s active inventory period. 
You can then view the new inventory in the Samples History view. 

To acknowledge receipt of a samples transfer 

1 Navigate to the Samples Receipts screen.

Field Comments

Item Status The application automatically changes this field value to 
Submitted when you submit the transaction.

Lot # The lot number for this samples transfer.

Quantity The quantity that you are transferring.

Sample The samples being transferred.
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2 In the Samples Receipts view, drill down on the Invoice # hyperlink.

The Receipts Details view appears. In the form, samples transfers that have not 
been acknowledged as received show an Invoice Status value of In Progress. 
Those that have been acknowledged as received show an Invoice Status value 
of Submitted. 

3 In the Receipts Details list, modify the Received Quantity field if the value does 
not accurately reflect the quantity received. 

4 Tap Submit. 

NOTE: The samples transfer quantities do not appear in end users’ inventory 
counts until they submit a samples receipt. However, after the samples receipt 
has been submitted, it cannot be modified or deleted. 

The values in the Invoice Status field (Received Samples list) and the Item Status 
field (Line Items list) change to Submitted. 

5 To verify the submitted transfer was recorded:

a Navigate to the Samples screen.

b From the Show drop-down list, select Samples History.

The Samples History view appears. 

c Highlight the appropriate inventory period to view the line items of the 
received transfers.
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Adjusting a Samples Transaction
You can adjust inventory counts of samples stock by making adjustments to past 
samples transactions directly in Siebel ePharma Handheld. Common reasons for 
adjusting past transactions include product loss or expiration, counting mistakes, or 
data entry errors. End users can add products or adjust quantities for any type of 
samples transaction (disbursement, transfer, order, and so on). 

NOTE: End users cannot add a product to your inventory that did not exist when the 
original transaction was created. 

The inventory list view displays all the samples for the selected inventory period. 

To add a product to a samples transaction

1 Navigate to the Samples screen.

2 From the Show drop-down list, select Samples History.

3 In the Inventory Periods list, select the period containing the transaction.

4 In the Sample History list, select the transaction you would like to update. 

You can identify the transaction record in the Samples History list by the 
Transaction Date, Last Name, or Transaction # field values. 

NOTE: To make it easier to find a transaction, sort the records in the Samples 
History list by the field you are using to identify the transaction. For example, if 
you know the Transaction #, sort the list by that field to locate the records you 
are looking for. 

5 In the Samples History list, tap Add, and then tap OK. 
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6 In the new row, complete the necessary fields.

When you add a record, the application adds a new line-item record for the 
transaction in the Samples History list and sets the line-item record’s Item field 
Status to In Progress. With the exception of the Item Status value, the new record 
is a copy of the record selected in Step 4. 

Some of the fields are described in the following table.

 

Field Comments

Item Status The application automatically changes this field value to 
Submitted when you submit the adjustment.

For any row that shows an item status of Submitted, you can also 
see one or more rows with the identical sample name and 
transaction number but with an item status of In Progress or 
Adjusted. 

Valid values include:

■ In Progress - Indicates that the adjustment record has not yet 
been submitted, so it can still be modified. However, the 
record’s data is not reflected in the inventory count.

■ Submitted - Indicates that the record has been submitted and 
therefore cannot be modified. Since it has been submitted, the 
record’s data is reflected in the inventory count.

■ Adjusted - Indicates that a previously submitted record has 
been superseded by a subsequent adjustment record. The 
record cannot be modified.

Lot # The correct lot number for this sample. Select the Add button to 
update this field.

Sample Verify that the correct product name is selected. Select the Add 
button to update this field.

Transaction # The transaction number or, in the case of samples disbursements, 
the reference number. The Transaction # value corresponds to the 
Ref # value displayed in the Contact Call Detail view.

Transaction Type Displays the type of transfer. Valid values include Transfer Out 
and Transfer In.
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To adjust a quantity in a samples transaction

1 Navigate to the Samples screen.

2 From the Show drop-down list, select Samples History.

3 In Inventory Periods list, select the period containing the transaction. 

The samples for the selected period are displayed in the list on the right. 

4 In the Samples History list, select the transaction you would like to update. 

You can identify the transaction record in the Samples History list by the 
Transaction Date, Last Name, or Transaction # field values. 

5 Tap Adjust Qty and then tap OK. 

The application copies the line-item record for the transaction in the Samples 
History list and sets the line-item record’s Item Status field to In Progress.

6 In the Samples History list, enter the correct quantity in the Quantity field.

7 Tap Submit, and then tap OK. 

The application adds the new item with an Item Status of Submitted and changes 
the original item record (whose quantity you adjusted) to an Item Status of 
Adjusted. The new quantity is reflected in the on-hand quantities in the Inventory 
Count view.

Setting Up MedEd Events
This section describes how a pharmaceutical company can use Siebel ePharma 
Handheld to plan a medical education (MedEd) event. A MedEd event refers to a 
promotional or educational event attended by physicians and medical professionals. 
An event functions as a forum for exchanging information on a particular disease, 
illness, therapeutic class or product. A medical education event can be as simple as 
a lunch-and-learn in a physician's office or as complex as a seminar series or 
national sales meeting. 

Sales representatives in the field can use Siebel ePharma Handheld to view and 
create MedEd events and invite contacts to MedEd events. 
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MedEd Procedures
This section provides instructions for the following procedures:

■ Creating a MedEd Event on page 225

■ Inviting Professionals to MedEd Events on page 225
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Creating a MedEd Event
You can create MedEd events directly in Siebel ePharma Handheld. 

To create a MedEd event

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Events.

3 On the toolbar, select the New Record button. 

4 In the new list, complete the necessary fields. 

Some of the fields are described in the following table.

Inviting Professionals to MedEd Events
When you have scheduled a MedEd event and have decided what sessions will be 
offered, you can invite health care professionals to attend. 

To invite a contact to a MedEd event

1 Navigate to the MedEd screen.

Field Comments

Budget The amount of money budgeted for the event. 

CME Credit Number of CME (Continued Medical Education) credits that can 
be earned at the event. 

Created By User name for the person who created the MedEd event.

End Date Date and time that the event ends. Set the time fields before 
selecting a calendar day. 

Start Date Date and time that the event starts. Set the time fields before 
selecting a calendar day. 

Event Status Indicates whether the event is active, cancelled, completed, in 
progress, inactive, or planned. 

Type The category of medical education event being offered. 
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2 From the Show drop-down list, select Invitees.

3 Tap the Contacts list to select it.

4 On the toolbar, select the New Record button.

5 In the new row, complete the fields.

Some of the fields are described in the following table.

Creating Expense Reports
You can track expenses and create expense reports using Siebel ePharma Handheld.

To create an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 On the toolbar, tap the New Record button.

4 In the new row, complete the necessary fields.

5 From the Show drop-down list, select More Info to view additional fields.

NOTE: You must complete the Submit To field or you will get an error message 
and your expense report will not be saved.

Field Comments

First Name Completed based on the last Name selection.

Last Name The contact/invitee. Select from the Pick Contact list.

Invitee Status Indicates whether the invitee has confirmed attendance, is on a 
wait list, and so on. Pending is the default value.

Role  Describes the selected contact’s role at the session.
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To add detailed line items

1 Navigate to the Expense Reports screen. 

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, drill down on the Name hyperlink. 

4 Tap the Line Items list to select it.

5 On the toolbar, tap the New Record button. 

6 In the new row, complete the necessary fields.

You can enter Line Items whose Start or End Date is outside of the Expense 
Report period. 

7 Repeat Step 4 through Step 6 to add line items. 
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Troubleshooting A
This appendix addresses some of the common issues faced while deploying Siebel 
Handheld. The appendix presents troubleshooting tips in three areas:

■ Installation

■ Performance

■ Log Files

The audience for this appendix is Siebel database administrators, system 
administrators, and application administrators.

Installation
Siebel Handheld supports a specific and limited set of devices, handheld OS, 
desktop OS, server OS, server databases, and languages. This range of devices and 
platform support varies widely across the range of Siebel Handheld releases and 
must be carefully checked to confirm support. See the system requirements and 
supported platforms documentation for your Siebel application for information on 
supported Handheld OS, desktop OS, server OS, and server databases.

Client Installation, Backup, and Restore
If you run into problems while installing the handheld application on client devices 
from a desktop PC, refer to the following checklist. Most installation problems are 
covered by this checklist.

■ Is the device certified and supported? Refer to the system requirements and 
supported platforms documentation for the handheld application.

■ Confirm that the device has 64 MB of RAM with the majority of it available for 
the Siebel Handheld application.
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Synchronization
■ Is an ActiveSync connection running (green icon)? If not, check your computer 
to make sure that the serial or USB port is activated and functioning correctly.

■ If previous versions of Siebel Handheld were installed to the device, did you 
uninstall the application? See “Uninstalling the Handheld Application” on 
page 136.

Siebel Handheld binaries may also be installed to a CompactFlash card to conserve 
(RAM) memory. The application will still be loaded into memory when it executes. 
To install to the CompactFlash card, set the ApplicationBinariesLocation and 
ApplicationDataLocation parameters in the setup.ini file. See “Setting up 
Installation on a CompactFlash Card” on page 113.

Siebel Handheld (application only - no data) may also be backed up to a 
CompactFlash card to aid in deployments. Using the built-in backup utility that 
comes with Compaq (QUtilities) and HP Jornada (HP Backup) devices, a backup 
image may be created which can then be restored onto other devices. The initial 
backup image should be made of a device that has not done an initial 
synchronization. An initial synchronization will still be required by each user to 
receive the configuration and data.

It is also possible to back up Siebel Handheld to a PC using the Backup/Restore 
feature within ActiveSync.

Synchronization
Synchronization problems can be caused by incorrect settings in the Siebel 
Handheld setup.ini or .cfg files. Be sure that application names, data sources, and 
SRFs are correct.

Make sure to set the URL setting (DSSURL) in the client setup.ini for direct server 
synchronization installations. Be sure to list the views (DefaultViews) in the 
application .cfg file. Also, do not forget to grant the user visibility to these views in 
the Application Administration > Responsibilities view.

NOTE: Check the log files and confirm the accuracy of the generated connect string.
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Synchronization
Companion Sync Checklist
Use the following checklist to troubleshoot problems you encounter using 
Companion Sync.

■ Is the latest version of ActiveSync (v.3.5 or later) installed and running?

■ Is ActiveSync connected (green icon)?

■ Do you have the correct data source defined in the handheld .cfg file?

■ If you have problems logging in, check to make sure that you can use the same 
credentials to log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in 
to sync each device. Failure to do so causes data corruption.

Direct Server Sync Checklist
Use the following checklist to troubleshoot problems you encounter using Direct 
Server Sync.

■ Did you install all client and server components successfully?

■ Is there a PDA OM running on the Siebel Server?

■ Did you bounce the IIS, SWE, and Siebel Server after installation?

■ Do you have network access to the URL for DSS? Can you ping the IIS server 
from inside and, if applicable, from outside the firewall?

■ Can you successfully run a SWE command?

■ Do you have the correct DSS URL defined in the setup.ini file?

■ Is the network connection working from the device? Try Pocket IE.

■ If you have problems logging in, check to make sure that you can use the same 
credentials to log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in 
to sync each device. Failure to do so causes data corruption.
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Re-synchronizing Problems
Generally if, for whatever reason, synchronization is terminated, the end user is 
prompted with a message and the synchronization process ends. In this situation 
the synchronization session is allowed to close. However, if the connection with the 
server is unintentionally broken, the session may not have a chance to close before 
the connection is broken. Therefore, if the end user tries to immediately 
synchronize again, he may get an error message and may not be able to 
synchronize. Should this occur, the end user should wait for a period of time 
(generally, 15 minutes) to allow the session to time out and terminate. Once the 
session terminates, the end user should be able to synchronize again.

Log Files
This section discusses issues related to log files.

Direct Server Sync Log Files
To assist Siebel Technical Support, collect the following files when logging a Siebel 
Handheld service request. The following files are found on the machine where 
Siebel Server is installed:

■ All server sync user files in the Siebel Root\siebsrvr\hhsync\application 
directory\user id\node id directory

■ Server NT application event log extract

■ Server NT system event log extract

■ All files in the Siebel Root\siebsrvr\log directory including hhsync.*.log files 

The hhsync.*.log files log every message returned by Object Manager (including 
informational messages, synchronization errors, debugging messages, and 
warnings.) The information logged depends on the logging level set in the .cfg 
file.

■ All files from all subdirectories under the Siebel Root\siebsrvr\logarchive 
directory.
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Log Files
■ Server perfmon log files (showing memory, network, disk performance), if 
available.

The following files are found on the machine where the Web Server (that is, IIS) is 
installed:

■ SWE log files from Siebel Root\eappweb\log (all files)

■ IIS server NT application event log extract

■ IIS server system event log extract

■ IIS server perfmon log files (showing memory, network, disk performance), if 
available

Companion Sync Log Files
To assist Siebel Technical Support, collect the following log files when logging a 
Siebel Handheld service request. The following files are found on the companion 
PC where Siebel Mobile Web Client is installed:

■ Client Siebel Handheld Sync log file: \log\syncmanager_log.txt

■ All files in the Siebel Root\client\hhsync\application directory\user id\node id 
directory

■ NT application event log extract

■ NT system event log extract

■ All files in the Siebel Root\client\log directory including hhsync.*.log files 

The hhsync.*.log files log every message returned by Object Manager (including 
informational messages, synchronization errors, debugging messages, and 
warnings.)

■ Perfmon log files (showing memory, network, disk performance), if available
Version 7.5.3 Siebel ePharma Handheld Guide for Windows-Powered Devices 233



Troubleshooting

Log Files
Handheld Device Logs
The following log files are found in the /Program Files/Siebel Handheld directory 
on the handheld device:

■ dbimport_log.txt—This file is a log of the database objects that were imported 
during synchronization. The file is located in the \Program Files\Siebel 
Handheld directory on the handheld client.

■ sql_stmt_log.txt—This file logs all SQL statements generated by the application. 
You must set a parameter in the setup.ini file to turn this log on. The log file is 
located in the \Program Files\Siebel Handheld directory on the handheld client. 
See “Configuring Handheld Logging Parameters” on page 113 for more 
information about setting the parameter.

■ ssa_errors_log.txt—This file is a log of all system error messages. You must set a 
parameter in the setup.ini file to turn this log on. The log file is located in the 
\Program Files\Siebel Handheld directory on the handheld client. See 
“Configuring Handheld Logging Parameters” on page 113 for more information 
about setting the parameter.

■ syncmanager_log.txt—This file contains all of the messages displayed on the Sync 
Manager dialog box as well as some basic information about synchronization, 
such as data source and connect string. You can set the logging level for this file 
using the SyncLogReportingLevel parameter in the setup.ini file.

For Direct Server Sync deployments, the file is located in the \Program 
Files\Siebel Handheld directory on the handheld client. For Companion Sync 
deployments, the file is located in the Siebel Root\client\log on the companion 
PC.

Logging Handheld Synchronization Errors
Siebel Handheld Sync logs all the strings that the user sees in the sync message 
window as well as many informational messages that do not get displayed in the 
UI. These informational messages are used to help track down where an error 
occurred. Siebel Handheld Sync determines which messages get logged based on a 
value stored in the registry under the key SyncLogReportingLevel. The values range 
from 0 to 4; 0 logs all error messages and strings that the user sees, and 4 logs all 
data that Siebel Handheld Sync sends and receives.
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SQLTrace
If Siebel Handheld Sync fails for some reason, check the syncmanager_log.txt file 
immediately after the failure. If you need more detail, increase the logging level and 
run Siebel Handheld Sync again. Use the LoggingLevels parameter in the setup.ini 
file to change the logging level. Furthermore, each time a user synchronizes, the 
syncmanager_log.txt file is overwritten with the new data.

SQLTrace
Use SQLTrace for diagnostic purposes if you encounter serious configuration errors 
or performance problems and cannot otherwise diagnose the problem. The problem 
may quickly become apparent in the log entries from SQL tracing.

To enable SQL tracing, set the EnableSqlTrace parameter in the .cfg file. By default, 
EnableSqlTrace=FALSE, and SQL tracing is disabled. Set EnableSqlTrace=TRUE to 
enable tracing. Log entries are written to the hhsync.*.log server log file.

NOTE: SQL tracing only logs SQL statements for one user at time. SqlTrace is applied 
to the first user who synchronizes after tracing is enabled.

CAUTION: When SQL tracing is enabled, synchronization is severely and adversely 
affected. Therefore, it is recommended that you turn SQL tracing on for a limited 
time to diagnose a specific problem, then turn SQL tracing off.

End User Error Messages
End users may encounter error messages when they synchronize their data. For 
more information on these messages, see “Troubleshooting” on page 163.
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Web Server Timeout Errors
If synchronization times are long due to the size of the database file or the speed of 
the network connection, your end users may encounter Web server timeout errors 
and synchronization failures. First try to resolve this problem by reducing the size 
of your extract and configuring your server performance. If after doing this, your 
end users continue to experience timeout errors, then increase the timeout 
parameter on IIS for the default Web Server.

Follow the procedure for your platform to change the timeout parameter.

To change the timeout parameter on Windows 2000 

1 From the Start menu, select Programs > Administrative Tools > Internet 
Services Manager.

2 From the Internet Information Services window, select the local machine, right-
click on the Default Web Site, and select Properties from the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.

4 Under the Connections heading, locate the Connection Timeout property and 
increase the number of seconds.

5 Click OK.

To change the timeout parameter on Windows NT

1 From the Start menu, select Programs > Windows NT 4.0 Option Pack > 
Microsoft Personal Web Server >Internet Service Manager. 

2 Under Internet Information Server, right-click on the Default Web Site and select 
Properties from the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.

4 Under the Connections heading, locate the Connection Timeout property and 
increase the number of seconds.

5 Click OK.
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Performance
This section discusses ways you can optimize your client performance, server 
performance, and network performance.

Client Performance
Client performance is affected primarily by the device capability (minimum 206 
MHz processor and 64 MB RAM), configuration, and the quantity of data loaded 
onto the device. In general, screen-to-screen and view-to-view navigation times of 
3 to 4 seconds or less should be considered normal. 

It is strongly recommended that customers follow these general guidelines to 
optimize the performance of their handheld applications:

■ Keep configuration under 30 views.

■ Keep RML file size under 1.75 MB.

■ Keep database files (dbfile.txt) under 2 MB. 

Use filters as outlined in the Siebel 2000 Handheld Synchronization Technical 
Note.

■ Keep the number of records for each business component under 2,500.

■ Avoid installing other applications on the device at the same time.

■ Users should synchronize their data frequently.

Additional configuration information can be found in the Siebel Technical Note 405, 
Siebel Handheld Synchronization.

The Professional Services Mobile eBusiness Competency group has a Siebel 
Handheld Quickstart program that is mandatory for all new Siebel Handheld 
customers to assess their configuration and deployment.

The Siebel Handheld client will benefit from periodic closing and restarting the 
application to release memory consumed by the handheld operating system. Use 
File > Exit in the menu to exit from the Siebel Handheld application.
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If an external VGA driver is or has been loaded on the device in the past and is no 
longer needed, be sure to unload it, because it is known to have significant 
performance impacts on handheld devices.

Server Performance
Server performance affects the performance and scalability of Direct Server Sync 
processes. Customers should engage Expert Services to do a Scalability Review. The 
following guidelines are general in nature and pertain to the Siebel Handheld sync 
components running on a Siebel Server:

■ Use Performance Monitor to track memory and processor performance on the 
Siebel server.

■ Make sure that the Servers (IIS, GW, OM and DB) are on the same high speed 
LAN segment.

■ Siebel Handheld Sync components will stress Siebel Server and database 
performance because of the intensive interactions during large concurrent 
synchronizations.

■ Estimate that 64 MB is used per Siebmtsh.exe instance.

■ To calculate the theoretical maximum concurrent users:

■ Numusers=Server_Memory*threads_per_process_ratio/64 MB.

■ Optimize the Threads per Process Ratio (Max Tasks/Max MT Servers) per 
Technical Note 405, Siebel Handheld Synchronization. 

■ Set Max Tasks=Max. number of concurrent users (for example, 150).

■ Set MinMTServers=MaxMTServers (for example, 30 for 5:1 ratio, if this is 
determined to be appropriate).

To optimize and tune a Siebel DB server:

■ Use Performance Monitor to track memory and processor performance on the 
DB server.

■ Turn on SQL tracing and search for long-running SQL calls.

■ Estimate 64 MB of RAM for each concurrent user.
238 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Troubleshooting

Performance
■ Consider creating indexes to tune the queries (only performed with the 
assistance of Siebel Expert Services).

■ Consider using a RAID 0+1 disk array with an expanded number of spindles to 
optimize database performance.

NOTE: Make sure that DB Server settings are set to recommended values. Timeouts 
should be set at the Siebel Server. Be careful that the timeout is set longer than the 
longest SQL query.

Network Performance
The condition of the network affects Direct Server Sync performance and scalability. 
In general, a low-latency, high-bandwidth network is preferred with dedicated 
rather than shared network connections. The following are general network 
considerations:

■ Make sure there is adequate bandwidth throughout the entire round-trip of 
network packets and estimate where bottlenecks will occur due to high 
concurrent load. For example, if 50 users are concurrently synchronizing 1 MB 
each, 50 MB of data must pass through the network. If this data is passing 
through a single leased 56 KB per second line, then this data will minimally take 
500,000 KB/56 KB/sec=8928 seconds=148 minutes. In reality, a 56 KB per 
second line will offer only 30-40 KB per second average throughput, which 
causes further bandwidth constraints. Check the total available bandwidth of 
network providers (private or public ISP).

■ Verify that you have low latency lines with ping round trips of less than 1 second 
(1000 ms) with no dropped packets.

■ Verify if roundtrips occur with less than 10 hops.

■ Check the actual throughput of network connections by performing simple file 
transfers with no Siebel software.

■ Nonvalidated VPN software from third parties accounts for 30 to 60 percent of 
additional packet overhead because of the encryption.
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Siebel Services
Network problems can usually be resolved by working with network providers to 
size network connections and optimize network routing. Consider the use of burst 
networks, quality of service contracts, private networks, and dedicated modem 
banks directly into a high-speed LAN environment. Noisy phone lines in some 
countries may benefit from the use of an external modem card from Xircom or 
Pretec instead of the built-in modem on the HP Jornada 720.

Siebel Services
You may wish to consult experts who have experience designing and configuring 
handheld applications, and who are knowledgeable about optimizing the 
performance of the applications.

Siebel Professional Services
To make deployment planning and implementation successful, Siebel Handheld 
customers are encouraged to engage the Siebel Mobile eBusiness Competency 
group. The Siebel Professional Services team has developed a Siebel Handheld 
Quickstart solution which defines the strategy, approach, and roadmap for 
successful Siebel Handheld deployments. Working directly with experienced 
handheld experts from the Mobile eBusiness Competency, customers can develop a 
complete deployment strategy, approach, and roadmap to facilitate their handheld 
implementation in a short time period.

Siebel Expert Services
All Siebel Systems customers should work with Siebel Expert Services to conduct 
detailed configuration and hardware sizing reviews. This helps customers make 
sure they have implemented the most effective and efficient solutions possible. 
Siebel Handheld customers benefit by making sure Siebel Handheld applications are 
configured according to best practices and that server environments are properly 
designed.
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Siebel Handheld Client supports a subset of the screens and views supported by the 
Siebel Web Client application. Other screens and views can be configured for your 
Siebel Handheld Client application if they are based on currently supported classes. 
Application developers and application administrators will find the information in 
this appendix useful.

If you configure screens and views based on unsupported classes, you may see 
anomalous results. For information on how to determine the classes used by other 
screens and views, see Object Types Reference.

Screens and Views
The screens and views shipped with the Siebel ePharma Handheld sample 
application are shown in Table 30.

Table 30. Siebel ePharma Handheld Screens and Views

Screen View Name on UI

Contacts My Contacts

Contacts More Info

Contacts Private Notes

Contacts Shared Notes

Contacts License Numbers

Contacts Activities

Contacts Calls

Contacts Affiliations
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Screens and Views
Contacts Best Time to Call

Contacts Addresses

Contacts Rx Data

Accounts My Accounts

Accounts Shared Notes

Accounts More Info

Accounts Private Notes

Accounts Activities

Accounts Best Times to Call

Accounts Addresses

Accounts Calls

Accounts Affiliations

Accounts Sales Data

Activities My Activities

Activities More Info

Calendar Daily

Calendar Weekly

Calendar Monthly

Calendar Contact Participants

Calendar Employee Participants

Calendar Add/Modify Activity (note: not displayed from the drop-down 
menu)

Contact Call Details

Contact Call Promotional Items

Table 30. Siebel ePharma Handheld Screens and Views

Screen View Name on UI
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Screens and Views
Contact Call Issues

Contact Call Samples Dropped

Account Call Details

Account Call Attendee

Home Page Home Page

Personal Lists Details

Personal Lists Promotional Items

Personal Lists Samples

Med Ed My Med Ed Events

Med Ed Invitees

Expense Reports My Expense Reports

Expense Reports More Info

Expense Reports Expense Items

Samples Samples History

Samples Inventory List

Samples Adjustments Inventory Count

Samples Adjustments Adjustments

Samples Adjustments Adj. Details

Samples Receipts Receipts

Samples Receipts Receipt Details

Samples Transfers Transfers

Samples Transfers Transfer Details

Samples Orders Orders

Samples Orders Order Details

Table 30. Siebel ePharma Handheld Screens and Views

Screen View Name on UI
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Siebel Handheld Client supports a subset of the business components and classes 
supported by the Siebel Web Client application. This appendix lists the supported 
business components, business component classes, and applet classes.

Business Components
Table 31 lists the supported Business Components for Siebel ePharma Handheld.

Table 31. Siebel ePharma Handheld Business Components

Supported Business Components

Account

Account Contact Affiliation

Account Note

Account Private Note

Action

Action Contact

Action Employee

Admin SEA Field

CSLS Contact Best Times - CE

CUT Address - CE

CUT Address for Account/Contact

CUT Address Inter Table - CE

Com Organization
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Business Components
Contact

Contact Account Affiliation

Contact (All)

Currency

Database Version

Decision Issue

Employee

Employee (MM)

Expense

Expense Item

Expense Item Type

Internal Division

Internal Product

LS Product Indiction

Language Def

List of Values

List of Values Child

List of Values Dynamic

Opportunity

Order Entry - Order Types

Order Entry - Orders

Period

Pharma Account Call - CE

Pharma Address Inter Table - CE

Table 31. Siebel ePharma Handheld Business Components

Supported Business Components
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Business Components
Pharma Area

Pharma Call Decision Issue

Pharma Call Decision Issue - CE

Pharma Call Products Detailed

Pharma Call Products Detailed - CE

Pharma Call Sample Dropped - CE

Pharma Call Signature

Pharma GA Markets

Pharma GA Rx Consumption

Pharma Internal Product

Pharma Inventory Period

Pharma Inventory Period - CE

Pharma ME Event

Pharma ME Event Professional Invitee Inter Table

Pharma Personal Inventory - CE

Pharma Personal Products - CE

Pharma Personal Promotional Items - CE

Pharma Personal Samples - CE

Pharma Product Issue

Pharma Professional Addresses - CE

Pharma Professional Call - CE

Pharma Professional Note

Pharma Professional Position

Pharma Professional Primary Specialty

Table 31. Siebel ePharma Handheld Business Components

Supported Business Components
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Business Components
Pharma Professional Private Note

Pharma Professional State Licenses

Pharma Professional Items Dropped - CE

Pharma Sales Consumption

Pharma Sample And Promo Order

Pharma Sample And Promo Order Item

Pharma Sample Order And Adjustment

Pharma Sample Order And Adjustment Item

Pharma Sample Stocked Lots

Pharma Sample Stocked Products

Pharma Sample Transaction History Item - CE

Pharma Samples

Pharma Signature Disclaimer

Pharma Template Call

Picklist Generic

Picklist Hierarchical

Position

Price List

Query List

Retail Outlet Best Call Time

SIS HH Contact Activity

Shift

Shift Exception

System Preferences

Table 31. Siebel ePharma Handheld Business Components

Supported Business Components
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Business Components
Time Expense Map

Time Zone

Table 31. Siebel ePharma Handheld Business Components

Supported Business Components
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Business Component Classes
Table 32 lists the supported Business Component classes for Siebel ePharma 
Handheld.

Table 32. Siebel ePharma Handheld Business Component Classes

Supported Business Component Classes

CSSBCAccountSIS CSSBCPosition

CSSBCAutoProduct CSSBCPriceList

CSSBCBase CSSBCProdRev

CSSBCBSampleLot CSSBCProductDetailed

CSSBCContactSIS CSSBCPromoItemsDropped

CSSBCDivision CSSBCSample

CSSBCDocInvoice CSSBCSampleDropped

CSSBCExpitm CSSBCSampleInventory

CSSBCExprpt CSSBCStateModel

CSSBCFINOppty CSSBCStateModelState

CSSBCFINSActivity CSSBCStateTransition

CSSBCHHInventoryPeriod CSSBCUser

CSSBCHHPharmaCall CSSBusComp

CSSBCHHSample CSSCommandShell

CSSBCHHSampleItem CSSExpenseAutoGenService

CSSBCInventoryPeriod CSSOMAlarmMgr

CSSBCLineItem CSSPreferencesService

CSSBCPeriod CSSQueryExporter

CSSBCPharmaAddress CSSSIABCOrder

CSSBCPharmaCall CSSSISOMPricerService
250 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Business Components and Classes

Applet Classes
Applet Classes
You may create additional screens and views for your handheld application. Any 
new screens and views must be based on classes and business components that are 
supported for the ePharma Handheld application. Refer to Table 33 for the 
supported applet classes.

CSSBCPharmaCallComponent CSSSMCacheService

CSSBCPharmaDisclaimer CSSTimeSheetAutoGenService

CSSBCPharmaSign

Table 32. Siebel ePharma Handheld Business Component Classes

Supported Business Component Classes

Table 33. Siebel ePharma Handheld Applet Classes

Applet Classes

CSSDurationFrameList

CSSFrame

CSSFrameAcctCall

CSSFrameBase

CSSFrameCECalAddModify

CSSFrameCEGridDay

CSSFrameCEGridMonth

CSSFrameCEGridWeek

CSSFrameCEHome

CSSFrameCEMultPart

CSSFrameList
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Siebel ePharma Handheld Objects That Should Not Be 
Modified

Refer to Siebel Tools Reference for guidelines on modifying existing objects. 

CSSFrameListBase

CSSFrameListExpitm

CSSFrameListPharmaActivity

CSSFrameListSample

CSSFrameListSampleItem

CSSFrameNewCall

CSSFramePopupCurrency

CSSFrameProfCall

CSSFrameSISAction

CSSFrameSample

CSSSWEFrameListPick

CSSSWEFrameListTargetAssoc

CSSSWEFrameListVisibilityAssoc

CSSSWEFrameListVisibilityPick

CSSSubmitFrame

Table 33. Siebel ePharma Handheld Applet Classes

Applet Classes
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Siebel ePharma Handheld Objects That Should Not Be Modified
There are certain objects in the Siebel ePharma Handheld Client which should not 
be changed. Table 34 lists these objects.

CAUTION: If these objects are changed, the behavior of the Siebel ePharma Handheld 
application cannot be predicted.

Table 34. Siebel ePharma Objects that Should Not Be Modified

Type of Object Objects

Business Objects Action - Account - CE

Action - Asset - CE

Action - Contact - CE

Action - Internal Product - CE

Action - Service Request - CE

Asset - Contact - CE

Asset - FS Inventory Location - CE

FS Activity Rec Parts & Tools - Order - CE

FS InvLoc Product - Internal Product - CE

FS Part Browser - FS Inventory Location - CE

Line Items - Action - CE

Business Objects (continued) Line Items - Internal Product - CE

Order - Asset - CE

Order - Service Request - CE

Service Request - Account - CE

Service Request - Asset - CE

Service Request - Contact - CE

Service Request - Internal Product - CE
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Business Components Action - CE

Service Request - CE

Hidden Picklists BusComp - CE

Table 34. Siebel ePharma Objects that Should Not Be Modified

Type of Object Objects
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This appendix documents the handheld-specific user properties and methods for 
the Siebel Handheld application.

Global User Properties

The following user properties apply to all business components.

Table 35. User Properties

Name Description

HandheldSyncPickMode User property on a field of a business component. 
When set to NoFail, turns Extended Pick processing 
ON. See “Extended Pick Processing” on page 119 for 
more information.

HandheldSyncInsertMode User property on a business component. When set to 
FailOnError, enables Extended Insert processing. See 
“Extended Insert Processing” on page 124 for more 
information.
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Global User Properties
CUT Address – CE Business Component

Pharma Account Call – CE Business Component
*

Table 36. User Properties for CUT Address – CE Business Component

CUT Address – CE Business Component

User Property Value Description

Propagate Address 
BC Fields

City,Postal 
Code,State,Street,Addre
ss,Country

Specifies the fields that must be updated 
in the S_ADDR_PER table that are 
propagated to the inter table. Fields are 
separated by commas.

Propagate Address 
Fields To Parent BC

City|City CE, Postal 
Code|Postal Code CE, 
State|State CE,Street 
Address|Street Address 
CE, Country|Country 
CE

Specifies the source and destination fields 
that are propagated to the parent 
business component. Source and 
destination fields are separated by a 
vertical bar (|) and the pairs of fields are 
separated by commas.

In the example City|City CE, “City” is the 
source field and “City CE” is the 
destination field.

Table 37. User Properties for Pharma Account Call – CE Business Component

Pharma Account Call – CE Business Component

User Property Value Default Value Description

Cascading 
Fields

,Field name, ,Start Date,Start Time,Account 
Id,Address,Account Address 
Id, Account State,Duration 
Minutes,Brick Id,

Specifies fields that must be cascaded 
to the attendee call. These fields have 
to be made force active in the child 
business component. 

Use field names as defined in Siebel 
Tools. Add a comma to the beginning 
and end of the field name.

Must Detail 
Products

Y or N Y Specifies whether a product must be 
detailed or not before the call can be 
submitted.
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OnlySubmitByP
osition

Y or N Y Specifies whether the position that 
entered the record is the only position 
that can submit the call.

Read Only If 
Status 
Synchronized

Y or N N Specifies whether the record is Read 
Only if the call status is 
“Synchronized.”

SubCall 
Component CE

,Business 
Component 
Name,

Pharma Professional Call - CE Child business component to which 
the changes are cascaded. Use business 
component names as defined in Siebel 
Tools.

Template 
Components

,Business 
Component 
Name,

Pharma Call Products Detailed 
- CE

Specifies the business components that 
need to be copied from the call 
template when a smart call is applied 
to a call. Use business component 
names as defined in Siebel Tools.

Update After 
Submit

,Field name, ,Comment, Specifies fields that are editable after 
the call is submitted. Use field names 
as defined in Siebel Tools. Add a 
comma to the beginning and end of the 
field name.

Update Status 
To 
Synchronized

Y or N Y Specifies whether the status of calls 
downloaded to the handheld is 
updated to “Synchronized.” When the 
status is “Synchronized,” the calls are 
read-only on the server

Table 37. User Properties for Pharma Account Call – CE Business Component

Pharma Account Call – CE Business Component

User Property Value Default Value Description
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Pharma Address Business Component

Pharma Professional Call – CE Business Component

Table 38. User Properties for Pharma Address Business Component

Pharma Address Business Component

User Property Value Description

Propagate Address 
BC Fields

City,Postal 
Code,State,Street 
Address, Country

Specifies the fields that must be updated 
in the S_ADDR_PER table that are 
propagated to the inter table. Fields are 
separated by commas.

Propagate Address 
Fields To Parent BC

City|City, Postal 
Code|Postal Code, 
State|State,Street 
Address|Street 
Address, 
Country|Country 

Specifies the source and destination fields 
that are propagated to the parent business 
component. 

Update Inter Table 
BC Fields

DEA#,DEA Expr Specifies list of fields that must be updated 
in the inter table (S_CON_ADDR).

Table 39. User Properties for Pharma Professional Call – CE Business Component

Pharma Professional Call – CE Business Component

User Property Value Default Value Description

Attendee Call 
Read Only

,Field name, ,Start Date,Start Time,Call 
Status,Sub 
Type,Address,Duration 
Minutes,Last Name, (default)

Specifies read-only fields when the call 
is an attendee call. Use the field names 
as they are defined in Siebel Tools. Add 
a comma to the beginning and end of 
the field name.

Electronic 
Signature Read 
Only

,Field name, ,Last Name,Address,Chosen 
Template,Start 
Date,CallStatus,Paper 
Signature,

Specifies fields that are read-only after 
a signature is taken. Use the field 
names as they are defined in Siebel 
Tools. Add a comma to the beginning 
and end of the field name.
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Must Detail 
Products

Y or N N Specifies whether a product must be 
detailed before the call is submitted.

OnlySubmitByP
osition

Y or N Y Specifies whether the position that 
entered the record is the only position 
that can submit the call. 

Paper Reference 
Number 
Required

Y or N Y Specifies whether the reference 
number is required or not in order to 
submit a call with a paper signature.

Paper Signature 
Read Only

,Field name, ,Call Status,Signature 
Captured,

Specifies fields that are read-only when 
Paper Signature is true. Use the field 
names as they are defined in Siebel 
Tools. Add a comma to the beginning 
and end of the field name.

Read Only If 
Status 
Synchronized

Y or N N Specifies whether the record is Read 
Only if the call status is 
“Synchronized.”

SRE 
Professional 
Types

Professional 
Type

No default Specifies a list of professions. Add a 
comma to the beginning and end of the 
professional type. An example would 
be: ,Physician,Central Lab Technician,

SRE Reference 
Number 
Required

Y or N N Specifies whether a reference number 
is required before the call can be 
submitted.

Sample 
Disbursed 
Required

Y or N N Specifies whether samples must be 
dropped when the call is submitted.

Template 
Components

,Business 
Component 
Name,

Pharma Call Products 
Detailed - CE,Pharma Call 
Sample Dropped - CE

Specifies the business components that 
need to be copied from the call 
template when a smart call is applied 
to a call. Use business component 
names as defined in Siebel Tools.

Table 39. User Properties for Pharma Professional Call – CE Business Component

Pharma Professional Call – CE Business Component

User Property Value Default Value Description
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Update After 
Recreate 
Receipt

,Field name, ,Last Name,Address,Start 
Date,Comment,Signature 
Captured,

Specifies fields that are editable when 
Recreate Receipt is selected. Use field 
names as defined in Siebel Tools. Add a 
comma to the beginning and end of the 
field name.

Update After 
Submit

,Field name, ,Comment, Specifies fields that are editable after 
the call is submitted. Use field names 
as defined in Siebel Tools. Add a 
comma to the beginning and end of the 
field name.

Update Status 
To 
Synchronized

Y or N Y Specifies whether the status of calls 
downloaded to the handheld is 
updated to “Synchronized.” When the 
status is “Synchronized,” the calls are 
read-only on the server

Validate DEA 
Number

Y or N Y Specifies whether the DEA Number 
must be validated before the user can 
sign and submit the call.

Validate DEA 
Number 
Expiration

Y or N Y Specifies whether DEA Expiration Date 
must be validated before the user can 
sign and submit the call.

Validate 
License 
Number

Y or N Y Specifies whether License Number 
must be validated before the user can 
sign and submit the call.

Validate 
License 
Number 
Expiration

Y or N Y Specifies whether License Number 
Expiration must be validated before the 
user can sign and submit the call.

Validate 
License 
Number Status

Y or N Y Specifies whether License Number 
Status must be validated before the 
user can sign and submit the call.

Validate OK to 
Sample

Y or N Y Specifies whether it is OK to drop a 
sample to a contact the call.

Table 39. User Properties for Pharma Professional Call – CE Business Component

Pharma Professional Call – CE Business Component

User Property Value Default Value Description
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Pharma Address Inter Table – CE Business Component

Validate 
Professional 
Profile

Y or N Y

Validate Sign 
Lot Number

Y or N Y Specifies whether Lot Number is 
required before the user can sign.

Validate Submit 
Lot Number

Y or N Y Specifies whether Lot Number is 
required before the user can submit the 
call.

Table 39. User Properties for Pharma Professional Call – CE Business Component

Pharma Professional Call – CE Business Component

User Property Value Default Value Description

Table 40. User Properties for Pharma Address Inter Table – CE Business Component

Pharma Address Inter Table – CE Business Component

User Property Value Default Value Description

Validate DEA Number Y or N Y Specifies whether the DEA 
number must be validated. An 
example of a valid DEA number is: 
AA1234563.
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Global User Properties
Pharma Call Decision Issue – CE Business Component

Pharma Call Products Detailed – CE Business Component

Table 41. User Properties for Pharma Call Decision Issue – CE Business Component

Pharma Call Decision Issue – CE Business Component

User Property Value Default Value Description

Template Fields ,Field name, Name Specifies the fields that need to be 
copied from the call template 
when a smart call is applied. Use 
field names as defined in Siebel 
Tools. Add a comma to the 
beginning and end of the field 
name.

Table 42. User Properties for Pharma Call Products Detailed – CE Business Component

Pharma Call Products Detailed – CE Business Component

User Property Value Default Value Description

Max Auto 
Generated 
Priority

number 3 Maximum number of priorities that are 
automatically generated.

Skip Conflict 
Resolution for 
Duplicate 
Records

Y or N Y Specifies the behavior of Object 
Manager when it encounters a 
duplicate record during 
synchronization. If Y, the Object 
Manager drops the record from the 
handheld client and keeps the record 
on the server. 

Template Fields ,Field name, Name,Priority,Indication Specifies the fields that are copied from 
the call template when a smart call is 
applied. Use field names as defined in 
Siebel Tools. Add a comma to the 
beginning and end of the field name.
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Pharma Inventory Period – CE Business Component

Pharma Call Sample Dropped – CE Business Component

Table 43. Pharma Inventory Period – CE Business Component

Pharma Inventory Period – CE Business Component

User Property Value Default Value Description

Maximum 
Periods

Number 2 Specifies the number of 
unreconciled periods, including 
the active period.

Table 44. User Properties for Pharma Call Sample Dropped – CE Business Component

Pharma Call Sample Dropped – CE Business Component

User Property Value Default Value Description

Signature Body 
Text Field: 1

Field name Quantity Field name that must appear in 
the signature body text.

Signature Body 
Text Field: 2

Field name Name Field name that must appear in 
the signature body text.

Signature Body 
Text Field: 3

Field name Vendor Name Field name that must appear in 
the signature body text.

Skip Conflict 
Resolution

Y or N Y Specifies the behavior of Object 
Manager when it encounters a 
duplicate record during 
synchronization. If Y, the Object 
Manager drops the record from the 
handheld client and keeps the 
record on the server.

Template Fields ,Field name, ,Name,Lot Name,Quantity, Specifies the fields that need to be 
copied from the call template 
when a smart call is applied. Use 
field names as defined in Siebel 
Tools. Add a comma to the 
beginning and end of the field 
name.
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Global User Properties
Pharma Promotional Items Dropped

Table 45. User Properties for Pharma Promotional Items Dropped – CE 

Pharma Promotional Items Dropped – CE Business Component

User Property Value Default Value Description

Template Fields ,Field name, ,Name,Quantity, Specifies the fields that need to be 
copied from the call template 
when a smart call is applied. Use 
field names as defined in Siebel 
Tools. Add a comma to the 
beginning and end of the field 
name.
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This chapter describes the print tagging language that is used to create print 
templates for your handheld device.

The audience for this appendix is Siebel application developers.

Overview
You can create the print template file in any text editor.

■ Tags are enclosed in angle brackets and identified with the keyword TAG, 
followed by a colon.

For example: <TAG: ....>

■ Parameters are specified with a keyword, followed by an equals sign. Arguments 
are in uppercase, surrounded by quotation marks.

For example, Font = "FONT FACE"

■ Values are in uppercase and lowercase, surrounded by quotation marks. 

For example: Font = "Helvetica"

■ Tags may appear in any order in the file. The only required tag is the Title tag.

■ Variables within a print template must be uniquely named. Variable names must 
be one-word strings and spaces are not allowed.

The following tags are used to specify the format of the print output, which applets 
are included, and the query that is executed:

■ Applet—Specifies which applets are used in the document.

■ Comment—Adds comments that do not appear in the final document.
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■ Divider—Adds visual lines to visually separate different parts of the document.

■ Footer—Adds information such as page numbers, date, and time.

■ Format—Specifies characteristics such as font, boldface, italics, and underline.

■ Header—Adds information such as page numbers, date, and time.

■ Page Break—Specifies a break in the text, forcing the text that follows to appear 
on the next page.

■ Picture—Adds graphic images to the document.

■ Title—Specifies a name for the template that appears in the print job list.

In addition, you may add static text in the print template.

The following print tags allow you to calculate additional information and add it to 
your reports:

■ GetTotal—Calculates the total for a column of data

■ GetField—Gets the value of a field

■ GetCount—Calculates the number of records

You can also calculate dates and times using the GetDate and GetTime tags, and you 
can retrieve the value of the registry using GetRegistry.

All of this information is stored in variables that you specify. In addition, you can 
assign any value to a variable using the SetVariable tag. You can present this 
information in your report using the Cell and EndofLine tags to create tables of 
information. See “Using Variables in Print Templates” on page 291 for an example 
of how variables can be used to present information in print templates.
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Applet

Description Specifies the applet to be printed.

Usage Any data that appears in your document must be generated from the applets in the 
view. Therefore, you must create applets that will produce the data required for your 
document.

Use the Applet tag to specify any number of list or form applets within the template 
and to locate the applet in your document. In the form view, a maximum of two 
fields per row are supported.

Syntax <TAG:Applet Name="APPLET NAME" Query="QUERY STRING" 
Caption="CAPTION" Headerdivider="HEADERDIVIDER" 
Recorddivider="RECORDDIVIDER" Wrap="WRAP">

Parameter Description

TAG:Applet (Required) Applet tag indicator.

APPLET NAME (Required) Applet name as defined in Siebel Tools.

QUERY STRING (Optional) Specifies the query string directly set to the business 
component supporting the document.

If the query string is not specified, the currently active query string 
in the view is applied to expose the relevant records.

CAPTION (Optional) Specifies whether the captions in the form applets are 
suppressed.

Valid values are TRUE (default) and FALSE. This parameter does not 
apply to list applets. Column headings in list applets are always 
enabled.

HEADERDIVIDER (Optional) Specifies whether a divider is printed below the column 
heading in list applets.

Valid values are TRUE and FALSE (default). This parameter does not 
apply to form applets.
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Overview
Example <TAG:Applet Name="Order List" Headerdivider="TRUE">

RECORDDIVIDER (Optional) Specifies whether a horizontal divider is printed between 
records in list applets.

Valid values are TRUE and FALSE (default). This parameter does not 
apply to form applets.

WRAP (Optional) Specifies whether text field values are word wrapped. 

Valid values are TRUE and FALSE (default). This parameter does not 
apply to numeric fields.

Parameter Description
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Cell

Description Prints the string stored in STRING or VARIABLE NAME at the specified location on 
the current line.

Usage Use the Cell tag to create cells of data in a row in a table. Use it with the EndOfLine 
tag. If the data exceeds the width of the cell specified by Startat and Endat, it wraps 
to the next line.

Syntax <TAG:Cell Startat="START" Endat="END" Name="STRING" 
Variable="VARIABLE NAME" Align=ALIGNMENT"

Parameter Description

TAG:Cell (Required) Required tag indicator.

START (Required) Specifies the starting point of the cell, expressed as 
a percentage of the printable page width. For example, if 
START =10, then the cell starts at the point that is 10% from the 
left edge of the printable width.

END (Required) Specifies the end point of the cell, expressed as a 
percentage of the printable page width. For example, if 
END=50, then the cell ends at the point that is 50% from the 
left edge of the printable width.

STRING (Optional) String value. If Variable is not specified, then String 
is a required parameter. 

VARIABLE NAME (Optional) Name of variable where the value is stored. If String 
is not specified, then Variable is a required parameter.

ALIGNMENT (Optional) Specifies the alignment of the string.

Valid values are LEFT (default), CENTER, and RIGHT.
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Example <TAG:Divider Weight="3" Startat="20" Endat="80">
<TAG:Cell Startat="0" Endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Defective:" 
Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveTotal" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodTotal" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Defective Count:" 
Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveCount" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Good Count:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodCount" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv3reg">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv5str">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="30" Variable="vvv4date">
<TAG:Cell Startat="30" Endat="70" Variable="vvv4longdate">
<TAG:Cell Startat="70" Endat="100" Variable="vvv8time">
<TAG:EndOfLine>
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Comment

Description Adds code comments to the print template.

Usage Use to add explanatory notes or documentation to explain and maintain the print 
template. Comment tags are ignored during printing and do not appear in the 
printed document.

Syntax <REM: COMMENT>

Example <REM: Quotation Print Template. This template includes four applets.>

Parameter Description

REM (Required) Comment tag indicator.

COMMENT (Optional) Comment text.
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Divider

Description Renders a horizontal line across the width of the page.

Usage Use to visually separate the different sections of your document. The Divider tag 
can be used between other tags; therefore, you may add a line between two applets. 
However, you cannot embed a Divider within an applet.

Syntax <TAG:Divider Weight="WEIGHT" Startat="START" Endat="END">\

Example <TAG:Divider Weight="2" Startat="20" Endat="80">

Parameter Description

TAG:Divider (Required) Divider tag indicator.

WEIGHT (Optional) Specifies line thickness.

Valid values are 1–5. The default value is 1, which produces a 
line 0.2 mm wide. Increasing the value by 1 increases the width 
by 0.2 mm. A 5 produces a line that is 1 mm wide.

START (Optional) Percentage that specifies the starting point of the line. 
The default is 0%, the farthest left point.

END (Optional) Percentage that specifies the end point of the line. 
The default is 100%, the farthest right point.
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EndOfLine

Description Specifies the end of a row and advances to the next line.

Usage Use to create rows of data in a table. Used with the Cell tag.

Syntax <TAG:EndOfLine>

Example <TAG:Cell Startat="0" Endat="50" Name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>
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Footer

Description Adds footer information such as page numbers, the current date, and the current 
time.

Usage You may, for example, always want the text “Thank you for your business!” to 
appear on the bottom of your receipts. If so, you may include this text in a Footer 
tag.

The Footer tag may be specified anywhere in the template file; however, it will 
always appear at the very bottom of your document. Only one Footer tag is applied 
to the document. If you have multiple Footer tags in the file, only the last Footer tag 
is used; any other Footer tags are ignored.

If you include a Footer tag in your template, then you must set the BottomMargin 
in setup.ini to a minimum of 20.

The footer has three sections, Left, Center, and Right, which are used to position the 
information in the footer.

The text in the footer is formatted in 10 point, Helvetica font. If Helvetica is not 
available on your system, the default font is used. You cannot customize text 
formatting of the Footer tag. The Format tag does not affect the formatting of the 
footer.

Syntax <TAG:Footer Left="DATA" Center="DATA" Right="DATA">

Parameter Description

TAG:Footer (Required) Footer tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing
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Example <TAG:Footer Left="<date>" Right="<page>"
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Format

Description Specifies the characteristics of the text—the typeface or font, whether the text is in 
boldface, italics, or underlined, and the text alignment.

Usage The font specification specifies the characteristics of all text that follows the tag 
until the next Format tag.

The text alignment tag (Align) behaves somewhat differently. When the applet is 
rendered, the field alignment specification takes precedence over the Align 
parameter.

Syntax <TAG:Format Face="FONT FACE" Size="FONT SIZE" Bold="BOLD" 
Italic="ITALIC" Underline="UNDERLINE" Align="TEXT ALIGNMENT">

Parameter Description

TAG:Format (Required) Format tag indicator.

FONT FACE (Required) Specifies the typeface of the text.

Any typeface installed on the handheld device may be specified. 
There is no default for this parameter.

FONT SIZE (Required) Specifies the text size.

Any installed font size for an installed typeface on the handheld 
device may be specified. There is no default for this parameter.

BOLD (Optional) Specifies whether the text is in bold.

Valid values are TRUE or FALSE (default). If TRUE, text is set to 
bold.

ITALIC (Optional) Specifies whether the text is in italic. 

Valid values are TRUE or FALSE (default). If TRUE, text is set to 
italic.
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Example <TAG:Format Face="Helvetica" Size="10">

UNDERLINE (Optional) Specifies whether the text is underlined.

Valid values are TRUE or FALSE (default). If TRUE, text is set to 
underline.

TEXT ALIGNMENT (Optional) Specifies the text alignment.

Valid values are LEFT (default), RIGHT, and CENTER.

Parameter Description
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GetCount

Description Calculates the number of records in the selected rows and assigns this value to a 
variable.

Usage Use GetCount to calculate the number of records and print this value in your report.

Syntax <TAG:GetCount Appletname="APPLET NAME" Query="QUERY STRING" 
Variable="VARIABLE NAME">

Example <TAG:GetCount Appletname="CS HH Product Bucket List Applet" 
Query="Status|Good" Variable="StatusGood">

Parameter Description

TAG:GetCount (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

QUERY STRING (Optional) Search specification for the rows to be included in 
the row set. If not specified, the current search specification is 
used.

The syntax for the query string is: Field Name|Query Statement. 
You may specify one or more query strings separated by a 
vertical bar (|).

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 
'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.
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GetDate

Description Gets the current date, offsets the date by the number of days specified in Dayoffset, 
and stores the result in a variable.

Usage Use GetDate to print a specific date in your report.

Syntax <TAG:GetDate Dayoffset="NUMBER OF DAYS" Variable="VARIABLE NAME" 
Logformat="DATE FORMAT">

Example <TAG:GetDate Longformat="TRUE" Variable="LongDate">

Parameter Description

TAG:GetDate (Required) Required tag indicator.

NUMBER OF DAYS (Optional) Number of days by which the current date is offset. 
For example, –100 subtracts 100 days from the current date; 100 
adds 100 days to the current date. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.

DATE FORMAT (Optional) TRUE prints the date in long date format (for 
example, Monday, February 11, 2002). FALSE prints the short 
date format (for example, 2/21/02). The default is FALSE.
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GetField

Description Gets the value of the specified column of the first row of selected rows and assigns 
the result to a variable.

Usage Use GetField to print a value without developing a print applet. Design the query 
and sort strings so that the desired record is the first record in the selected rows. 
GetField only allows you to get the value in the first record.

Syntax <TAG:GetField AppletName="APPLET NAME" Fieldname="FIELD NAME" 
Query="QUERY STRING" Sort="SORT STRING" Variable="VARIABLE NAME">

Example <TAG:GetField AppletName="CS HH Product Bucket List Applet" 
Fieldname="Quantity" Variable="ProdBucketListField">

Parameter Description

TAG:GetField (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

FIELD NAME (Required) Name of the field or column.

QUERY STRING (Optional) Search specification for the rows to be included in 
the total. If not specified, the current search specification is 
used.

SORT STRING (Optional) Sort specification. If not specified, the current sort 
specification is used.

The syntax is: Field Name [ASC][DESC]. The default is ASC 
(Ascending).

For example: Sort="Account DESC, Date". In the example, the 
Account field is sorted in descending order, then the date field 
is sorted in ascending order.

VARIABLE NAME (Required) Name of variable where the value is stored.
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GetRegistry

Description Gets a value in the registry for Siebel Handheld and assigns it to a variable.

Usage Use GetRegistry to print the contents of the registry key in your report.

Syntax <TAG:GetRegistry Name="REGISTRY NAME" Variable="VARIABLE NAME">

Example <TAG:GetRegistry Name="InstallDir" Variable="Registry">

Parameter Description

TAG:GetRegistry (Required) Required tag indicator.

REGISTRY NAME (Required) Value the registry.

VARIABLE NAME (Required) Name of variable where the value is stored.
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GetTime

Description Gets the current time, offsets the time by the number of seconds specified in 
Secondoffset, and assigns the result to a variable.

Usage Use GetTime to print a specific time in your report.

Syntax <TAG:GetTime Secondoffset="NUMBER OF SECONDS" Variable="VARIABLE 
NAME">

Example <TAG:GetTime Secondoffset="3600" Variable="Time">

Parameter Description

TAG:GetTime (Required) Required tag indicator.

NUMBER OF 
SECONDS

(Optional)Number of seconds by which the current time is 
offset. For example, –100 subtracts 100 seconds from the current 
time; 100 adds 100 seconds to the current time. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.
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GetTotal

Description Calculates the total for the specified column for all selected rows and assigns the 
value to a variable.

Usage Use GetTotal to calculate a column total and display the total in your report.

Syntax <TAG:GetTotal AppletName="APPLET NAME" FieldName="FIELD NAME" 
Query="QUERY STRING" Variable="VARIABLE NAME">

Example <TAG:GetTotal AppletName= "CS HH Product Bucket List Applet" 
Fieldname="Quantity" Variable="ProdBucketListTotal">

Parameter Description

TAG:GetTotal (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

FIELD NAME (Required) Name of the field or column. Specify a field or 
column with numeric data. If you specify a field with non-
numeric data, a 0 is assigned to the variable.

QUERY STRING (Optional) Search specification for the rows to be included in 
the total. If not specified, the current search specification is 
used.

The syntax for the query string is: Field Name|Query Statement. 
You may specify one or more query strings separated by a 
vertical bar (|). 

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 
'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.
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Description Adds header information such as page numbers, the current date, and the current 
time.

Usage You may always want the current date and time to appear on your invoices. If so, 
you may include this information in a Header tag.

The Header tag may be specified anywhere in the template file; however, it always 
appears at the very top of your document. Only one Header tag is applied to the 
document. If you have multiple Header tags in the file, only the last Header tag is 
used; any other Header tags are ignored.

If you include a Header tag in your template, then you must set TopMargin in 
setup.ini to a minimum of 20.

The header has three sections, Left, Center, and Right, which are used to position 
the information in the header. The Left parameter aligns the text with the left 
margin, and the Right parameter right aligns the text with the right margin. The 
Center parameter centers the text in the header.

The text in the header is formatted in 10 point, Helvetica font. If Helvetica is not 
available on your system, the default font is used. You cannot customize text 
formatting of the Header tag. The Format tag does not affect the format of the 
header. 

Syntax <TAG:Header Left="DATA" Center="DATA" Right="DATA"

Parameter Description

TAG:Header (Required) Header tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing
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Example <TAG:Header Center="Company Confidential">
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Page Break

Description Forces text that follows the tag to appear on the next page.

Usage Use this for multipage documents or forms.

Syntax <TAG:PageBreak>

Example <TAG:PageBreak>

Parameter Description

TAG:PageBreak (Required) Page break tag indicator.
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Description Specifies graphic files included in the print template.

Usage Use to add graphic images, such as a company logo, to your documents. 

The supported file formats are BMP and JPG. 

Graphics files are located in the \Program Files\Siebel Handheld\templates 
directory on the handheld device. Specify the full path name of the file for the Name 
parameter.

Scaling or graphics operations, such as inverse image, are not supported.

The Alignment and Position parameters are used together to place the graphic. 
Alignment specifies the left edge, the center, or the right edge of the graphic. 
Position is distance, specified in millimeters, from the left edge of the paper. 

■ If Alignment ="Left" and Position="30", then the left edge of the graphic is set 
30 millimeters from the left edge of the paper. 

■ If Alignment = "Center" and Position = "30", the center of the graphic is set 30 
millimeters from the left edge of the paper.

■ If Alignment = "Right" and Position = "30", the right edge of the graphic is set 
30 millimeters from the left edge of the paper.

If Position is not specified, it defaults to 0. Depending on the Alignment setting, the 
graphic is left-aligned (Alignment = "Left"), the graphic is right-aligned 
(Alignment = "Right"), or the graphic is centered (Alignment ="Center")

Syntax <TAG:Picture Name="FILE NAME" Alignment="ALIGNMENT" 
Position="POSITION">

Parameter Description

TAG:Picture (Required) Picture tag indicator.

FILE NAME (Required) Specifies the full path and name of the graphics file.
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Example <TAG:Picture Name="\Program Files\Siebel Handheld\templates\logo.bmp" 
Alignment="Right" Position="88">

ALIGNMENT (Optional) Specifies the left edge, the center, or the right edge of the 
graphic. Used with the Position parameter to specify the horizontal 
position of the graphic.

Valid values are LEFT (default), CENTER, and RIGHT.

POSITION (Optional) Specified in millimeters, it is the distance from the left edge of 
the paper. Used with the Alignment parameter to specify the horizontal 
position of the graphic. The default is 0.

Parameter Description
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SetVariable

Description Sets a value to a variable.

Usage Use SetVariable to assign a value to a variable. You can then print the value by 
specifying the variable in the Cell tag.

Syntax <TAG:SetVariable Name="VALUE" Variable="VARIABLE NAME>

Example <TAG:SetVariable="100" Variable="TotalQuantity">

Parameter Description

TAG:SetVariable (Required) Required tag indicator.

VALUE (Required) A value.

VARIABLE NAME (Required) Name of variable where the value is stored.
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Static Text
You may add static text anywhere in your template by using the current Format 
settings. The text goes across the entire page width. If it exceeds the width of the 
page, it wraps to the next line.

Example This quote is valid for 60 days from the date on this quotation.
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Title

Description Name used to identify the template.

Usage The Title tag is a required tag in your print template file. 

When you print your document, this title appears in the print job list. This title does 
not appear on the document that is printed. Use static text to add the document title 
to your template.

Syntax <TAG:Title Title="TITLE">

Example <TAG:Title Title="Quotation">

Print Template File Examples
The following is an example of a print template file.

Using Variables in Print Templates
The following example shows how to use variables in a print template.

<TAG:Title Title="Inventory Report">

<REM: **********Variable Assignment Examples**************>

<TAG:SetVariable name="THIS IS VARIABLE" variable="VarStr">
<TAG:GetRegistry name="InstallDir" variable="VarReg">
<TAG:GetDate dayoffset="10" variable="VarDate">
<TAG:GetDate longformat="TRUE" variable="VarLongDate">
<TAG:GetTime secondoffset="-3600" variable="VarTime">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" 

Parameter Description

TAG:Title (Required) Title tag indicator.

TITLE (Required) Title text. May be between 1–255 characters.
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fieldname="Quantity" variable="VarTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" 
fieldname="Quantity" query="Status|Good" variable="VarGoodTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" 
fieldname="Quantity" query="Status|Defective" 
variable="VarDefectiveTotal">
<TAG:GetField appletname="CS HH Product Bucket List Applet" 
fieldname="Quantity" variable="VarQuantityField">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" 
query="Status|Good" variable="VarGoodCount">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" 
query="Status|Defective" variable="VarDefectiveCount">

<REM: **********Variable Assignment Examples End************>

<REM: Inventory Print Template. This template includes 3 applets. 
The ENU template>

<TAG:Format Face="Helvetica" Size="16" Align="Center">
[Distributor Name
Street Address
City, Country Postal Code
Phone Number   Fax Number]

<TAG:Format Face="Helvetica" Size="20" Bold="TRUE" Align="Center">
Inventory Report
<TAG:Format Face="Helvetica" Size="8" >
<TAG:Applet Name="CS HH Inv Loc Print Applet" Caption="TRUE" 
Wrap="TRUE">
<TAG:Applet Name="CS HH Product Bucket List Applet" Line="FALSE" 
Headerdivider="TRUE" Recorddivider="FALSE" Wrap="TRUE">

<REM: *************Variable Usage Example***************>

<TAG:Divider Weight="3" startat="20" endat="80">
<TAG:Cell startat="0" endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarTotal" 
Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell startat="0" endat="50" name="TOTAL Defective:" 
Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveTotal" 
Align="RIGHT">
<TAG:EndOfLine>
292 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Print Tagging Language

Using Variables in Print Templates
<TAG:Cell startat="0" endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodTotal" 
Align="RIGHT"
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Defective Count:" 
Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveCount" 
Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Good Count:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodCount" 
Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarReg">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarStr">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="30" variable="VarDate">
<TAG:Cell startat="30" endat="70" variable="VarLongDate">
<TAG:Cell startat="70" endat="100" variable="VarTime">
<TAG:EndOfLine>

<REM: ***********Variable Usage Example End***************>

<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="LEFT">
Warehouse Signature
<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="RIGHT">

Rep Signature
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Print Configuration Settings F
You configure printing attributes in the setup.ini file. This appendix describes the 
printing parameters for Siebel application developers and application 
administrators.

Overview
The administrator sets up the default printer setting in the setup.ini file located in 
the setup directory.

There are a number of parameters to specify printing on the handheld. The 
parameters specify the following:

■ Printer attributes (printer model, port, baud rate, and printer handshake)

■ Printing attributes (portrait or landscape orientation, print density and quality, 
use of compression techniques, and advancing continuous–feed paper)

■ Dimensions of the paper (U.S. or European standard paper sizes or custom–size 
paper)

■ Margin settings of the pages (left, right, top, and bottom margins)

These parameters are specified in the [Printing] section of the setup.ini file located 
in the setup directory. The file contains default settings for all the printing 
parameters. Review the settings in the file to verify that these settings will work for 
your printing environment. If necessary, edit the settings as required. You may use 
any text editor to edit the file.

See Appendix E for a list of the printing parameters and valid values.

The parameters are set using the following syntax:

PARAMETER_NAME = VALUE
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For example: PrinterType = 1

The parameters are listed below in alphabetical order by the parameter name.

MarginBottom
Use the MarginBottom parameter to specify the dimensions of the bottom margin 
of your page. Specify the margin in millimeters using a whole number; decimal 
fractions are not valid. The default is 5 millimeters.

The data specified in the Footer tag of the print template is printed in the margin 
specified by MarginBottom. Therefore, if the print template includes a Footer tag, 
you must specify a wide enough bottom margin to accommodate the footer. 
MarginBottom should be set to a minimum of 20 millimeters. For more information, 
see “Footer” on page 274.

MarginLeft
Use the MarginLeft parameter to specify the width of the left margin of your page. 
Specify the margin in millimeters using a whole number; decimal fractions are not 
valid. The default is 5 millimeters.

MarginRight
Use the MarginRight parameter to specify the width of the right margin of your 
page. Specify the margin in millimeters using a whole number; decimal fractions are 
not valid. The default is 5 millimeters.

MarginTop
Use the MarginTop parameter to specify the dimensions of the top margin of your 
page. Specify the margin in millimeters using a whole number; decimal fractions are 
not valid. The default is 5 millimeters.

The data specified in the Header tag of the print template is printed in the margin 
specified by MarginTop. Therefore, if the print template includes a Header tag, you 
must specify a wide enough top margin to accommodate the footer. MarginTop 
should be set to a minimum of 20 millimeters. For more information, see “Header” 
on page 284.
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PaperHeight
If the paper that your printer uses is not one of the supported standard sizes, then 
set PaperSize to 5 (custom paper dimensions). Then, specify the height of the paper, 
in millimeters, using the PaperHeight parameter. You must use a whole number; 
decimal fractions are not valid. The default is 280 millimeters. If you specify a value 
of 1–4 for PaperSize, the PaperHeight parameter is ignored.

Use the PaperWidth parameter to specify the width of the paper.

PaperSize
Specify one of the standard paper sizes or specify a custom paper size. (See 
Table 46.) If you specify custom paper size (5), you must also specify the 
PaperWidth and PaperHeight parameters. The default is custom paper dimensions.

See also PaperWidth and PaperHeight.

PaperWidth
If the paper that your printer is printing to is not one of the supported standard 
sizes, then set PaperSize to 5 (custom paper dimensions). Then, you must specify 
the width measurement of the paper, in millimeters, using the PaperWidth 
parameter. You must use a whole number; decimal fractions are not valid. The 
default is 5 millimeters. If you specify a value of 1–4 for PaperSize, the PaperWidth 
parameter is ignored.

Table 46. Paper Dimensions

Value Description

1 Letter size (8.5" x 11.5")

2 A4 (210 mm x 297 mm)

3 B5 (176 mm x 250 mm)

4 Legal size (8.5" x 14")

5 (default) Custom paper dimensions (Specify PaperWidth and PaperHeight 
parameters.)
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Use the PaperHeight parameter to specify the length of the paper.

PrinterBaudrate
Use PrinterBaudrate to specify the speed of the data transmission for the printer. 
(See Table 47.)

PrinterCompressed
Use PrinterCompressed to specify the data compression mode. (See Table 48.) For 
the printers supported in this release, always set PrinterCompressed to 1.

PrinterDensity
Use the PrinterDensity parameter to get a lighter or darker output from the printer. 
Start with the default setting, 2, which corresponds to the printer manufacturer’s 
default. As you get feedback from the field, you may need to adjust this setting.

Table 47. Printer Baud Rate

Value Description

0 Always use 0 for LPT or Network printer ports or for COM ports 
that communicate with the printer at 4800 baud.

1 (default) 9600 baud

2 19200 baud

3 38400 baud

4 57600 baud

5 115200 baud

Table 48. Data Compression

Value Description

0 No compression techniques used

1 (default) Use any known compression
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The valid values are 0–4 where 0 is the lightest print density, 4 is the heaviest print 
density, and 2 is average print density.

PrinterDither
Use to specify the method by which different colors are represented. (See Table 49.) 
For the printers supported in this release, PrinterDither should always be set to 0.

PrinterDraftMode
Use PrinterDraftMode to specify the quality of the printing. (See Table 50.) For the 
printers supported in this release, PrinterDraftMode should always be set to 0.

PrinterFormFeed
Use PrinterFormFeed to specify how paper advances to the next page. (See 
Table 51.) If using sheets of paper, set PrinterFormFeed to 0. 

Specify 1 or 2 for continuous–feed paper:

■ Set PrinterFormFeed to 1 if you do not need to conserve paper or if you want 
pages of uniform length. The printer scrolls to the length specified by the 
PageHeight parameter and trims the page there. 

Table 49. Print Dithering

Value Description

0 (default) Use color diffusion

1 Use dithering

Table 50. Print Quality

Value Description

0 (default) Use the highest quality printing

1 Use a lower quality printing if available
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■ Set PrinterFormFeed to 2 to conserve paper or if it does not matter if your pages 
are of varying length. In this case, the printer scrolls 25 millimeters beyond the 
last printed line and trims the page there. The scroll distance, 25 mm, is not 
customizable.

For both values, 1 and 2, the page length never exceeds PageHeight.

PrinterHandshake
Use PrinterHandshake to define the serial port handshake. (See Table 52.) The 
PrinterHandshake parameter applies only when the printer port is a Com1 or Com2 
port. If PrinterPort is set to Com1 or Com2, then set PrinterHandshake to 1. 

Table 51. Printer Form Feed

Value Description

0 (default) Printer sends a form feed command to the printer at the end of 
each page. Use this setting for sheet paper.

1 Printer scrolls the page to the length specified by the PaperHeight 
parameter.

2 Printer scrolls the page 25 millimeters past the last printed line of 
the page.

Table 52. Printer Handshake

Value Description

0 Uses Xon/Xoff

1 (default) Uses hardware control lines

2 No handshaking of serial port
300 Siebel ePharma Handheld Guide for Windows-Powered Devices Version 7.5.3



Print Configuration Settings

Overview
PrinterOrientation
Specify whether the paper is to be oriented vertically (portrait) or horizontally 
(landscape). (See Table 53.) Not all printers can print in landscape orientation. 
Therefore, you will need to check the specifications for your printer.

PrinterPort
Specify the port to which the printer is connected with the PrinterPort parameter. 
(See Table 54.)

If PrinterPort is an LPT port or a network path (2 or 9), then the PrinterBaudrate 
must be set to 0.

Table 53. Paper Orientation

Value Description

1 (default) Portrait (vertical)

2 Landscape (horizontal)

Table 54. Printer Port

Value Description

0 Com1: serial port

1 Com2: serial port

2 LPT: parallel port

3 (default) IR Infrared port

4 Com3: serial port

5 Com4: serial port

6 Com5: serial port

7 Com6: serial port

8 Print to file OUTPUT.PRN

9 Print to network address
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PrinterType
Specify the type of printer using the PrinterType parameter. See Table 55 for the list 
of supported printers.

Default Printing Settings
The following are the printing parameters from the setup.ini file. The values shown 
are the default settings.

[Printing]

PrinterType= 14
PrinterPort= 3 
PrinterBaudrate= 1
PrinterHandshake= 1
PrinterOrientation= 1
PrinterDensity= 2
PrinterCompressed= 1
PrinterDither= 0

10 Bluetooth BlueCard solution by Wireless Solutions

11 Socket PNC Bluetooth card support

12 Bluetooth BlueCard solution by Anycom

13 Com7: serial port

14 Com8: serial port

Table 54. Printer Port

Value Description

Table 55. Printer Type

Value Description

6 Pentax PocketJet 200

14 (default) O’Neil microFlash2i and microFlash4t printers

108 O’Neil microFlash8i printer
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PrinterDraftMode= 0
PrinterFormFeed= 0
PaperSize= 5
PaperWidth= 115
PaperHeight= 280
MarginLeft= 5
MarginRight= 5
MarginTop= 5
MarginBottom= 5
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I
Inactive inventory type, described 210
initial count adjustments, creating and 

submitting 214
initial master inventory

establishing, about 211
initial count adjustments, creating and 

submitting 214
products, adding to inventory and 

submitting an initial count 211
installing software

about ways to 131
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Index
Companion Sync users, for 132
Direct Server Sync, users for 134
reinstalling or upgrading 136
uninstalling handheld application 136

inventory
initial master inventory 211
initial master inventory control 214
initial master inventory control, about 

establishing 211
inventory periods, table of 210

inventory sample records, managing 55

J
Journal Viewer, using to 129

L
license, adding and editing license 

information 171
list applets

See also applets
about and guidelines 36

List of Values, filtering out 80
log files

Companion Sync logs, using for 
troubleshooting 233

Direct Server Sync logs, using for 
troubleshooting 232

handheld device logs, using for 
troubleshooting 234

server logging levels, configuring 101
logging parameters, configuring 113
LogSQLStmts parameter, caution 

setting 114
LogSSAErrors parameter, caution 

setting 114

M
MarginBottom parameter, about 296
MarginLeft parameter, about 296
MarginRight parameter, about 296
MarginTop parameter, about 296
MedEd event

See medical education event, setting up
medical education event, setting up

about 223
contact, inviting to an event 225
creating a medical education event 225

memory
caution, log files using available 

memory 114
Microsoft ActiveSync, about 22
multiple synchronization servers, about 

using 105
Multi-Value Group applet, support of 29

N
network performance, about 239
notes, sharing about a contact 173

O
objects that should not be changed 

(table) 253
organization of guide 16

P
Page Break print tag 286
PaperHeight parameter, about 297
PaperSize parameter, about 297
PaperWidth parameter, about 297
PDQ filters, administration

Companion Sync, about 85
Direct Server Sync mode, about 86

performance
client performance, about 237
network performance, about 239
server performance, about 238
SQLTrace, enabling 235

personal lists
about 181
creating 186

pick applets, data filtering for
about 86
business object declarations, setting 

examples 88
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Index
configuration file directives 87
Popup Visibility Type setting, 

overriding 91
visibility, designating 89

Picture print tag 287
Planned Start field, exposing in Activities 

view 36
Pocket PC

form applets, layout sequence 38
menu bar, about using 41
multiple applet views, screen 

allocation 34
status bar, about 43
toolbars, configuring 42
uninstalling handheld application 137

pop-up lists
auto pop-up lists, about 39
data visibility, about controlling 40, 87

Popup Visibility Type setting, 
overriding 91

Predefined Queries (PDQs)
about and example 80
All Records PDQs, about 84
default PDQs, configuring 83
general and default PDQ filters, 

described 81
PDQ filters, summary of use (table) 85

prescription data, viewing 174
print applets, designing

See also individual print entries
about 47
form applets, designing 47
list applets, designing 47

Print button
See also individual print entries
configuring (procedure) 49
configuring, about 48

print tagging language
See print templates

print templates
See also server installation; individual 

print entries
Applet print tag 267

Cell print tag 269
Comment print tag 271
Divider print tag 272
EndofLine print tag 273
Footer print tag 274
Format print tag 276
GetCount print tag 278
GetDate print tag 279
GetField print tag 280
GetRegistry print tag 281
GetTime print tag 282
GetTotal print tag 283
Header print tag 284
Page Break print tag 286
Picture print tag 287
print template file example 291
print template file, creating 

overview 265
SetVariable print tag 289
Static Text print tag 290
Title print tag 291
variables, example using in 

template 291
PrinterBaudrate parameter, about 298
PrinterCompressed parameter, about 298
PrinterDensity parameter, about 298
PrinterDither parameter, about 299
PrinterDraftMode parameter, about 299
PrinterFormFeed parameter, about 299
PrinterHandshake parameter, about 300
PrinterOrientation parameter, about 301
PrinterPort parameter, about 301
PrinterType parameter, about 302
printing receipts for samples dropped 73

See also individual print entries
printing, configuration settings

See also server installation; individual 
print entries

default printing settings, list of 302
MarginBottom parameter, about 296
MarginLeft parameter, about 296
MarginRight parameter, about 296
MarginTop parameter, about 296
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Index
PaperHeight parameter, about 297
PaperSize parameter, about 297
PaperWidth parameter, about 297
parameters and syntax, about 295
PrinterBaudrate parameter, about 298
PrinterCompressed parameter, 

about 298
PrinterDensity parameter, about 298
PrinterDither parameter, about 299
PrinterDraftMode parameter, about 299
PrinterFormFeed parameter, about 299
PrinterHandshake parameter, about 300
PrinterOrientation parameter, about 301
PrinterPort parameter, about 301
PrinterType parameter, about 302

printing, configuring for the handheld
See also individual printing entries; print 

templates
about 45
defining documents for printing 46
print applets, configuring for printing 48
print applets, designing 47
Print buttons, about configuring 48
Print buttons, configuring 

(procedure) 49
private notes

account notes, adding 178
contact notes, adding 173

products
inventory, adding to and submitting an 

initial count 211
samples transaction, adding to 221

Professional Call Submit button
editing user properties (table) 69
flowchart 67

promotional items dropped, recording 
information about 193

Q
Query by Example filters (QBE)

about 77
business component filters, adding 78
List of Values, filtering out 80

R
Reconciled inventory type, described 210
recovering data

Companion Sync journal files 128
Siebel Handheld Journaling 127

reinstalling handheld application 136
remote database

See synchronization, conflict handling 
and recovery

report
expense report, creating 226
views, associating with 35

repository
.SRF file, location of 45
compiling, about 45

Repository Configuration, about 75
resources, additional 17
restore, troubleshooting 229
returned samples 217

S
sales data, viewing 180
sample views, list of 215
samples

See also individual sample entries
dropped, recording information 

about 192
inventory records, managing, about 55
printing receipts for samples dropped 73
returned to home office 217
samples order, creating 216

samples transaction
See also individual sample entries
product, adding to 221
quantity, adjusting 223

samples transfer
See also individual sample entries
about 217
acknowledging receipt of 219
creating (procedure) 217

samples, managing
See also individual sample entries
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about 206
business scenario 208
initial master inventory, about 

establishing 211
inventory periods, table of 210
sample views, list of 215
samples order, creating 216
samples transaction, adding a product 

to 221
samples transaction, adjusting a 

quantity 223
samples transfer, about creating 217
samples transfer, acknowledging receipt 

of 219
samples transfer, creating 

(procedure) 217
server and handheld samples records, 

keeping in sync 207
Siebel Samples Management, about 

working with calls 209
screens and views (table)

Siebel ePharma 241
screens and views, designing

drill-down only views, about 35
multiple applet views, screen 

allocation 34
multiple applet views, toggling 

between 35
Planned Start and Duration fields, 

exposing in the Activities view 36
print templates and reports, views 

associated with 35
scripting

deactivating scripts, about 93
user interface methods, calls to 94

server installation
CompactFlash card, setting up 

installation on 113
database backup, enabling 111
Direct Server Synchronization (DDS), 

installation 98
DSS URL, about changing 114
external media, installing from 115

handheld logging parameters, 
configuring 113

hardware and network configuration, 
recommended 97

installation configuration file, 
editing 107

planning for, about 95
print templates, about installing 114
server logging levels, configuring 101
server process management, 

optimizing 104
server topology overview, about and 

diagram 96
synchronization performance and 

scalability 104
setup.ini file, location and editing 107
SetVariable print tag 289
shared notes

account notes, adding 178
contacts, adding 173

Siebel eScript, issues and validation 93
Siebel Expert Services, about using 240
Siebel Handheld Client

handheld screen, about designing for 32
identify user activities, improving 

performance 32
minimal navigation, about designing 

applications 32
Multi-Value Group applet, support of 29
naming conventions, about 33
scripting, about 93
Siebel Web Client, differences in 

configuring 28
stop-and-go workflow, about 

supporting 32
testing the handheld application 50
unsupported functions (table) 30
user functionality, defining 31

Siebel Handheld Journaling
about and parameter settings 127
journal log files, location and name 127

Siebel Mobile Web Client, about 
installation 105
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Index
Siebel Professional Services, about 
using 240

Siebel Signature Capture display, changing 
distributor name 56

Siebel Visual Basic (VB), issues and 
validation 93

Siebel Web Client
Multi-Value Group applet, support of 29
scripting, issues and validation 93
Siebel Handheld client, differences in 

configuring 28
unsupported functions (table) 30

Signature button, editing
default validation logic flowchart 66
user properties (table) 69

signature capture verification
See also signature capture verification, 

configuring user properties
checksum examples 59
Checksum status for body text, user 

properties 60
Checksum status for header text, user 

properties 60
Checksum status for sale representative’s 

row, user properties 60
signature capture verification status, 

about and examples (table) 59
signature key, about 58
status determination 60

signature capture verification, configuring 
user properties

See also signature capture verification
Editing Checksum Field: 1 Signature 

Header Text 63
Editing Checksum Field: 2 Signature Body 

Text 63
Editing Checksum Field: 3 Sales 

Representative’s Row Number 63
new checksum field user properties, 

creating 64
Signature Header Text field, description 

of 60
signatures

capturing 195
signature key, about 58
verifying 57

Smart Call
about 182
template, applying 189

SQLTrace, enabling 235
.SRF file, location of 45
stand-alone installer, about creating 115
Static Text print tag 290
status bar, about 43
Submit button

Account Call Submit button, default 
validation logic flowchart 68

editing user properties (table) 69
Professional Call Submit button, default 

validation logic flowchart 67
synchronization

See also synchronization, conflict 
handling and recovery

Direct Server Sync via Proxy, about 24
Direct Server Sync, about and 

diagram 23
handheld synchronization errors, 

logging 234
methods and architecture 21
overview 20
preventing synchronization with another 

handheld 54
resynchronization problems, 

troubleshooting 232
servers, types of 21
synchronization conflicts, preventing 43
troubleshooting, about problems caused 

by 230
synchronization filters

See Predefined Queries (PDQs)
synchronization, conflict handling and 

recovery
See also Siebel Handheld Journaling; 

synchronization
about 119
extended insert processing 124
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extended pick processing settings, 
recommended 123

extended pick processing, about 119
extended pick processing, enabling 120
extended pick processing, resolving 

conflicts 124

T
templates, associating views with 35
testing the handheld application 50
timeout parameter, changing on 

Windows 236
Title print tag 291
toolbars, configuring

HPC 2000 toolbar functions (table) 41
Pocket PC 2002 toolbar functions 

(table) 42
transaction errors, viewing 129
troubleshooting

client installation, backup, and 
restore 229

client performance, about 237
Companion Sync checklist, using 231
Companion Sync log files 233
Direct Server Sync checklist, using 231
Direct Server Sync log files 232
handheld device logs 234
network performance, about 239
resynchronization problems 232
server performance, about 238
Siebel Expert Services, about using 240
Siebel Professional Services, about 

using 240
SQLTrace, enabling 235
synchronization, about problems caused 

by 230
timeout parameter, changing on Windows 

2000 236

timeout parameter, changing on Windows 
NT 236

U
uninstalling handheld application 136
upgrading handheld application 136
user functionality, defining

about 31
general guidelines 31

user interface elements, configuring
about 36
auto pop-up lists, about 39
buttons, about and functionality 

(table) 40
form applets, group boxes 39
form applets, labels 38
form applets, layout sequence 38
Home Page applets, configuring 39
hyperlinks, about configuring 43
list applets, about and guidelines 36
menu bar, about using 41
status bar, about 43
toolbars, configuring 41

user interface methods, business 
component script calls to 94

user properties, changing default 
values 69

V
validation logic, changing default user 

property values 69
views

drill-down only views, about 35
new views, adding 51

visibility, designating 89

W
Windows, changing timeout 

parameter 236
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